Please make sure to read this manual before using and follow the procedures. If you have any inquiries about the product, contact the number on the warranty statement or the packing box. Do not discard this manual, the warranty statement, or the packing box.

Americas: www.buffaloamericas.com
Europe: www.buffalo-technology.com
Asia Pacific: www.buffalo-asia.com
<table>
<thead>
<tr>
<th>Chapter 1 Getting Started</th>
<th>9</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diagrams</td>
<td>9</td>
</tr>
<tr>
<td>Turning the TeraStation On and Off</td>
<td>11</td>
</tr>
<tr>
<td>Changing the Administrator Password</td>
<td>14</td>
</tr>
<tr>
<td>Creating a Recovery Drive</td>
<td>15</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 2 Configuration</th>
<th>17</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opening Advanced Settings</td>
<td>17</td>
</tr>
<tr>
<td>Opening Easy Admin</td>
<td>19</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 3 File Sharing</th>
<th>21</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring Shared Folders</td>
<td>21</td>
</tr>
<tr>
<td>Adding a Shared Folder</td>
<td>21</td>
</tr>
<tr>
<td>Recycle Bin</td>
<td>24</td>
</tr>
<tr>
<td>Read-Only Shares</td>
<td>24</td>
</tr>
<tr>
<td>Hidden Shares</td>
<td>24</td>
</tr>
<tr>
<td>Configuring Users</td>
<td>24</td>
</tr>
<tr>
<td>Adding a User</td>
<td>24</td>
</tr>
<tr>
<td>Importing User Information</td>
<td>27</td>
</tr>
<tr>
<td>Adding a Group</td>
<td>27</td>
</tr>
<tr>
<td>Configuring Access Restrictions</td>
<td>30</td>
</tr>
<tr>
<td>Local Users and Groups</td>
<td>30</td>
</tr>
<tr>
<td>Active Directory</td>
<td>31</td>
</tr>
<tr>
<td>NT Domain</td>
<td>34</td>
</tr>
</tbody>
</table>
Chapter 4 Storage Management

RAID Modes

Working with RAID Arrays

Using JBOD

Changing RAID Mode

Configuring a Hot Spare

RMM (RAID Mode Manager)

RAID Scanning

Adding an External Drive

Connecting an External Drive

Compatibility

Dismounting Drives

Dismounting with the Function Button

Dismounting from Settings

Checking Drives

Formatting Drives

Encrypting Drives

Media Cartridges

Erasing Data on the TeraStation Completely

Drive Quotas

Quotas for Users

Quotas for Groups

Size Limits

Using the TeraStation as an iSCSI Device

Introduction
Creating an iSCSI Volume ................................................................. 60
Connecting or Disconnecting Volumes ........................................... 62
Configuring Access Restrictions ..................................................... 68
Expanding Volume Sizes ................................................................. 76
Deleting Volumes ........................................................................... 77

Drive Replacement ........................................................................ 79
Using JBOD or a Redundant RAID Mode and TeraStation Is On ......... 80
Using a Redundant RAID Mode and TeraStation Is Off ..................... 84
Using RAID 0 ................................................................................ 84
Using a Hot Spare .......................................................................... 85
Replacing a Media Cartridge ............................................................. 85
Replacing a Non-Malfunctioning Drive ............................................ 85

Chapter 5 Backup ............................................................................. 87
Back up to a Buffalo NAS Device .................................................. 87
Preparation of a Backup Destination .............................................. 87
Configuration of a Backup Job ......................................................... 88
Backup Logs .................................................................................. 93
Replication ..................................................................................... 96
Preparation of a Replication Destination ......................................... 96
Configuration of a Replication Task ................................................ 97
Failover ......................................................................................... 100
Before Configuration of Failover .................................................... 101
Usage Restrictions .......................................................................... 102
Configuration of Failover ............................................................... 103
Replacing to the Backup TeraStation Manually ............................... 104
Reconfiguration After Failover Occurs ........................................... 105

Backing Up Your Mac with Time Machine .................................... 107
Advanced Usage ................................................................................................. 143
  Export Recorded Data as an MOV Video File .............................................. 143
  Viewing Video Real-time .............................................................................. 146
  Moving Recorded Video Data to Another TeraStation ......................... 147
  Backing Up Recorded Video to Another TeraStation .............................. 148
  Automatically Delete Old Data When Space Is Low .............................. 149
  Changing Where Recorded Video Is Saved ............................................ 151
  Email Notifications ...................................................................................... 152

Client Tools ........................................................................................................... 153
  Camera Policies ............................................................................................. 153
  Live Viewer ..................................................................................................... 154
  Data Service Policies ..................................................................................... 154
  Vault Admin .................................................................................................... 155
  Surveillance Video Manager ......................................................................... 156
  Network Activity ............................................................................................ 157
  Mini Vault Stats ............................................................................................. 158

Activating Additional Licenses ........................................................................ 158
  When the TeraStation Is Connected to the Internet ..................................... 158
  TeraStation Not Connected to the Internet .................................................. 160

Troubleshooting ................................................................................................... 165

Chapter 10 Advanced Features .......................................................................... 166

Antivirus Software ............................................................................................... 166
  Activating Virus Scanning ............................................................................ 166
  Configuring Security Settings ....................................................................... 168
  Licenses .......................................................................................................... 169
  Connecting Through a Proxy Server ............................................................. 170
  Updating Antivirus Pattern Files ................................................................. 171
  Configuring Folders as Virus Scanning Targets ......................................... 172
Creating a Recovery Drive ................................................................. 202
Initializing with the USB Drive ....................................................... 203

Logs ........................................................................................................ 204
Displaying TeraStation’s Logs .............................................................. 204
Transferring Logs to the Syslog Server .............................................. 204
Creating a Link to the Logs in the Shared Folder .............................. 205

Updating the Firmware ....................................................................... 206

Name, Date, Time, and Language ...................................................... 206

Beep Alerts ........................................................................................... 209

LCD and LEDs ...................................................................................... 210

Jumbo Frames ....................................................................................... 211

Changing the IP Address ..................................................................... 213

Chapter 11 Utilities ............................................................................. 216

NAS Navigator2 for Windows ............................................................... 216
  Mounting as a Network Drive ........................................................... 218
  Changing the IP Address ................................................................... 219

NAS Navigator2 for macOS ................................................................. 219
  Mounting as a Network Drive ........................................................... 221
  Changing the IP Address ................................................................... 221

iSCSI Connection Tool ....................................................................... 221
  Home Screen ...................................................................................... 222
  Menu .................................................................................................... 222

NovaBACKUP ........................................................................................ 223
  Installing from CD ............................................................................. 223
  Installing from Website ..................................................................... 223
<table>
<thead>
<tr>
<th>Chapter 12 Appendix ................................................................. 224</th>
</tr>
</thead>
<tbody>
<tr>
<td>LCD Panel ............................................................................ 224</td>
</tr>
<tr>
<td>Modes ................................................................................. 224</td>
</tr>
<tr>
<td>Errors ................................................................................. 224</td>
</tr>
<tr>
<td>Status .................................................................................. 225</td>
</tr>
<tr>
<td>Default Settings ................................................................... 228</td>
</tr>
<tr>
<td>Specifications ...................................................................... 229</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 13 Regulatory Compliance Information .... 231</th>
</tr>
</thead>
<tbody>
<tr>
<td>For Customers in the United States .............................. 231</td>
</tr>
<tr>
<td>For Customers in Europe ............................................. 231</td>
</tr>
<tr>
<td>For Customers in Russia .............................................. 234</td>
</tr>
<tr>
<td>For Customers in China ............................................... 235</td>
</tr>
<tr>
<td>For Customers in Taiwan .............................................. 235</td>
</tr>
<tr>
<td>For Customers in Korea ............................................... 235</td>
</tr>
</tbody>
</table>
Chapter 1 Getting Started

This manual provides procedures for the latest firmware (as of June 2018). For more detailed information on the latest firmware, refer to the Buffalo website.

Diagrams

TS3400D

TS3400R
**Power Button ( )**
To power on, connect the power cable and wait for 10 seconds, then press and hold the power button for 1 second. To power off, press and hold the power button for 3 seconds until it beeps.

**Info LED**
If there is a status message, the amber info LED will light up. Check the LCD panel to see the status message.

**Error LED**
If there is an error, the red error LED will light up. Check the LCD panel to see the error message.

**LAN1 LED**
When LAN port 1 is connected, this LED glows green. It blinks when the connection is active.

**LAN2 LED**
When LAN port 2 is connected, this LED glows green. It blinks when the connection is active.

**LCD Panel**
This display shows the status of many TeraStation settings. It also displays errors and messages when available.

**Display Button**
Switches between the different display modes. Also, if the TeraStation is beeping, press this button to stop it.

**Function Button**
Use this button for Direct Copy, dismounting USB devices, rebuilding RAID arrays, and configuring failover.

**Drive Lock ( )**
Open the front panel with the key to replace drives or access the init button.

**Init Button**
Press and hold this button to initialize the TeraStation’s admin username and password, IP address, SSL, and service port restriction settings to their factory default values. The behavior of this button can be modified in Settings.

**Status LEDs**
Normally, these LEDs blink green when drives are accessed. If a drive fails, its LED will turn red or amber.
Chapter 1 Getting Started

12 VGA Port
Factory use only.

13 Boot Mode Switch
Leave the switch in the HDD position during normal operation. To recover settings, insert the recovery USB drive into a USB 2.0 port, move the boot switch to the USB position, and press the power button.

14 UPS Port
Connect to a UPS.

15 USB 3.0 Port
Compatible Buffalo USB 3.0 drives can be connected. USB hubs are not supported.

16 USB 2.0 Port
Compatible Buffalo USB drives, USB flash drives, digital cameras, and USB UPS connections can be connected. USB hubs are not supported.

17 LAN Port 1
Connect an Ethernet cable to use this port for your network. It is available for communicating at a max. of 1000 Mbps.

18 LAN Port 2
Connect an Ethernet cable to use this port for your network. It is available for communicating at a max. of 1000 Mbps.

19 Power Connector
Use the included power cable to connect to a UPS, surge protector, or outlet.

20 Fan
Spins to avoid overheating inside. Do not block the fan.

21 Anti-Theft Security Slot
Use this slot to secure your TeraStation with a cable lock (not included).

22 UID Button
Press the UID button on the front or the back of the unit to cycle the blue LED on and off.

23 Serial Number
This sticker shows the TeraStation’s serial number.

24 Not in use.

25 Link and Act LEDs
These LEDs show network activity. They blink amber when the TeraStation is accessed over the network.

---

**Turning the TeraStation On and Off**

Press the power button on the TeraStation to turn it on.

To turn off the TeraStation, press and hold the power button for 3 seconds until it beeps. Don’t unplug the TeraStation without turning it off first. You can also shut it down and restart it remotely from Settings.

1 Double-click the NAS Navigator2 icon to start NAS Navigator2.
2 Right-click your TeraStation's icon and select Settings. For macOS, select the TeraStation's icon while holding down the control key, then select Settings.

![TeraStation Settings](image)

3 Enter the username and password, then click OK.

![Login Screen](image)

**Note:** The default username and password are “admin” and “password”.
4 Settings will open.

5 Click at the top-right of Settings and choose Shut Down.

6 Click Yes.

7 The “Confirm Operation” screen will open. Enter the confirmation number, then click OK.

When the power LED on the front of the TeraStation turns off, the shutdown process is complete.
Changing the Administrator Password

After initial setup, follow this procedure to change your password.

1. Double-click the NAS Navigator2 icon to start NAS Navigator2.

2. Right-click your TeraStation's icon and select Settings. For macOS, select the TeraStation's icon while holding down the control key, then select Settings.

3. Click Easy Admin.

4. Click Change Password.

Before using your TeraStation, change the default password.
5 If this screen is displayed, enter the current password and click OK. The default password is "password".

6 Enter the new password (twice) and click Next.

7 Click OK. You have changed the admin password.

Creating a Recovery Drive

To initialize all of the TeraStation's settings, or just restore the admin password to its factory default value, create a recovery drive as described below.

Notes:
• Normally, creating and using a recovery drive will not affect data on the TeraStation. However, always back up your data regularly!
• This USB drive can be used to recover the system if your TeraStation doesn't boot at all. In this case, if the data partition is damaged, then all your data will be deleted by the recovery process.

1 Insert a 1 GB or larger USB drive (not included) into a USB 2.0 port on the TeraStation.
   Note: All data on the USB drive will be erased!

2 From Settings, click Management.
3 Click to the right of “Computer Management”.

4 Select “Create a USB drive for initializing settings”.

5 From “Target USB drive”, select the USB drive that is connected to the USB 2.0 port on the TeraStation, then click Execute.

6 The “Confirm Operation” screen will open. Enter the confirmation number, then click OK.

7 The TeraStation will create the recovery drive. This will take about a minute. When creating the USB recovery drive is completed, click OK.

For the procedure on using recovery drive, refer to the “Restoring Factory Defaults” section in chapter 10.
Chapter 2 Configuration

Configure and manage your TeraStation using the Settings interface, accessible from a browser window. Open the interface using the procedure below or type the TeraStation’s IP address into the URL field of your browser. Within Settings, the Easy Admin page gives you quick access to commonly used settings.

**Note:** Microsoft Edge, Firefox, Google Chrome, Internet Explorer 9 or later, and Safari 9 or later are supported. If you have difficulty viewing Settings, check the following:

- If there are a large number of registered users, groups, or shared folders, use another browser instead of Internet Explorer.
- If you have a proxy server enabled in the browser settings, configure the exception settings for Settings or disable the proxy server.
- With Internet Explorer, set security to *Local intranet*. On Windows Server operating systems, higher-level security is configured by default. Set the security to a lower level temporarily.

### Opening Advanced Settings

1. Double-click the NAS Navigator2 icon ( ) to start NAS Navigator2.

2. Right-click your TeraStation’s icon and select **Settings**. For macOS, select the TeraStation’s icon while holding down the control key, then select **Settings**.
3 Enter the username and password, then click OK.

Notes:
• If the time-out period is set to “10 minutes”, you will be logged out of Settings after 10 minutes of inactivity.
• Click Secure Connection to log in using an encrypted connection.

4 Settings will open.

Notes:
• Username/Password Combinations:

<table>
<thead>
<tr>
<th>Username</th>
<th>Password</th>
<th>Settings Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>admin (default)</td>
<td>password (default)</td>
<td>All</td>
</tr>
</tbody>
</table>
Username | Password | Settings Available
--- | --- | ---
guest | blank | System information (read-only)
Your username | Your password | If a user is assigned as an administrator, all settings are available. If assigned to another group, only system information (read-only) is available.

- Click 🛠️ to open Easy Admin.
- Click 🎵 to play a tone from the TeraStation for easy location. For TS3400R models, you can stop the beeping by pressing the function or display button.

## Opening Easy Admin

The Easy Admin page makes it easy to change common settings. Follow the procedure below to open Easy Admin.

1. Double-click the NAS Navigator2 icon (.GUI) to start NAS Navigator2.

2. Right-click your TeraStation’s icon and select Settings. For macOS, select the TeraStation’s icon while holding down the control key, then select Settings.
3 Click Easy Admin.

4 The Easy Admin screen will open.

**Note:** If you click any buttons, you will need to enter a username and password.
Chapter 3 File Sharing

Configuring Shared Folders

Adding a Shared Folder

1. From Settings, click *File Sharing*.

2. Click \( \text{Folder Setup} \) to the right of “Folder Setup”.

3. Click *Create Folder*.

![Shared Folder List]

[Image of Shared Folder List]

- Name: info
- Volume: USB Drive 1
- AFP: ✔
- FTP: ✔
- Backup: ✔
- DLNA: ✔
- WebAccess: ✔
- SFTP: ✔
Configure the desired settings, then click OK.
Notes:

• Names may contain up to 27 alphanumeric characters, hyphens (-), and underscores (_). Multibyte characters are supported. The first character should not be a symbol.

• Descriptions may contain up to 75 alphanumeric characters, hyphens (-), underscores (_), and spaces. Multibyte characters are supported. The first character should not be a space.

• You may create up to 400 shared folders.

• If the names of shared folders accessed via AFP and FTP connections contain multibyte characters, configure the client language in Management > Name/Time/Language to match the characters. If the setting does not match, the shared folder name will not be displayed correctly.

• The following characters are handled differently by macOS and Windows. Avoid using these characters when sharing data between macOS and Windows:

| ❌ | － | － | － | － | － | － | － | － | － | － | － | － | － | － | － | － | － | － | － | － | － | － |

• Do not use the following words for the name of a shared folder as these words are reserved for internal use by the TeraStation: authtest, global, homes, info, lost+found, lp, msdfs_root, mt-daapd, printers, ram, spool, usbdisk x (where “x” is a number, for example: usbdisk1)

• File and folder names may contain up to 255 single-byte characters.

• Folder and workgroup names whose names contain non-Roman characters may not be displayed correctly.

• If shared folders are accessed from a Mac using any of the following symbols, it will not display correctly on a Windows computer. With macOS 10.2 or later, you may have to connect to the TeraStation via AFP in order to display or copy files that contain these symbols in their filenames.

? ] { / \ = + > < ; : " | *  

• Windows does not support any of the following characters as they are reserved for files and folders created on a Mac:

| ❌ | ❌ | ❌ | ❌ | ❌ | ❌ | ❌ | ❌ | ❌ | ❌ | ❌ | ❌ | ❌ | ❌ | ❌ | ❌ | ❌ | ❌ | ❌ | ❌ | ❌ | ❌ | ❌ |

• File and folder names may contain up to 255 single-byte characters.

• Folder and workgroup names whose names contain non-Roman characters may not be displayed correctly.

• If shared folders are accessed from a Mac, information files for the Mac may be generated automatically. Do not delete these files. If they are deleted using Windows, this may prevent further access from a Mac.

• If an SMB connection is used with OS X 10.3.9, the names of mounted volumes may appear as unreadable characters in Finder and other applications. This is not a problem with the filename or data.

• With OS X 10.5.6, Spotlight searches are not supported over AFP connections. Use SMB connections or upgrade to OS X 10.5.7 or later.

• The TeraStation belongs to the default zone in AppleShare; the zone cannot be specified.

• When files are copied to the TeraStation or to a USB drive connected to the TeraStation, file information such as date created, date modified, and other date information may be updated or changed.

• During a file transfer, if settings are changed, the file transfer operation may be aborted.

• File copying to the TeraStation is protected by a journaling file system. If the Ethernet cable is disconnected or a power outage occurs while copying data, the following may occur:

  ◦ Preset data such as the TeraStation name, users, and groups may be erased.

  ◦ An incomplete file may be copied and the file can no longer be deleted. If this happens, restart the TeraStation, delete the file, and perform the copy operation again.
Recycle Bin

To protect your data from accidental deletion, you may configure your TeraStation to use a recycle bin instead of deleting files immediately. The recycle bin will only work with SMB connections. To empty the recycle bin, click File Sharing > Folder Setup > Empty Recycle Bin in Settings. The recycle bins in all shared folders will be deleted.

Notes:
- You can prevent guests and other users from emptying the trash by navigating to File Sharing > SMB > Recycle Bin Permissions and select “Administrator only” for the “Recycle Bin Permissions” option.
- If you use macOS, select “Yes” for the “Exclude Mac OS temp files from recycle bin” option by navigating to File Sharing > SMB. If this setting is changed, files in the recycle bin may be corrupted.

Read-Only Shares

By default, new shares are set with read and write access, but you may change the attribute to Read Only at Attribute. Read-only shares and HFS Plus-formatted USB drives will have “(Read Only)” added to comments in File Explorer.

Note: Configure read-only file attribute in Settings. Configuring them from within Windows is not supported and may cause unexpected behavior.

Hidden Shares

If hidden shares are enabled, shared SMB folders will not be displayed in Network, and only certain users are allowed to access them. To hide a shared SMB folder, follow the procedure below.

1. From Settings, navigate to File Sharing > Folder Setup and choose a shared folder or a USB drive to configure hidden shares.

2. Select the “Hidden Share (SMB Only)” checkbox and click OK.

Notes:
- If protocols other than “SMB (Windows/Mac)” or “Backup” under “LAN Protocol Support” are enabled, the hidden shares option will be grayed out and cannot be selected.
- Configure hidden share attribute in Settings. Configuring them from within Windows is not supported and may cause unexpected behavior.

To access a hidden folder, open File Explorer in your computer and enter “\TeraStation name\shared folder name$” into the address bar. For example, if the TeraStation name is “TSXXX001” and the shared folder name is “share”, enter “\TSXXX001\share$” to open it.

Configuring Users

Adding a User

Note: The TeraStation can register a maximum 300 of users, which include the default users “admin” and “guest”.

1. From Settings, click File Sharing.
2 Click to the right of “Users”.

3 Click Create User.
Enter the desired settings, then click OK.

**Notes:**

- Usernames may contain up to 128 alphanumeric characters, hyphens (-), underscores (_), periods (.), and the symbols ! # & $ * ^ %. The first character should not be a symbol.
- The user ID should be a number from 1000 to 1999. Each user ID should be unique. If this field is left blank, a user ID is assigned automatically.
- Do not duplicate user IDs, group IDs, usernames, or group names. Each should be distinct and unique.
- User descriptions may contain up to 75 alphanumeric characters, hyphens (-), underscores (_), and spaces. Multibyte characters are supported. The first character should not be a symbol or space.
- Passwords may contain up to 20 alphanumeric characters, hyphens (-), underscores (_), periods (.), and the symbols @ ! # $ % & ' ( ) * + , / ; : < = ? ‘ ’ [ ] ^ { } | ~. The first character should not be a symbol unless it is an underscore.
- Use the same username and password for both Windows and the TeraStation or you may be unable to access shared folders.
Do not use any of the following words for a username as these words are reserved for internal use by the TeraStation: adm, admin, administrator, all, apache, backup, bin, daemon, dbus, disk, ftp, ftpuser, guest, haldaemon, halt, hdusers, kmem, lp, mail, man, mysql, news, nobody, nogroup, none, operator, proxy, root, rpc, rpcuser, shadow, shutdown, splx, sshd, sync, sys, tty, users, utmp, uucp, www, www-data

**Importing User Information**

You can import users in *File Sharing > Users* by clicking *Import CSV File*.

An example format for user data: Username (required), password (required), and user description (optional).

**Example 1:** Importing usernames, passwords, and comments

username1,password1,comment1
username2,password2,comment2
username3,password3,comment3

**Example 2:** Importing usernames and passwords

username1,password1,
username2,password2,
username3,password3,

**Guidelines:**

- Use commas (,) as separators. Do not put spaces before or after commas. If you don't want user descriptions, use a comma after the password at the end.
- If a line is in an incorrect format, the username entered on that line will not be registered.
- If a username already exists, the new user information will overwrite the old information.
- Do not use commas (,) in the username, password, or user description.

**Note:** Imported users are added to the “hdusers” group automatically.

**Adding a Group**

1. From Settings, click *File Sharing*.

2. Click to the right of “Groups”.

3 Click *Add Group.*
4 Enter the desired settings, then click OK.

Notes:

- Group names may contain up to 20 alphanumeric characters, hyphens (-), underscores (_), and periods (.). The first character should not be a symbol.
- Group descriptions may contain up to 75 alphanumeric characters, hyphens (-), underscores (_), and spaces. Multibyte characters are supported. The first character should not be a symbol or space.
- If the group ID field is left blank, a group ID is automatically assigned. Use numbers between 1000 and 1999 to set a group ID manually. Don't use duplicate group IDs.
- You may register up to 300 groups with the TeraStation.
- If you are logged in as a member of the general users group, you can only change your own password. If you're logged in as an administrator, you can change any settings, including other users' passwords. If you are logged in as a member of the power users group, you can create and edit shared folders, users, and groups.
- Do not use any of the following words for a group name as these words are reserved for internal use by the TeraStation: adm, admin, administrator, all, apache, bin, daemon, disk, ftp, ftpuser, guest, halt, hdusers, kmem, lp,
Configuring Access Restrictions

You may restrict access to specific shared folders, including external USB drives.

Notes:
• Access restrictions can be set separately for each shared folder, but not for folders within the shared folders.
• Configure access restrictions in Settings. Configuring access restrictions from within Windows is not supported and may cause unexpected behavior.
• You can also configure users, groups, and shared folders from Easy Admin by clicking **Access Restrictions**.
• Shared folders with limited access can still be used as backup destinations.
• If you change access restrictions for a user or group while they are accessing files, unexpected behavior may result.

**Local Users and Groups**

1. From Settings, click **File Sharing**.

2. Click **Folder Setup** to the right of “Folder Setup”.

3. Click the shared folder that you want to set access restrictions for.

4. Click **Edit**.
5 Enable “Access Restrictions”.

6 Select the level of access for the user or group.

- [ ] Read and write access allowed
- [ ] Read access allowed
- [ ] Access prohibited

7 Click **OK**.

**Notes:**

- The example above shows access restriction by a user. To restrict access by group, click the *Local Groups* tab and select group permissions.
- If both read-only and read and write permissions are given to a user, the user will have read-only access. The most restrictive access always applies.
- For an access-restricted shared folder, if you change the access restrictions of all users and groups from read and write or read-only to access prohibited from the user or group list page in Settings, that shared folder can only be accessed by admin users and groups.

**Active Directory**

If there is an Active Directory environment, the TeraStation will use account information from the Active Directory domain controller to set access restrictions for TeraStation’s shared folders. There is no need to perform individual account management for the TeraStation. If multiple TeraStations are installed on the network, the account information is centrally managed in Active Directory, greatly reducing the operations required for installation and management.

**Notes:**

- If usernames or group names from Active Directory include multibyte characters, you will not be able to configure access restrictions for them.
- The TeraStation supports a domain environment with a maximum of 1000 users and 1000 groups.

1 From Settings, click **Network**.
2 Click to the right of “Workgroup/Domain”.

3 Click Edit.

4 Select “Active Directory”, then click Next.

5 Click Yes.

6 Enter the desired settings, then click OK.

7 Click to the right of “Folder Setup”.

Chapter 3 File Sharing
8 Click the shared folder that you want to set access restrictions for.

![Shared Folder List](image)

9 Click Edit.

10 Enable “Access Restrictions”.

![Access Restrictions](image)

11 Select the level of access for the user or group.

- Read and write access allowed
- Read access allowed
- Access prohibited

12 Click OK.

Notes:

- To have the TeraStation join an Active Directory domain, configure it to use a DNS server that can resolve names for the Active Directory domain.
- After building an Active Directory domain, the administrator password for joining the domain must be changed at least once, or joining the Active Directory domain will fail.
- The DNS name and NetBIOS name of Active Directory domains should be identical.
- If both read-only and read and write permissions are given to a user, the user will have read-only access. The most restrictive access setting will apply.
- If there is a difference of more than 5 minutes between the TeraStation's clock and the domain controller's clock, joining the domain or authenticating domain users and groups may fail. For best results, use an NTP server to set the time for all network devices.
- To use the TeraStation as a member server in an Active Directory domain, the TeraStation should be logged in to the domain and accessed from a computer that is not a member of the domain with a valid domain account.
- If the TeraStation is a member server of an Active Directory domain, you cannot connect as a guest user via AFP.
- If your TeraStation is a member server in an Active Directory domain and you change the authentication method to "Workgroup", the account on the domain controller will not be deleted automatically.
- If FTP is enabled, local and domain group access restrictions from the AD network do not work. Use user access restrictions instead.
• Don’t disable the SMB protocol while Active Directory is used for access restrictions. If you do, you will need to enable SMB again and reconfigure AD from scratch.
• For an access-restricted shared folder, if you change the access restrictions of all users and groups from read and write or read-only to access prohibited from the user or group list page in Settings, that shared folder can only be accessed by admin users and groups.

**NT Domain**

If there is an NT domain environment, the TeraStation will use account information from the NT domain server to set access restrictions for files and folders on the TeraStation. There is no need to perform individual account management for the TeraStation. If multiple TeraStations are installed on the network, the account information is centrally managed in the NT domain, greatly reducing the operations required for installation and management.

**Note:** The TeraStation supports an NT domain environment with a maximum of 1000 users and 1000 groups.

1. Create an account on the domain controller for the TeraStation.
2. From Settings, click **Network**.
3. Click **Workgroup/Domain** to the right of “Workgroup/Domain”.
4. Click **Edit**.
5. Select “NT Domain”, then click **Next**.

**Note:** To use Active Directory from Windows 2000 or Windows Server 2003, select “Active Directory” instead of “NT Domain”.

6. Click **Yes**.
7 Enter the desired settings, then click OK.

8 Click the right of “Folder Setup”.

9 Click the shared folder that you want to set access restrictions for.

10 Click Edit.

11 Enable “Access Restrictions”.

12 Select the level of access for the user or group.

13 Click OK.
Notes:

• If you change the TeraStation's name, you will no longer be able to use domain users and groups or access restrictions. To repair this, rejoin the domain.
• If both read-only and read and write permissions are given to a user, the user will have read-only access.
• If a domain username is more than 20 bytes long, the TeraStation truncates it to 20 bytes.
• To use the TeraStation as a member server in an NT domain, the TeraStation should be logged in to the domain and accessed from a computer that is not a member of the domain with a valid domain account.
• If the TeraStation is a member server of an NT domain, you cannot connect as a guest user via AFP.
• When you change the user or group settings on the domain controller, these changes may not take effect immediately on the TeraStation until it is rebooted.
• If your TeraStation is a member server in an NT domain and you change the authentication method to "Workgroup", the account on the domain controller will not be deleted automatically.
• If FTP is enabled, local and domain group access restrictions from the NT domain network do not work. Use user access restrictions instead.
• Don’t disable the SMB protocol while an NT domain server is used for access restrictions. If you do, you will need to enable SMB again and reconfigure the NT domain settings from scratch.
• For an access-restricted shared folder, if you change the access restrictions of all users and groups from read and write or read-only to access prohibited from the user or group list page in Settings, that shared folder can only be accessed by admin users and groups.

User Authentication with an External SMB Server

TeraStations on your network can be linked to an external authentication server for centralized management of user accounts and passwords. The authentication server should be another TeraStation or a LinkStation. Other external SMB authentication servers are not supported.

Notes:

• Disable SMB2 before using external authentication.
• Access restrictions for local users and groups will still apply to shared folders if an external SMB server is used for authentication.
• The procedure below contains methods to automatically register external users. You can also manually add external users by converting them from local users. Refer to the “Converting Local Users into External Users” section below for more details on converting local users.

1 From Settings, click Network.

2 Click to the right of “Workgroup/Domain”.

3 Click Edit.
4. Select “Workgroup” and click Next.

5. Click Yes.

6. Enter a workgroup name. Select “Authenticate local and external SMB server users” and enter the SMB server’s IP address. You can also specify a server from another subnet.

7. If “Automatically register users who access TeraStation folders” is checked, users that access any of the TeraStation’s folders will be automatically registered as external users. This process only applies to folders that have access restrictions disabled. After new external users are added, disable this option to limit the number of authenticated user accounts.

8. If “Restrict user registration to a single folder” is checked, the TeraStation will automatically create a read-only shared folder. Enter the shared folder name. Users that access this specific folder will be automatically registered as external users. If this setting is deselected at a later time, the TeraStation will automatically remove the folder.

   **Note:** Connect to the authentication folder via SMB, not FTP or AFP. Automatic user registration may not work with OS X 10.8 (or later) the first time. If this occurs, try rebooting the TeraStation then access the authentication shared folder again.

9. Click OK to save any changes. When saving changes to the external authentication server settings, you may not convert all current local users to external users. If a local user is converted to an external user, their user information (including passwords) will be removed from the NAS. External users cannot be reverted to local users.
10 Click to the right of “Folder Setup”.

11 Click the shared folder that you want to set access restrictions for.

12 Click Edit.

13 Enable “Access Restrictions”.

14 Click the External Users tab and select the level of access for each external user.

- Read and write access allowed
- Read access allowed
- Access prohibited

15 Click OK.

Notes:

- Users that are automatically registered belong to the “hdusers” group. They can be added to other groups from within group settings. Added users will be listed in “Users” > “External Users”. To delete a user that was registered automatically, select that user and click Delete External User.
- If both read-only and read and write permissions are given to a user, the user will have read-only access.
- OS X 10.4 or earlier and Windows Server 2012 are not supported with external authentication.
- To access access-limited shared folders from OS X 10.7, use AFP instead of SMB; under “LAN Protocol Support”, check “AFP (Mac)” on the destination folders to use AFP and click OK.
- If access restrictions are set for users and groups from the authentication server, guest and anonymous connections will not be possible with AFP connections.
- FTP connections do not support authentication with an external SMB server.
- If using a Windows PC for external authentication, the default Windows SMB security settings may need to be changed. An easy way to do this is to run the File Sharing Security Level Change Tool, available from this product's
download page on the Buffalo website. This utility will let you easily change or restore your Windows security settings to work with external authentication.

- If you change all users’ and groups’ access attributes for the access-restricted shared folder, from read and write or read-only to access prohibited in the user or group list page of Settings, that shared folder can only be accessed by admin users and groups.

Converting Local Users into External Users

If using an external SMB server for authentication, you may convert any local users into external users. This way, the TeraStation will have a user list that matches the users in the external SMB server, and access restrictions for this TeraStation’s shared folders may be assigned to the converted “external” users.

Follow the procedure below to convert a local user into an external user. If a local user is converted, their user information (including passwords) will be removed from the TeraStation. External users cannot be reverted to local users.

**Note:** External authentication should be enabled before local users can be converted. For more information on external authentication, refer to the “User Authentication with an External SMB Server” section.

1. From Settings, click *File Sharing*.

2. Click ![Add User](image.png) to the right of “Users”.

3. From the user list screen, check any users to be converted to an external user, then click *Convert to External User*.

4. The “Confirm Operation” screen will open. Enter the confirmation number, then click *OK*.

Converted users are displayed under the “External Users” tab. You can then configure access restrictions for external users.
TeraStations support many types of RAID. The type of RAID arrays available for use depends on how many drives are installed in your TeraStation.

Notes:
- If you change the RAID mode, all data on the array is deleted. This is true for every procedure in this chapter. Always back up any important data before performing actions that affect your RAID array.
- Drive capacity is displayed in Settings in actual gigabytes. The Properties window in Windows may show GiB instead, which will be a smaller number.
- If the TeraStation is restarted or shut down while changing the RAID mode, the message that appears on the LCD panel will change from I46 or I47 to I18.
- RAID 5, 6, and 10 are only available for models with 4 drives.

RAID 6
RAID 6 arrays are available for TeraStations with 4 or more drives. RAID 6 combines 4 or more drives into a single array. The usable space is equal to the sum of the capacity of all drives minus the capacity of two drives. For example, if 4 drives are combined into a RAID 6 array, the usable space is the sum of the capacity of 2 drives. If 2 drives in the array are damaged, you can recover data by replacing them. If 3 or more drives are damaged, your data is lost.

RAID 5
RAID 5 arrays are available for TeraStations with 3 or more drives. RAID 5 combines 3 or more drives into a single array. The usable space is equal to the sum of the capacity of the drives minus the capacity of one drive. For example, if 4 drives are combined into a RAID 5 array, the usable space is the sum of 3 drives. If one drive in the array is damaged, you can recover data by replacing the damaged drive. If two or more drives are damaged at the same time, your data is lost.

RAID 10
RAID 10 arrays are available for TeraStations with 4 or more drives. In this mode, mirrored pairs of drives in RAID 1 arrays are combined into a RAID 0 array. The usable space is equal to the capacity of the smallest drive multiplied by the number of drives divided by 2.

RAID 1
Combines 2 or more drives into a mirrored array. The usable space in the array is the capacity of a single drive. Identical data is written to each drive. If a drive is damaged, data can be recovered by replacing the damaged drive. As long as one drive in the array remains undamaged, all data in the array can be recovered.
RAID 0
Combines 2 or more drives into a single array. The usable space is the total space of all drives used. This simple RAID mode offers faster performance than RAID modes that include parity. If a single drive in the array fails, then all data in the array is lost.

JBOD
This mode uses the drives inside the TeraStation as individual drives. The usable space is the total capacity of all drives in the TeraStation. If any drives are damaged, then the data on that drive is lost.

Working with RAID Arrays
To change RAID settings, navigate to Drives > RAID in Settings.

Using JBOD
With JBOD, each drive in the TeraStation is addressed separately. To put drives from an array into JBOD, follow the procedure below.

1. From Settings, click Drives.
2. Click to the right of “RAID”.
3. Click the array to delete.
4. Click Delete RAID Array.
5. The “Confirm Operation” screen will open. Enter the confirmation number, then click OK.
6 Click OK when finished.

Once JBOD is configured, create shared folders on each drive to use them.

**Changing RAID Mode**

To change the RAID mode, first put the drives in JBOD.

1. From Settings, click *Drives*.

2. Click 🔄 to the right of “RAID”.

3. Click the array to delete.

4. Click *Delete RAID Array*.

5. The “Confirm Operation” screen will open. Enter the confirmation number, then click OK.

6. Click OK.
Choose a RAID array.

Select a RAID mode and the drives to be used, then click **Create RAID Array**.

The “Confirm Operation” screen will open. Enter the confirmation number, then click **OK**.

Click **OK** when finished.

**Notes:**

- Normally, after a RAID array is created, it is “resynced”, which optimizes the array, making it more stable. The resyncing process takes about 10 hours per terabyte of space in the array. File transfers will be slower during this period, but the array will remain fully usable. The I17 message will be shown on the LCD display during the resync.
- You can also configure RAID settings from Easy Admin.
- After changing the RAID mode, create a shared folder.
Configuring a Hot Spare

If you have a hot spare configured and an array fails, the TeraStation immediately switches over to the hot spare. To use a hot spare, you need an extra drive that’s not part of any array and a RAID 1, RAID 10, RAID 5, or RAID 6 array.

Notes:

- All data on the hot spare drive is deleted when it is configured as a hot spare and again when it changes from a spare to a drive in the array.
- A hot spare cannot be configured for TeraStation models with only two drives.

1. From Settings, click Drives.

2. Click ▶ to the right of “RAID”.

3. Choose a RAID array.
4 Click Set as a hot spare.

5 Click Yes.

6 The “Confirm Operation” screen will open. Enter the confirmation number, then click OK.

7 Click OK when finished.

**Note:** To turn the hot spare back to a normal drive, choose *Set as a normal disk*.

**RMM (RAID Mode Manager)**

With RMM, you can create or expand a RAID array without erasing the data on the drives. To use RMM, insert all internal drives of the same size into the slots.

**Changing from JBOD to RAID 1**

You must have at least two drives available in JBOD (not in a RAID array) to build the RAID 1 array with RMM.

1 From Settings, click *Drives*.

2 Click to the right of “RAID”.
3. Choose a RAID array.

4. Set the RAID mode to “RAID 1”.

5. Select the “Add a disk to RAID array with RMM. Your data will be preserved.” checkbox.

6. Select the drive whose data will be saved from the drop-down list.

7. Select the drive to add to the RAID array.

8. Click Create RAID Array.

9. The “Confirm Operation” screen will open. Enter the confirmation number, then click OK.

10. Click OK when finished.
**Adding a Drive to an Existing RAID Array or Changing the RAID Mode While Adding a Drive**

You can add a drive to a RAID 1, RAID 5, or RAID 6 array. Drives in JBOD can be added to the RAID array. **Note:** RMM can be used to expand an array by one drive per operation. To expand by two or more drives, RMM must be performed multiple times.

1. From Settings, click *Drives*.

2. Click 📽️ to the right of "RAID".

3. Choose a RAID array.

   ![RAID Array List](image)
4 Select one drive to add to the RAID array. If changing the RAID mode, choose the desired mode for the array from the drop-down list. If not, keep the current RAID mode as is.

5 Click Change RAID Array.

6 The “Confirm Operation” screen will open. Enter the confirmation number, then click OK.

7 Click OK when finished.

**RAID Scanning**

A RAID scan checks your RAID array for bad sectors and if it finds any, it automatically repairs them. Arrays other than RAID 0 are supported. For best results, run a RAID scan regularly.

1 From Settings, click Drives.

2 Move the RAID scanning switch to the position to enable RAID scanning.

3 Click to the right of “RAID Scanning”.

4 Click Edit.
5 Select when to run the scan and click OK.

```
RAID Scan Settings

RAID Scan Schedule: 1st week Saturday
Start Time: 2 a.m.

[ ] Immediately

OK Cancel
```

Notes:
- Select the "Immediately" checkbox to run a RAID scan immediately.
- To stop a RAID scan, click Cancel RAID Scan.

## Adding an External Drive

### Connecting an External Drive

Your TeraStation includes USB ports (the number of ports depends on your model), and you can connect external drives to these ports. Once connected, they appear as shared folders on the TeraStation. Formatted drives are detected automatically. Unformatted drives should be formatted in Settings.

After a USB drive is recognized, the TeraStation adds "usbdisk x" to the shared folder list, where "x" is the USB port to which the drive is connected.

### Compatibility

The following USB devices are supported by the TeraStation:
- USB storage devices
- Card readers (except for card readers that can recognize two or more memory cards)

Buffalo external USB drives are recommended but DUB and DIU series drives are not supported.

Supported file systems for external drives are below:
- FAT32
- Ext3
- XFS
- NTFS
- HFS Plus (read-only)

Connect only one device to each USB port of the TeraStation. Some external drives with automatic power-on won’t turn on automatically when connected to the TeraStation. Use their manual power switch to turn them on. Be sure to connect only one bus-powered drive at a time. If there is insufficient bus power for your USB drive, connect its AC adapter. Note that only the first partition of a connected USB drive is mounted. Additional partitions are not recognized. Do not connect bus-powered devices to the 2-drive TeraStation models.
Notes:
• Backup data from macOS may include characters that cannot be written to FAT32 drives such as “.DS_Store”. For best results, reformat the drive before using it as a backup target.
• The TeraStation is compatible with most USB 2.0 external drives. Compatible USB 3.0 external drives include HD-LBU3 series, HD-LXU3 series, HD-PCTU3 series, HD-PNTU3 series, HD-PZU3 series (as of May 2013).

Dismounting Drives
If the TeraStation is powered on, dismount drives (internal and external) before unplugging them. You may dismount external drives using the function button, or dismount any drive from Settings. If the TeraStation is off, then all drives are already dismounted and may be unplugged safely.

Dismounting with the Function Button
Press and hold the function button for 8 seconds. The function button will light up blue for 30 seconds as your USB drives are dismounted. When the dismount is finished, the function button’s LED will turn off, then come back on. You may now unplug any USB drives safely. After 60 seconds, the function LED will go out and any drives that have not yet been unplugged will be remounted.

Dismounting from Settings
1. From Settings, click Drives.

2. Click Drives to dismount an internal drive or USB Drives to dismount an external drive.
3 Select the drive to dismount and click Dismount Disk.

4 The “Confirm Operation” screen will open. Enter the confirmation number, then click OK.

5 When the dismounting process is completed, it is safe to unplug the drive. Disconnect the drive from the TeraStation.

Note: To remount the drive, unplug it and then plug it back in.

Checking Drives

A drive check tests the data on a drive in the TeraStation or one that is connected via USB for integrity. Errors are fixed automatically. With large drives, a drive check may run for many hours. Shared folders cannot be accessed during a drive check. Do not turn off the TeraStation until the drive check is finished. Use the procedure below to run a drive check.

1 From Settings, click Drives.

2 Select Drives to check an internal drive or USB Drives to check an external drive.
3 Select the drive or array to test, then click Check Disk.

4 Click Check. You have the option of deleting information files from macOS during the check if desired.

Formatting Drives

Notes:
- Under some circumstances, data deleted when a drive is formatted can be recovered. To ensure that data is “gone forever”, a format might not be sufficient. Refer to the “Erasing Data on the TeraStation Completely” section below.
- After a drive is formatted, the “% Used” and “Amount Used” in Settings will not be 0. This is because some drive space is used for the system area.

1 From Settings, click Drives.
2. Select Drives to format an internal drive or USB Drives to format an external drive.

3. Select the drive or array to format, then click Format Disk.

4. Select a format type, then click Format.

5. The “Confirm Operation” screen will open. Enter the confirmation number, then click OK.

6. Depending on the size and the formatted file system of your drive, the format may take several minutes or several hours to complete. “Formatting” will be displayed on the LCD panel until the format is complete. Click OK when finished.

Notes:
- Do not turn off or disconnect power to the TeraStation while formatting a drive.
For drives of 2.2 TB or larger, make sure that the “GPT Partition” checkbox is selected. For many drives, this option will be enabled automatically during format.

### Encrypting Drives

Internal drives (and arrays) can be encrypted with 128-bit AES during formatting. Encrypted drives and arrays are then readable only from that specific TeraStation. To decrypt a drive or array, clear the “Encryption” checkbox and format it again.

**Warning:** Before formatting, check that the disk is not set as a backup device. Do not format if the disk is set as a backup device.

### Media Cartridges

If configured as a media cartridge, an internal drive can be used as a removable storage device in the same way as an external drive. Media cartridges can be unplugged and connected to a different TeraStation with all data intact. To configure a drive as a media cartridge, select the “Media Cartridge” checkbox during formatting. To return it to its original state, clear the “Media Cartridge” checkbox and reformat the drive.

Media cartridges do not support:
- RAID arrays
- LVM volumes
- Access restrictions
- Direct connection to a Windows computer
Erasing Data on the TeraStation Completely

Under some circumstances, data from formatted drives can be recovered. The drive erasure process in this section does a much more thorough job of erasing data. This procedure is recommended for removing all data from a drive in a way that makes it nearly impossible to recover with current tools. The TeraStation will then be in the following state:

- All drives in JBOD
- An empty shared folder on each drive
- All settings returned to their default values
- All logs deleted

If you remove a drive and then erase all data on the TeraStation, the LCD panel will show the E22 message and the number of the removed drive. You can still use the TeraStation.

Follow the procedure below to completely and permanently erase all data from your TeraStation.

1. From Settings, click Management.

2. Click to the right of "Restore/Erase".

3. Click Erase TeraStation.

4. The “Confirm Operation” screen will open. Enter the confirmation number, then click OK.

5. All data on the TeraStation will be permanently erased.

Drive Quotas

You can set a drive quota to limit drive space for each user or group. You can also set a threshold. If the drive space exceeds the configured threshold, an email notification will be sent. To configure email notifications for the drive quota, refer to the “Email Notification” section in chapter 10.

Notes:

- When using quotas, disable the recycle bin or empty the trash folder often. The limited space includes the space used for trash.
- Quotas apply per drive or per array. If a quota is set to 1 GB, each array or drive can use a maximum of 1 GB.
- Quotas cannot be set for external drives connected to the TeraStation and drives that are configured as media cartridges.
- If both user and group quotas are configured for a user, the most restrictive quota will always apply.
- Make sure that SMB2 is disabled before using quotas on the TeraStation.
Quotas for Users
Follow this procedure to limit the shared folder drive space available for a user.

1. From Settings, click File Sharing.

2. Click to the right of “Users”.

3. Select the user that will be given a quota and click Edit. If you want to set a quota for a new user, create a user by referring to the “Adding a User” section in chapter 3.

4. Enable quotas, choose the alert and the maximum amount of space the user will be allowed to use, and click OK.

Note: If you change the primary group, restart the TeraStation to apply the quota settings.

Quotas for Groups
Follow the procedure below to limit the space for shared folders that each group can use.

1. From Settings, click File Sharing.

2. Click to the right of “Groups”.

3. Select the group that will be given a quota and click Edit. If you want to set a quota for a new group, create a group by referring to the “Adding a Group” section in chapter 3.
Enable quotas, choose the alert and the maximum amount of space the group will be allowed to use, and click OK.

Click Close.

Click to the right of “Users”.

Select the user that will inherit the group quota settings and click Edit. If you want to add a new user to a group with a quota, create a user by referring to the “Adding a User” section in chapter 3.

Select the group’s checkbox to join and change the user’s primary group to the group with the quota, then click OK.

Click Close.

Click at the top-right of Settings and select Restart.

Size Limits

If LVM is enabled, volumes can be created with maximum size limits.

Note: When creating an LVM volume, all data in the area where you specified for the LVM volume will be erased. Before changing any settings, back up any important data.

From Settings, click Drives.

Click to the right of “LVM”.
3 Select the drive or array where the volume will be located and click *Enable LVM on Volume*.

4 The "Confirm Operation" screen will open. Enter the confirmation number, then click *OK*.

5 Click *OK*.

6 Click *Edit* under "NAS Volume".
7 Click Create Volume.

8 Configure the desired settings, then click OK.

9 Click OK.

10 Click Close, then click Close again.

11 Navigate to File Sharing > Folder Setup.

12 Click Create Folder.

13 Configure the settings.

14 Select the volume that you created for "Volume" and click OK.
Using the TeraStation as an iSCSI Device

Introduction

iSCSI is a protocol for carrying SCSI commands over IP networks. Unlike traditional SAN protocols such as Fibre Channel, which requires special-purpose cabling, iSCSI can be run over long distances using existing network infrastructure. Normal Windows formatting such as NTFS is supported.

Differences Between NAS and iSCSI

With iSCSI, the TeraStation is connected to a single computer, such as a server. Other computers on the network access files on the TeraStation through the computer it’s connected to. The TeraStation can be used as a local drive from Windows Server. Features of Windows Server such as Active Directory can be used normally.

As a NAS, the TeraStation is a server, and computers (including other servers) on the network can access shared folders on it directly. A separate server is not required, and features such as backup are built-in.

Network Configuration

Use gigabit or faster network equipment with iSCSI. For best results, a dedicated network for iSCSI is recommended, separate from the regular network. By default, the IP address of the TeraStation is automatically assigned from a DHCP server. However, in this case, if you turn off and restart the TeraStation, the IP address may be changed and the volumes on the TeraStation may not be accessible. To avoid changing the IP address unexpectedly, using a static IP address for the TeraStation is recommended.

Connection Tool

Windows XP, Windows Server 2003

Before using any iSCSI equipments, download and install the iSCSI connection software “Microsoft iSCSI Software Initiator” from the Microsoft website. You can also use Buffalo iSCSI Connection Tool to connect an iSCSI drive.

Windows Vista or later, Windows Server 2008 or later

The Microsoft iSCSI Software Initiator is already installed on your computer. You don’t need to download and install it.

You can also use Buffalo iSCSI Connection Tool to connect to an iSCSI drive on except for Windows 10. If you are using Windows 10, use Microsoft iSCSI Software Initiator.

Creating an iSCSI Volume

To use the TeraStation as an iSCSI drive, create a volume first. Configure the TeraStation as described below.
Notes:

- If the volume settings are changed, all data on the volume will be erased. Before changing any settings, back up any important data.
- The TeraStation can have up to 255 volumes, but we recommend creating no more than 32. Exceeding this volume amount may cause irreparable damage to the unit.
- Do not use any of the following words for the name of a volume as these words are reserved for internal use by the TeraStation: arrayx, authtest, diskx, global, homes, info, lost+found, lp, mediacartridge, msdfs_root, mtdaapd, printers, ram, spool, usbdiskx. Any instances of “x” denote a number (for example: array1 or disk3)

1. From Settings, click Drives.

2. If you want to specify a volume size or change it later, enable LVM by referring to the “Size Limits” section above. LVM does not need to be enabled for a drive or array to be used as an iSCSI drive, as you can still create an iSCSI volume from the entire drive or array. However, enabling LVM is recommended for drives or arrays that will be used for iSCSI.

   To use the whole drive or array as an iSCSI drive, proceed to the next step.

3. Move the iSCSI switch to the position to enable iSCSI.

4. Click to the right of “iSCSI”.

5. Click Create Volume.
Enter a volume name, volume description, drive or array where a volume will be created, and volume size. Click OK when finished.

If you enabled LVM for the target drive or array, the volume size that you specify here can be changed later. To change the volume size, refer to the “Expanding Volume Sizes” section below.

The “Confirm Operation” screen will open. Enter the confirmation number, then click OK.

Click OK, then click Close.

Note: If you click Disable Connection for the selected volume in Drives > iSCSI in Settings, the selected iSCSI volume can no longer be accessed. If you click Enable Connection, the volume will become accessible from the iSCSI initiator software.

Connecting or Disconnecting Volumes

There are two methods to connect or disconnect volumes. One uses the pre-installed Microsoft iSCSI Initiator on Windows; the other uses Buffalo iSCSI Connection Tool.

Using Microsoft iSCSI Initiator

Connecting Volumes

To connect a volume using Microsoft iSCSI Initiator from a Windows computer, follow the procedure below.

Note: Do not shut down the TeraStation while connecting to an iSCSI volume. It may cause unexpected data erasure. Make sure all connections are disconnected before shutdown.

1 From Windows, navigate to Control Panel > System and Security > Administrative Tools > iSCSI Initiator.
2 Enter the IP address of the TeraStation into the “Target” field and click Quick Connect.

3 Confirm if the connection is established and click Done.

**Formatting Volumes**

If using the connected volume for the first time, the volume should be formatted to be used as a local drive. Follow the procedure below for formatting.

1 From Windows, navigate to Control Panel > System and Security > Administrative Tools > Computer Management.

2 Click Disk Management.
   When the “Initialize Disk” screen appears, click OK without changing any settings.
Right-click the drive volume that shows the status “Unallocated” and click New Simple Volume from the displayed menu. Follow the screen to finish formatting.

When the formatting process is completed, the drive will be visible as an icon in Computer or My Computer and can be used as a normal drive on the computer.

Disconnecting a Volume

1. From Windows, navigate to Control Panel > System and Security > Administrative Tools > iSCSI Initiator. The status of the connecting volume will be displayed as “Connected” under “Discovered targets”.
2. Select a volume to disconnect and click Disconnect.
3. Click Yes.
4. When the volume status is displayed as “Inactive”, the disconnection was carried out properly.

Using Buffalo iSCSI Connection Tool

Connecting a Volume

To connect a volume using Buffalo iSCSI Connection Tool from a Windows computer, follow the procedure below.

1. Click Start > Programs > Buffalo > iSCSI Connection Tool > iSCSI Connection Tool. iSCSI Connection Tool will open.
2 Select the TeraStation name from the drop-down list of “Target” and click *Register iSCSI Device*.

3 Click OK.
4 Select a volume to connect from the drop-down list of "Volume" and click Connect.

5 Click OK.

Formatting Volumes

If using the connected volume for the first time, the volume should be formatted to be used as a local drive. Follow the procedure below for formatting.

1 From Windows, navigate to Control Panel > System and Security > Administrative Tools > Computer Management.

2 Click Disk Management.
   When the "Initialize Disk" screen appears, click OK without changing any settings.

3 Right-click the drive volume that shows the status "Unallocated" and click New Simple Volume from the displayed menu. Follow the screen to finish formatting.

When the formatting process is completed, the drive will be visible as an icon in Computer or My Computer and can be used as a normal drive on the computer.

Disconnecting a Volume

1 Click Start > Programs > Buffalo > iSCSI Connection Tool > iSCSI Connection Tool.
   iSCSI Connection Tool will open.
2 Select a volume to disconnect from the drop-down list of “Volume” and click Disconnect.

3 Click Yes.

4 Click OK.
5 Select the TeraStation name from the drop-down list of “Target” and click Unregister iSCSI Device.

6 Click OK.

Using with Multiple Computers

If the TeraStation is divided into multiple volumes (or drives), it can be used with multiple computers. However, multiple computers cannot be accessed from one volume (or one drive) at the same time.

Checking Whether iSCSI Volume Is Connected

To check whether an iSCSI volume is connected, navigate to Drives > iSCSI. Current volumes will be listed. If “Connected” is displayed under “Status”, the volume is currently connected to the client.

Configuring Access Restrictions

A CHAP name and secret can be configured for the entire iSCSI volume or each existing volume. Access restrictions can be configured so that entering a target CHAP name and secret is required for each connection.

The TeraStation can perform mutual authentication (two-way authentication). Dual passwords ensure that only authorized client computers can access the volume on the TeraStation.

Follow the procedure below to enable access restrictions.
Configuring Access Restrictions for the Entire TeraStation

1. From Settings, click Drives.

2. Click to the right of “iSCSI”.

3. Click the Security tab.

4. Click Edit under “Access Control (Target Discovery)”.

![iSCSI Settings](image)
5 Enable authentication, enter the target CHAP name and secret, and click OK.

![Security Settings](image)

**Note:** To enable mutual authentication in addition to target CHAP name and secret authentication, select the “Enable mutual authentication” checkbox and enter the initiator CHAP secret.

To search or connect the volume which has mutual authentication enabled from Microsoft iSCSI Initiator, initiator CHAP secret settings should be configured.

### Connecting Volumes on the Access-Restricted TeraStation

#### Using Microsoft iSCSI Initiator

If access restrictions are configured for the entire iSCSI volume, that volume will not be detected by Microsoft iSCSI Initiator. To connect that volume, the target CHAP name and secret should be authenticated.

1. Open the Microsoft iSCSI Initiator.

2. Register the initiator CHAP secret to your computer first. If you didn’t enable mutual authentication, skip this step.
   - Click CHAP on the Configuration tab. Enter the configured initiator CHAP secret into the "Initiator CHAP secret" field and click OK.

3. From the Discovery tab, click Discover Portal.

4. Enter the TeraStation’s IP address into the “IP address or DNS name” field.

5. Click Advanced.

6. Select the “Enable CHAP log on” checkbox and enter the target CHAP name into the “Name” field and the target CHAP secret into the “Target secret” field.
   - If mutual authentication is enabled, select the “Perform mutual authentication” checkbox.

7. Click OK, then click OK again.

8. From the Targets tab, select the volume from “Discovered targets” and click Connect > OK.

9. If the status of the selected volume is displayed as “Connected” under "Discovered targets", the connection is established properly.
Using Buffalo iSCSI Connection Tool

1. Open the Buffalo iSCSI Connection Tool.

2. Select the TeraStation name from the drop-down list of “Target” and click **Register iSCSI Device**.

3. The screen to enter the username and password will be displayed. Enter the target CHAP name into the “Username” field and the target CHAP secret into the “Password” field, and click **OK**. If mutual authentication is enabled, select the “Mutual Authentication” checkbox, then click **OK**.
4. If "Mutual Authentication" is checked, the following screen will be displayed. Enter the initiator CHAP secret and click OK.

5. When authentication is successful, click OK.

6. Select a volume to connect from the drop-down list of "Volume" and click Connect.

7. Click OK.

**Configuring Access Restrictions for Individual Volumes**

If access restrictions are configured for a volume, that volume cannot be accessed unless the target CHAP name and secret are authenticated.

1. From Settings, click Drives.
2 Click to the right of “iSCSI”.

3 Click the volume to enable access restrictions.

4 Enable authentication, enter the target CHAP name and secret, and click OK.

Note: To enable mutual authentication, select the “Enable” checkbox to the right of “Mutual Authentication” and enter the initiator CHAP secret.

5 Click OK.

Connecting to Individual Volumes that Are Access-Restricted

Using Microsoft iSCSI Initiator

1 Open the Microsoft iSCSI Initiator.

2 Register the initiator CHAP secret to your computer first. If you didn’t enable mutual authentication, skip this step.
   Click CHAP on the Configuration tab. Enter the configured initiator CHAP secret into the “Initiator CHAP secret” field and click OK.

3 From the Discovery tab, click Discover Portal.

4 Enter the TeraStation’s IP address into the “IP address or DNS name” field.

5 Click Advanced.
6. Select the "Enable CHAP log on" checkbox and enter the target CHAP name into the "Name" field and the target CHAP secret into the "Target secret" field. If mutual authentication is enabled, select the "Perform mutual authentication" checkbox.

7. Click OK, then click OK again.

8. From the Targets tab, select the volume from "Discovered targets" and click Connect.

9. Click Advanced.

10. Select the "Enable CHAP log on" checkbox and enter the target CHAP name into the "Name" field and the target CHAP secret into the "Target secret" field. If mutual authentication is enabled, select the "Perform mutual authentication" checkbox.

11. Click OK, then click OK again.

12. If the status of the selected volume is displayed as "Connected" under "Discovered targets", the connection is established properly.

Using Buffalo iSCSI Connection Tool

1. Open the Buffalo iSCSI Connection Tool.

2. Select the TeraStation name from the drop-down list of "Target" and click Register iSCSI Device.
3. Select a volume to connect from the drop-down list of “Volume” and click Connect.

4. The screen to enter the username and password will be displayed. Enter the target CHAP name into the “Username” field and the target CHAP secret into the “Password” field, and click OK. If mutual authentication is enabled, select the “Mutual Authentication” checkbox, then click OK.
5 If “Mutual Authentication” is checked, the following screen will be displayed. Enter the initiator CHAP secret and click OK.

![Mutual Authentication dialog box]

6 When authentication is successful, click OK.

**Expanding Volume Sizes**

The volume size of the existing volumes can be expanded after they are created.

**Notes:**
- Expanding the volume size may erase all data on the volume depending on the formatting type. Backing up the data before expanding the volume size is recommended.
- To expand the volume size, the volume needs to have been created in a drive or array with LVM enabled.

1 From Settings, click **Drives**.

2 Click **iSCSI** to the right of “iSCSI”.

3 Select the volume to expand.
4 Enter the desired volume size to add and click OK.

5 Click OK.

Deleting Volumes

To delete an existing volume, follow the procedure below.

Note: Deleting a volume will erase all data on the volume. Back up the data before deleting the volume.

1 From Settings, click Drives.

2 Click to the right of “iSCSI”.

Chapter 4 Storage Management
3 Select the volume to delete and click *Delete Volume*.

4 Confirm that the volume is correctly selected on the screen and click *OK*.

5 The “Confirm Operation” screen will open. Enter the confirmation number, then click *OK*.

6 Click *OK*. 
Drive Replacement

Drives in the TeraStation show a blue status LED during normal operation. If a drive fails, its error LED will glow red.

1 Error LED
Glows red if a drive has failed.

2 Status LEDs
The failed drive’s status LED will be glowing a steady red. A drive with a red status LED is ready to hot-swap.

Notes:

• Do not unplug a drive whose status LED is green instead of red. Dismount it first or shut down the TeraStation before swapping a working drive. If you remove the drive without properly dismounting it, data may be lost or the TeraStation may malfunction.

• For the replacement drive, use a Buffalo OP-HDS series drive. The replacement drive should be the same size or larger (the same size if using RMM) as the original drive. If a larger drive is used, the extra space will not be usable in a RAID array.

• To avoid damaging the TeraStation with static electricity, ground yourself by touching something made of metal before handling any sensitive electronic parts.

• After a drive is replaced, it will take about 30 minutes before normal file reading and writing are restored. Settings may not be accessible during this period.

• Do not change the order of the drives in the TeraStation. For example, pulling out drive 1 and replacing it with drive 2 may cause data to be corrupted or lost.

• If the LCD panel does not change after a new drive is installed, click Rediscover Disk in Settings.
Using JBOD or a Redundant RAID Mode and TeraStation Is On

1 Open the front cover with the included key.

2 The failed drive's status LED will be glowing red. Push its unlock button and swing the lock mechanism out.
Drives without red status LEDs lit are still on. Do not unplug or remove them.

3 Pull out the drive cartridge and remove it from the TeraStation.
Insert the new drive into the empty slot. Slide the drive in with the locking mechanism open.
5 Swing the lock back down until it clicks into place.

6 Close the front cover.

7 When the replacement drive is recognized, the status LED will flash red and the I31 message will appear on the LCD panel.

8 Press and hold the function button on the front of the TeraStation for 3 seconds until it beeps.
For RAID 1, 5, or 6:
The TeraStation will start rebuilding the RAID array automatically. After a few minutes, the I18 message will appear until the array is rebuilt.

For JBOD:
The drive will be formatted as an individual drive. Create a shared folder on the drive before use.

Using a Redundant RAID Mode and TeraStation Is Off

1. Open the front cover with the included key.
2. The failed drive’s status LED will be glowing red. Push its unlock button and swing the lock mechanism out.
3. Pull out the drive cartridge and remove it from the TeraStation.
4. Insert the new drive into the empty slot. Slide the drive in with the locking mechanism open. Swing the lock back down until it clicks into place.
5. Close the front cover.
6. Press the power button on the TeraStation.
7. When the replacement drive is recognized, the status LED will flash red and the I31 message will appear on the LCD panel.
8. Press and hold the function button on the front of the TeraStation for 3 seconds until it beeps. The TeraStation will start rebuilding the RAID array automatically. It will take about 5 minutes before the I18 message appears.

Using RAID 0

Drives in a RAID 0 array do not automatically turn off in the event of a malfunction. Before replacing the failed drive, either dismount the drive from Settings or shut down the TeraStation.

This section describes the process of replacing a drive when the TeraStation is on.

Note: If a drive malfunctions in RAID 0, all data on the RAID array will be lost. All of the settings for the shared folders (such as access restrictions) are erased after replacing a drive from a RAID 0 array.

1. Open the front cover with the included key.
2. From Settings, navigate to Drives > Drives.
3. Select the drive with the flashing status LED and click Dismount Disk.
4. Enter the number that appears on the screen, then click OK.
5. The status LED will stop flashing and glow steadily.
6. Unlock the failed drive by pushing the unlock button and swinging the lock mechanism out.
   Note: Drives without red status LEDs lit are still on. Do not unplug or remove them.
7. Pull out the drive cartridge and remove it from the TeraStation.
8. Insert the new drive (sold separately) into the empty slot. Slide the drive in with the locking mechanism open. Swing the lock back down until it clicks into place.
9 Close the front cover.

10 When the replacement drive is recognized, the status LED will flash red and the I32 message will appear on the LCD panel.

Select the RAID array from Drives > RAID in Settings and click Delete RAID Array. From Drives > Drives, click Format Disk to format the new drive. From Drives > RAID, choose the type of RAID array desired. Enter the confirmation number, then click OK. Create a shared folder before use.

Using a Hot Spare

If your TeraStation’s drives are in a redundant RAID mode and you have a hot spare enabled, a malfunctioning drive in the array is replaced by the spare drive and the RAID array is rebuilt automatically. The status LED will continue to glow red for the failed drive even after the RAID array is rebuilt with the hot spare. This section describes the replacement process for a drive while the TeraStation is still on.

1 Open the front cover with the included key.

2 The failed drive’s status LED will be glowing red. Push its unlock button and swing the lock mechanism out.

3 Pull out the drive cartridge and remove it from the TeraStation.

4 Insert the new drive into the empty slot. Slide the drive in with the locking mechanism open. Swing the lock back down until it clicks into place.

5 Close the front cover.

6 When the replacement drive is recognized, the status LED will flash red and the I31 message will appear on the LCD panel.

7 Press and hold the function button on the front of the TeraStation for 3 seconds until it beeps. The replacement drive is automatically registered as a hot spare.

To use the replacement drive as a normal drive rather than a hot spare, navigate to Drives > RAID and click the RAID array, select the new drive, and click Set as a normal disk.

Note: If a drive fails in the RAID array before it is rebooted, the hot spare will not automatically replace the failed drive. In this case, follow the procedure below to repair the array.

(1) From Settings, navigate to Drives > Drives.
(2) Click the drive that was configured as a hot spare, then click Dismount Disk.
(3) Click Rediscover Disk.
(4) Navigate to Drives > RAID.
(5) Choose the RAID array to repair.
(6) Click the drive that was previously configured as a hot spare, then click Recover RAID Array.
This will rebuild the RAID array.

Replacing a Media Cartridge

Drives configured as media cartridges may be removed and moved to a different TeraStation for use. Before unplugging the drive, dismount it in Settings or shut down the TeraStation.

Replacing a Non-Malfunctioning Drive

Do not replace a drive that is not malfunctioning (unless it has been converted to a media cartridge).
If you must change a drive that is not malfunctioning, either first dismount it in Settings, referring to the "Dismounting Drives" section above or shut down the TeraStation before replacing the drive. If you need to replace more than one drive at the same time, replace the drives one at a time to preserve your data. When replacing the non-malfunctioning drive, the RAID array will function as below:

**Operating in RAID 0 Mode**

All data on the RAID array will be deleted after replacing the drive. You will not be able to use the TeraStation until you delete and rebuild the RAID array with the new drive.

**Operating in JBOD**

All data on that drive will be deleted after replacing the drive. You will not be able to use the TeraStation until you format the new drive.

**Operating in a Redundant RAID Mode**

If you are using a redundant RAID mode such as RAID 1, 5, or 6, the RAID array will be in degraded mode after replacing the drive. You will not be able to use the TeraStation until you rebuild the RAID array with the new drive.
Chapter 5 Backup

Backing Up to a Buffalo NAS Device

You can back up the TeraStation folders to another shared folder on the same TeraStation, a connected USB drive, or a shared folder on another Buffalo NAS device, either on the same network or on another network.

Note: You can also configure backup jobs from Easy Admin.

Preparing a Backup Destination

First, configure a shared folder on a Buffalo NAS device or connected USB drive as a backup destination. The following procedure explains using another shared folder on a TeraStation as a backup destination. The procedure may vary depending on which Buffalo NAS device is selected as a destination.

1. From Settings, click File Sharing.

2. Click to the right of “Folder Setup”.

3. Choose the folder to set as a backup destination.

4. Click Edit.

6 Click OK.

![Image of a note with a warning about the backup device access key.]  

7 Enter the desired characters into the backup device access key field and click OK.

```
Backup Device Access Key: [********]
```

Note: You may leave this field blank if you do not want a backup device access key, but for security reasons we highly recommend entering one for the shared folder. If a backup device access key is configured for the shared folder, that folder will not show up as a target for the backup source or backup destination when configuring a backup job on another Buffalo NAS device unless it’s entered. You may create multiple folders using different backup device access keys for backup and replication, but only one access key can be used on the TeraStation. Folders that are configured with a different access key cannot be used.

### Configuring a Backup Job

You can configure backup jobs by using another shared folder on the Buffalo NAS device or a USB drive connected to the TeraStation as a destination. You can also back up to a Buffalo NAS device on another network as long as the two networks are connected by a VPN or the route is configured properly.

1 From Settings, click Backup.

2 Click [ ] to the right of “Backup”.

![Image of the Backup page on a device interface.]
3 If you had configured a backup device access key for the backup source folder on another Buffalo NAS device or the backup destination folder, click Set. If you hadn’t, skip to step 5.

4 Enter the backup device access key and click OK.
5 Click Create New Job.
6 Select backup settings such as date and time to run. Refer to the differences between the backup modes in the "Backup Modes" section below.

7 Click Add.

Note: If you want to back up to a Buffalo NAS device on another network, follow the procedure below to add the Buffalo NAS device on another network before selecting the backup folders.

a. Click LinkStation and TeraStation List.
b. Click Add under "Off-subnet Devices", enter the IP address or hostname of the destination Buffalo NAS device, and click Refresh. Make sure that the desired Buffalo NAS device is added to the "Detected LinkStations and TeraStations" list.
c. Click Close when finished.

8 Click Browse under "Backup Source Folder Name".
9 Select the shared folder that will be the backup source, then click OK.

10 Click Browse under "Backup Target Folder Name".

11 Select the shared folder that will be the backup destination, then click OK.

12 Click OK. Jobs will be added to the backup list.
Chapter 5 Backup

Notes:

• Up to 8 backup jobs can be configured.

• To back up data between Buffalo NAS devices on a network using jumbo frames, make sure that both devices are configured to use identical (or similar) Ethernet frame sizes. If Ethernet frame sizes are significantly different, the backup job may not be properly performed. In such a case, select the default frame size (1500 bytes).

• You can also specify a hostname by a fully qualified domain name (FQDN).

• Windows-based TeraStations with multibyte characters in the hostname may not be detected as a backup destination, and folders in these devices cannot be used as backup destination folders.

• If you will use the same folder for both Amazon S3 remote replication and as a backup destination folder, create a new subfolder under "\wbfs\amazons3". Under "LAN Protocol Support", select the "Backup" checkbox and click OK. Without these settings, that shared folder will not be listed in the backup destination folder list.

Backup Modes

The following types of backup jobs may be selected:

<table>
<thead>
<tr>
<th>Type</th>
<th>Files included</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal backup</td>
<td>All files in the source will be backed up to the destination.</td>
</tr>
<tr>
<td>Overwrite (incremental)</td>
<td>The first backup job runs like a normal backup. In subsequent backups, files added to the source as well as files deleted from the source are kept in the backup folder.</td>
</tr>
<tr>
<td>Overwrite (differential)</td>
<td>The first backup job runs like a normal backup. As each additional backup job runs, files are added to and deleted from the backup folder. The backup destination folder is always the same size as the backup source folder.</td>
</tr>
<tr>
<td>Management backup</td>
<td>Each time a backup is executed, management information is stored, and only files that have changed are copied or deleted. Data is retrieved from the previous backup file for files that were not changed. This is useful for making backups with limited space or for referencing status at a particular point in time (for use for data snapshot applications). The destination folder for a management backup should be a local folder on this TeraStation or on a USB drive attached to it. The destination folder will be set to read-only. Do not use folders from drives formatted with FAT. You can specify how many backup versions to keep from 1–400, or select “Unlimited” to keep all backups until the drive is full. The backup destination folder should be on the same TeraStation that the backup job is configured from, or on an external USB drive attached to that TeraStation.</td>
</tr>
</tbody>
</table>

Backup Logs

The following backup error codes may be recorded in the backup log. Read the description and try the respective corrective actions for each error.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Corrective Action</th>
<th>Log Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>The backup destination USB drive could not be found.</td>
<td>Check that the backup destination USB drive is connected to the TeraStation properly.</td>
<td>rsync error: errors selecting input/ output files, dirs (code 3) at main.c(634) [Receiver=3.1.0] Can’t write to backup destination(target disk is broken?).</td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
<td>Corrective Action</td>
<td>Log Example</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Code 5</td>
<td>The backup destination shared folder could not be found.</td>
<td>Check that the Ethernet cable is securely connected and that the hub or other devices on the network are turned on.</td>
<td>rsync error: error starting client-server protocol (code 5) at main.(1504)</td>
</tr>
<tr>
<td>Code 10</td>
<td>The Ethernet cable was disconnected from the backup source TeraStation when the backup job started.</td>
<td>Reconnect the Ethernet cable.</td>
<td>rsync error: error in socket IO (code 10) at clientserver.(128) [sender=3.1.0pre1]</td>
</tr>
<tr>
<td>Code 11</td>
<td>The drive capacity of the backup destination TeraStation became full.</td>
<td>Delete unnecessary files and folders.</td>
<td>rsync error: error in file IO (code 11) at receiver.389 [receiver=3.1.0]</td>
</tr>
<tr>
<td>Code 12</td>
<td>Could not communicate between backup source and destination TeraStations.</td>
<td>Check that the Ethernet cable is securely connected and that the hub or other devices on the network are turned on.</td>
<td>rsync error: error in rsync protocol data stream (code 12) at io.(515)</td>
</tr>
</tbody>
</table>
|        | The settings of the TeraStation were changed while the backup job was running. | Do not change the settings while the backup job is running. If changed, the connection is temporarily terminated and the backup job will fail. | ERROR: out of memory in flist_expand
rsync error: error allocating core memory buffers (code 22) at util.(120) [sender=2.6.8]
rsync: fork failed in do_recv: Cannot allocate memory (12)
rsync error: error in IPC code (code 14) at main.(655) [receiver=2.6.8] |
<p>| Code 14| Insufficient memory on the TeraStation was not enough so that the backup job did not run. | Reduce the number of backup destination files or disable any other functions running at the same time. |                                                                                                                                          |
| Code 12| The connection was disconnected while the backup job was running.           | Do not change the settings while the backup job is running. If changed, the connection is temporarily terminated and the backup job will fail. | rsync error: received SIGINT, SIGTERM, or SIGHUP (code 20) at rsync.(242)                                                             |
| Code 22| The backup destination files were updated while the backup job was running.  | Do not overwrite the backup destination files while the backup job is running. If updated, the backup destination files will not be backed up and the backup job will fail. | rsync error: some files could not be transferred (code 23) at main.(702)                                                              |
| Code 23| Invalid characters were used in the filename or folder name of the backup destinations. | Change the filename or folder name using compatible characters. Available characters are described in the “Adding a Shared Folder” section in chapter 3. |                                                                                                                                          |</p>
<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Corrective Action</th>
<th>Log Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code 23</td>
<td>4 GB or more files were backed up to the FAT32-formatted USB drive.</td>
<td>Reduce the file size to 4 GB or less or change the file system to one other than FAT32. Refer to the “Adding an External Drive” section in chapter 4 for the compatible file systems.</td>
<td>rsync error: some files could not be transferred (code 23) at main.c(702)</td>
</tr>
<tr>
<td>Code 24</td>
<td>The backup destination files were updated while the backup job was running.</td>
<td>Do not overwrite the backup destination files while the backup job is running. If updated, the backup destination files will not be backed up and the backup job will fail.</td>
<td>rsync warning: some files vanished before they could be transferred (code 24) at main.c</td>
</tr>
<tr>
<td>Code 30</td>
<td>The Ethernet cable was disconnected from the backup source or destination TeraStations while the backup job was running.</td>
<td>Reconnect the Ethernet cable.</td>
<td>rsync error: timeout in data send/receive (code 30) at io.c(195) [sender=3.1.0]</td>
</tr>
<tr>
<td>B14</td>
<td>Insufficient TeraStation memory.</td>
<td>Restart the TeraStation and try again.</td>
<td>-</td>
</tr>
<tr>
<td>B101</td>
<td>The backup destination TeraStation does not exist.</td>
<td>Check that the backup destination TeraStation is turned on, the Ethernet cables are securely connected, and the hostname of the backup destination TeraStation is not changed.</td>
<td>-</td>
</tr>
<tr>
<td>B102</td>
<td>The backup source folders on the backup source TeraStation do not exist.</td>
<td>Check that the backup source folders on the backup source TeraStation exist in the shared folder list.</td>
<td>-</td>
</tr>
<tr>
<td>B103</td>
<td>The drives were not recognized.</td>
<td>Check that the drives are recognized properly in Settings. If you configure the “mediacartridge” or “usbdisk” folders for the backup source or destinations, confirm if these folders exist in the shared folder list.</td>
<td>-</td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
<td>Corrective Action</td>
<td>Log Example</td>
</tr>
<tr>
<td>------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>B106</td>
<td>The file systems of the media cartridge and USB drive are not supported.</td>
<td>Check that the media cartridge and USB drive are formatted to the compatible file systems. If you configure the management backup in the backup job, FAT format cannot be used for the backup destination.</td>
<td>-</td>
</tr>
<tr>
<td>B107</td>
<td>The device files such as &quot;/dev/null&quot; etc. does not exist.</td>
<td>Restart the TeraStation and try again.</td>
<td>-</td>
</tr>
</tbody>
</table>

### Replication

Replication copies all data from a share to a share on a different TeraStation. This is an easy way to configure a reliable system to provide data protection in the event your main TeraStation fails. To configure replication, connect an Ethernet cable to the LAN port of each TeraStation and follow the procedure below.

**Notes:**
- For best results, use static IP addresses for connecting both replication TeraStations (source and destination).
- Replication source data is copied to the replication destination folder with a differential overwrite. Any data that is not in the replication source will be overwritten.

#### Preparing a Replication Destination

First, configure a folder as a replication destination.

1. From Settings, click **File Sharing**.

2. Click **Folder Setup** to the right of "Folder Setup".

3. Choose the folder to set as a replication destination.

4. Click **Edit**.

6 Click OK.

![Image]

Note

The backup device access key is blank. It is recommended that you set an access key for security. In order for another device to use this folder as source for backup or a destination for replication or backup, you must enter this access key under the setup for that function.

OK

7 Enter the desired characters into the backup device access key field and click OK.

Backup Device Access Key: •••••

Note: You may leave this field blank if you do not want a backup device access key, but for security reasons we highly recommend entering one for the shared folder. If a backup device access key is configured for the shared folder, that folder will not show up as the replication destination when configuring a replication task on another Buffalo NAS device unless it’s entered. You may create multiple folders using different backup device access keys for backup and replication, but only one access key can be used on the TeraStation. Folders that are configured with a different access key cannot be used.

Configuring a Replication Task

1 From Settings, click Backup.

![Image]

2 Click to the right of “Replication”.

![Image]

3 Click Edit.

![Image]
4 If you had configured a backup device access key for the replication destination folder, click Set. If you hadn’t, skip to step 6.

5 Enter the backup device access key and click OK.

6 Click Add.

7 Click Browse under “Replication Source”.
8 Select the shared folder that will be the replication source, then click OK.

9 Click Browse under “Replication Target”.

10 Select the shared folder that will be the replication destination, then click OK.

11 Click OK, then Yes.
Notes:

- During setup, you may choose to encrypt and/or compress replication data. Encrypted data will be transferred securely on the network. Compressed data will ease network loading and is recommended for slow or heavily loaded network connections. Either will increase the CPU load on the source TeraStation. Encrypted and compressed data will be decrypted and decompressed on the destination TeraStation.
- A maximum of 64 shared folders can be configured for replication.
- Replication can also be used to copy all data from a share to a share on an attached external drive. Format the drive with ext3 or XFS before using it for replication. Drives with FAT, NTFS, and HFS file systems are not supported with replication.
- You can select the first and second levels of shared folders and USB drives connected to the TeraStation as the replication source. Folders whose names contain more than 80 alphanumeric characters cannot be selected.
- Do not use the same TeraStation for both failover and replication, or replication and Time Machine.
- Don't configure replication from one source folder to multiple destination folders.
- If a network problem causes a replication error, unsynced data may be shown as "0" even though replication is incomplete. Click Resync to recover from the replication error. All files from the source folder will be copied to the destination folder.

Failover

With failover, two TeraStations are connected to the network for redundancy. If an issue renders the main TeraStation inaccessible, operation automatically switches to the backup TeraStation.

Failover will activate during any of the following situations:

- **The backup TeraStation cannot detect the main TeraStation within a specified time**
  
  If the backup TeraStation has not received a packet from the main TeraStation within a specified time, the backup TeraStation considers the main TeraStation to have failed. By default, it will try 5 times and wait 60 seconds. If this is triggered by accident, reconfigure failover from the main TeraStation.
Errors
Failover will occur if any of the following errors occur:
E12 (cooling failure), E14 (cannot mount RAID array), E16 (drive not found), E22 (cannot mount drive), E30 (drive failure)

Notes:
• Only use identical model and capacity TeraStations for failover. If the capacity of the main TeraStation is larger than that of the backup TeraStation, an I33 replication error will occur.
• All drive bays of a TeraStation should be occupied if it will be used for failover. Failover will not work if a drive is missing from any bay.

Before Configuring Failover
Use the same LAN ports for transferring data and configure both TeraStations with static IP addresses for the purposes of failover.
When failover, the backup TeraStation will take over the hostname and IP address of the main TeraStation unless the IP conflict is detected. If you want to assign different IP address to the backup TeraStation after failover, configure the “service IP address”. The service IP address will be a new address of the backup TeraStation when it takes over operation from the TeraStation.

Using the Same LAN Port for Both Failover and Connecting to the Network
Using this setup, if the main TeraStation fails, the backup TeraStation will replace it completely. The backup TeraStation will be updated over normal network traffic.

Using Different LAN Ports for Connecting to the Network and Failover
With this setup, the backup TeraStation and main TeraStation are connected by a second Ethernet cable connecting their LAN 2 ports. Updating is done over this dedicated network path, so updates are quicker and don't interfere with normal network traffic.
Usage Restrictions

Functional Restrictions
Failover is not available when any of the following functions are enabled:
Replication, sleep mode, encrypted drive volume, MySQL server, media cartridge, LVM volume, iSCSI volume, port trunking, cloud storage, surveillance server, hot spare, access restrictions by Active Directory or NT domain

Setting Restrictions
The following functions will not be available while failover is enabled:
Initializing settings, changing the RAID settings, formatting drives, iSCSI volume, changing the backup TeraStation's settings, turning the TeraStation on and off, updating the firmware

While failover is enabled, shutdown, power-on, and firmware update operations can be made available by temporarily changing the TeraStation to maintenance mode. Maintenance mode can be enabled or disabled at Backup > Failover in the main TeraStation's Settings. Click Maintenance mode to enable maintenance mode, or click Cancel maintenance mode to disable maintenance mode.
To update the firmware while in maintenance mode, the main TeraStation can be updated from Settings, but the backup TeraStation cannot. Download the firmware updater from the Buffalo website for the backup TeraStation and try updating the firmware on it.

Non-Transferable Settings
The settings below are not copied from the main TeraStation to the backup TeraStation. Make a note of the original settings so that they can be configured manually if failover errors.
Web server (including PHP), MySQL server, Direct Copy, WebAccess*, print server, UPS synchronization, antivirus**, SNMP (when using SNMPv3)
*If the backup TeraStation took over the main TeraStation's IP address after failover, the WebAccess settings will not be copied. Re-register your BuffaloNAS.com account for WebAccess. If the backup TeraStation kept its IP address, the settings will be copied from the main TeraStation.
**The settings configured on the Trend Micro NAS Security settings page will not be copied to the backup TeraStation. The settings configured on the main TeraStation's Settings page will be copied. Only if the antivirus is activated on the TeraStation.
Using with UPS

Once failover is configured, you cannot set up a UPS for the backup TeraStation. Configure your UPS before configuring failover. UPS recovery can be configured for both the main and backup TeraStations.

Configuring Failover

1. From Settings for the main TeraStation, click Backup.

2. Click to the right of “Failover”.

3. Click Edit Failover Status.
4 Select a TeraStation to be the backup destination device.

5 Enter the administrator password of the backup destination device, then click Continue.

6 If the administrator password is correct, the backup TeraStation will beep. To accept the settings from the main TeraStation, press and hold the function button on the front of the backup TeraStation until it stops beeping.

7 The I51 message will display on the LCD panel and NAS Navigator2 for both TeraStations. Wait until failover is configured after it finishes and the I51 message disappears.

When failover is configured, the RAID array on the backup TeraStation may be reconfigured and resynchronized to the same mode with the main TeraStation as part of the failover configuration process. This is expected behavior and not an error.

8 To avoid a possible IP conflict after failover occurs, configuring a service IP address from the main TeraStation’s Settings is recommended.

Notes:

- When you cancel failover settings, attributes of the shared folders on the backup TeraStation will become read-only. Change the attribute settings to the desired options if necessary.
- If replication is configured for more than one folder, initialize the TeraStation before configuring failover.
- The main TeraStation cannot be used as the backup location for Time Machine.
- Do not use the same TeraStation for both failover and replication, or failover and Time Machine.
- If email notification is enabled and failover occurs, navigate to Management > Email Notification > Edit in the main TeraStation’s Settings and click OK.
- Ethernet frame size settings for main and backup TeraStations should be 1500 bytes. To change the Ethernet frame size, navigate to Network > IP Address, click the LAN port and Edit, and change the Ethernet frame size to “1500” bytes.
- Files whose filenames contain more than 80 alphanumeric characters will not be backed up.
- If the I33 message appears on the LCD panel, navigate to Backup > Failover > Edit Failover Status and click Resync.

Replacing to the Backup TeraStation Manually

If “Switch to backup unit manually” is selected on the Advanced Settings tab in the main TeraStation’s Settings, the backup TeraStation will not replace the main TeraStation if the main TeraStation fails. To have the backup TeraStation replace the main TeraStation, you can either:

- Log in to Settings for the backup TeraStation and click Set as Main Unit.
- Or, press and hold the function button on the backup TeraStation.

Note: If the main TeraStation fails but both LAN ports’ link on the backup TeraStation is up, the backup TeraStation cannot replace to the main TeraStation from Settings. In such a case, use the function button instead.
Reconfiguring After Failover Occurs

When the backup TeraStation replaces the main TeraStation, the I49 message may appear on the backup TeraStation’s LCD panel and NAS Navigator2. To configure failover again, follow the procedure below using the new TeraStation unit. The following procedure is an example using the replaced backup TeraStation (“main TeraStation”) and the new TeraStation (“backup TeraStation”).

If you don’t want to configure failover with the new TeraStation, cancel the failover settings by following the steps 1–5 below and restart both TeraStations. The I49 message will disappear.

**Note:** The following procedure will also work if failover occurs unexpectedly.

1. After failover occurs, log in to Settings for the main TeraStation.
   
   If you have configured to sync with the UPS device connected to the failed TeraStation, the E10 message will appear on the main TeraStation. In such a case, follow the procedure below to change the UPS settings on the main TeraStation. If you hadn’t, skip to the next step.
   
   a. Disconnect the UPS cable from the failed TeraStation and connect it to the main TeraStation.
   b. Click *Management*.
   c. Click to the right of “UPS Sync”.
   d. Click *Edit*.
   e. Select “Sync with UPS connected to this TeraStation” and reconfigure the desired UPS settings.
   f. Click *OK* when finished.

2. Click *Backup*.

3. Click to the right of “Failover”.

Chapter 5 Backup
4 Click *Edit Failover Status*.

5 Click *Force Failover to Stop* to cancel the failover settings.

6 Shut down this main TeraStation.

7 Turn the backup TeraStation on.

8 Log in to Settings for the backup TeraStation, then rename the TeraStation’s hostname and configure the IP address so that it has a new static IP address.

9 Power on the main TeraStation. To configure the UPS sync on the backup TeraStation, configure the settings here. Otherwise, skip to the next step.
   To sync with the UPS device connected to the main TeraStation, follow the procedure below on the backup TeraStation.
   a. Click *Management*.
   b. Click the icon to the right of “UPS Sync”.
   c. Click *Edit*.
   d. Select “Sync with UPS connected to another LinkStation or TeraStation on the same network” and configure the main TeraStation as a sync source.
   e. Click *OK* when finished.

10 Reconfigure failover by referring to the “Configuring Failover” section above.
Backing Up Your Mac with Time Machine

Time Machine is a backup program included with macOS. Configure your TeraStation as shown below to use Time Machine.

1. Preparing a Shared Folder for Time Machine

1. From Settings, click File Sharing.

2. Move the AFP switch to the position to enable AFP.

3. Click to the right of “Folder Setup”.

4. Choose a shared folder as your backup destination for Time Machine.

5. Click Edit.

6. Under “LAN Protocol Support”, select the “AFP (Mac)” checkbox and click OK.

7. Click OK, then click Close.

2. Configuring a Shared Folder as a Backup Destination

1. From Settings, click Backup.

2. Click to the right of “Time Machine”.

3. Click Edit.
4 Click **Browse**.

5 Select the shared folder that you enabled AFP for in the previous steps, then click **OK**.

6 Click **OK**, then click **OK** again.

7 Move the Time Machine switch to the **on** position to enable Time Machine.
3. Configuring Time Machine on macOS

1. From the Finder menu bar, navigate to Go > Connect to Server.

2. Enter “afp://” and then the IP address or hostname of your TeraStation, then click Connect.

3. Enter a username and password with the rights to access the shared folder of the TeraStation, then click Connect.
Chapter 5 Backup

**Note:** If access restrictions are not configured on the destination share, log in with the administrator account. The default username and password for the administrator account are “admin” and “password”. If access restrictions are configured, log in with an account with write privileges.

4 Select the shared folder that has been configured as the backup destination and click OK.

5 From the Apple menu, open *System Preferences*.
6 Click *Time Machine*.
Chapter 5 Backup

7 Click **Select Backup Disk**.

8 Select the shared folder and click **Use Disk**.
9 Click Connect.

10 Enter a username and password to be used for accessing the shared folder and click Connect.

11 Time Machine will count down from 120 seconds, then backup will begin.
Copying from a USB Device

Use Direct Copy to copy from a USB device directly to the TeraStation.

Note: To use Direct Copy, connect only one USB device at a time.

Supported Devices:

- USB mass storage devices
- Card readers (except for card readers that can recognize two or more memory cards)
- Digital cameras and other PTP devices

1. From Settings, click Backup.

2. Move the Direct Copy switch to the position to enable Direct Copy.

3. Connect the USB device. When it mounts (about 10 seconds), the function button will light up.
   
   Note: Unsupported devices will not cause the function LED to light.

4. You now have 60 seconds to press and hold the function button for 3 seconds. If you do, the function button will flash as all the files on the USB device are copied to the Direct Copy folder of the TeraStation.
   
   Notes:
   - While the function button is flashing, press and release it quickly to cancel Direct Copy.
   - For digital cameras that are not in the USB mass storage class, all files in the digital camera are copied.
   - To change the Direct Copy target folder, navigate to Backup > Direct Copy > Edit, select a new folder, and click OK.

5. When the copy operation is finished, the access LED of the USB device will stop flashing. Dismount the USB device from the TeraStation referring to the “Dismounting Drives” section in chapter 4.
WebAccess

WebAccess is a software utility for accessing the files in the shared folder of your TeraStation from your computer or mobile devices through the Internet. Be careful when configuring WebAccess. Certain settings can make the files in the shared folder available to anyone on the Internet, without any access restrictions.

Notes:

- You can also configure WebAccess from Easy Admin.
- WebAccess supports downloading up to 60,000 files at a time. Attempting to download up to 60,000 files at a time may result in unexpected behavior.

1. From Settings, click File Sharing.

2. Click to the right of “WebAccess”.

3. Click Edit.

WebAccess Settings

- HTTPS/SSL Encryption: Disabled
- BuffaloNAS.com Registration: Enabled
- BuffaloNAS.com Name:
- BuffaloNAS.com Key:
- Automatic Router Setup (UPnP): Disabled
- Other DNS Service Hostname:
- NAS Internal Port: 9000
- Exclusive Session: Disabled
- Session Timeout: 30 minutes
- WebAccess URL: -
4 Configure the desired settings, then click OK.

- To use SSL encryption for more secure data transfers, enable “HTTPS/SSL Encryption”.
- You may use the BuffaloNAS.com server as a DNS server, or disable it to use a different DNS server.
- Choose a “BuffaloNAS.com Name” and “BuffaloNAS.com Key” for your WebAccess account. Names and keys may contain between 3 and 20 alphanumeric characters, underscores (_), and hyphens (-).
- If “Exclusive Session” is enabled, multiple users cannot be logged in to WebAccess at the same time. Only the last login will be active.
- Enter a time in minutes (1 to 120, or “Unlimited”) before inactive users are logged out of WebAccess.

5 Move the WebAccess switch to the position to enable WebAccess.

6 Click to the right of “Folder Setup”.

7 Select a shared folder to publish.

Notes:
- For best results, create a new dedicated share for WebAccess.
- When accessing shared folders through WebAccess from a remote location, a username and password may be required for certain operations. For best results, create a user account with permissions on the WebAccess share before using WebAccess.

8 Click Edit.

10 Select the desired WebAccess security level for “WebAccess Public Mode”.

- **Allow Anonymous**: Anyone can access (view) shared folders. (Access restrictions configured for shared folders will not work.)
- **Allow All Groups and Users**: All groups and users registered on the Buffalo NAS device can use WebAccess. (Access restrictions configured for shared folders will not work.)
- **Use Inherited Folder Permissions**: Users and groups have the same access permissions with WebAccess that they do locally. If access restrictions are not set for the shared folder, then this option will not be shown.

Whether a user or group can access a folder through WebAccess depends on a combination of WebAccess settings and the shared folder’s settings.

<table>
<thead>
<tr>
<th>WebAccess Public Mode</th>
<th>Not logged in</th>
<th>Access restrictions for the logged-in users</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>No access</td>
</tr>
<tr>
<td>Allow Anonymous</td>
<td>R</td>
<td>R/W</td>
</tr>
<tr>
<td>Allow All Groups and Users</td>
<td>-</td>
<td>R/W</td>
</tr>
<tr>
<td>Use Inherited Folder Permissions</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

R: Read-only, R/W: Read and write, -: No access

11 Click **OK**.

There are many ways to access WebAccess folders depending on your device.


### WebAccess Remote

WebAccess Remote lets you open a shared folder on a remote Buffalo NAS device from File Explorer or another file manager program.

To use WebAccess Remote, the following conditions must be satisfied:

- You have Buffalo NAS devices in two different locations, such as at home and at a remote location.
- WebAccess should be enabled on the remote NAS device.
- WebAccess Remote should be enabled on this TeraStation.

**Note**: Set the TeraStation’s time settings to the correct time. Using NTP is recommended. To configure NTP settings on the TeraStation, refer to the “Name, Date, Time, and Language” section in chapter 10.

1 From Settings, click **Web Services**.
2 Click to the right of “WebAccess Remote”.

3 Click Edit.

4 Click Browse next to the “Target Folder” field and select the shared folder that will be connected.

5 You may choose to enter a BuffaloNAS.com name or an external DNS/IP address. If using a BuffaloNAS.com name, it should be the same BuffaloNAS.com name assigned to the remote NAS device. If using an external DNS/IP address, enter either the IP address of your DNS server or the global IP address of the remote NAS device’s WebAccess.

6 Enter the remote NAS device’s admin username and password.

7 Click OK.

8 Move the WebAccess Remote switch to the position to enable WebAccess Remote.

9 You can directly access the shared folder in the remote NAS device by entering the path displayed at the “Target Folder” field into the address bar in File Explorer or another file manager program.

Notes:
- If using WebAccess Remote to access files that are available to the public, these files will be copied to the accessed Buffalo NAS devices as caches when accessing them.
- If using after the network has been temporarily disconnected, click Remount.
• If no files and folders are displayed in the target folder, disable WebAccess Remote and Amazon S3, reboot the TeraStation, and turn on both services again.
• If using both Amazon S3 and WebAccess Remote, configure the same shared folder for both. Don’t use different folders for these services.

FTP

By default, the TeraStation’s shares are only accessible by users connected to the same network or router as the TeraStation. The optional FTP server allows users outside the local network to access the TeraStation.

Note: FTP is intended for users who already have FTP client software and have experience with it.

1. From Settings, click File Sharing.

2. Move the FTP switch to the position to enable FTP.

3. Click to the right of “Folder Setup”.

4. Choose a folder to enable remote FTP access on.

5. Click Edit.

6. Select read-only or read and write for the shared folder’s attribute; under “LAN Protocol Support”, select the “FTP” checkbox and click OK.

Accessing the TeraStation with an FTP Client
To access the TeraStation via FTP, configure your FTP client software with the following settings:
• Hostname: IP address of the TeraStation
• Username: The TeraStation’s username
• Password: The TeraStation’s password
• Port: 21

Accessing the TeraStation with an Anonymous User
To allow anonymous access to your FTP share, disable access restrictions. Configure your FTP client software with the following settings for anonymous FTP access:
• Hostname: IP address of the TeraStation
• Username: Anonymous
• Password: Any character string
• Port: 21

Notes:
• If the TeraStation joins a domain, anonymous users cannot access it.
• Shared folders connected by FTP are available from the “/mnt” folder. The examples of default locations are:
  /mnt/array1/share
  /mnt/disk1/share
  /mnt/usbdisk1

• If a file was created or copied using AFP, you may be unable to delete it using an FTP connection. If this occurs, use an SMB or AFP connection instead to delete the file.

• For FTP connections, make sure that the total filename including the folder path is 250 single-byte characters or less.

Amazon S3

Amazon S3 (Amazon Simple Storage Service) is a fee-based online storage service provided by Amazon. Follow the procedure below to configure your TeraStation for use with Amazon S3.

1 Create an account at the Amazon S3 website: http://aws.amazon.com/s3

2 From Settings, click Web Services.

3 Click to the right of “Amazon S3”.

4 Click Browse.
5 Select the shared folder for remote replication, then click OK.

6 Select the connection type and the connection protocol; select the region name that you have selected when creating the bucket from the drop-down list.

7 Enter the bucket name, access key ID, and secret access key, then click OK.

8 Move the Amazon S3 switch to the position to enable Amazon S3.

Notes:
- This folder is used by Amazon S3. Files are not added to the selected folder and the amount of used space does not increase.
- If using both Amazon S3 and WebAccess Remote, configure the same shared folder for both. Don't use different folders for these two services.
- Enter the path from the “Target Folder” field in a browser window to access the files saved to Amazon S3.
- If no files and folders are displayed in the target folder, disable WebAccess Remote and Amazon S3, reboot the TeraStation, and turn on both services again.
- To use after the network was temporarily disconnected, click Remount.
- If a file is added to the Amazon S3 bucket directly, the file will not copy to the remote target folder.
Chapter 7 BitTorrent

BitTorrent is a protocol for distributing large amounts of data efficiently. The information in this chapter is for users who are familiar with BitTorrent.

1. From Settings, click Applications.

2. Click to the right of “BitTorrent”.

3. Click Edit.

4. Click Browse.
5 Select the shared folder where the downloaded file will be saved, then click OK.

6 Click OK.

7 Move the BitTorrent switch to the position to enable BitTorrent.

8 Click to the right of “BitTorrent”.
9 Click *Open Download Manager*. The default username is “admin” and the default password is blank (no password).

The download manager will open.

10 The download manager will open.
DLNA

DLNA is a set of guidelines for sharing digital media. The TeraStation includes a DLNA server compliant with the DLNA guidelines. The movies, photos, and music saved on this product can be played back on DLNA-compliant TVs, stereo equipment, game consoles, and other devices within the network.

1 From Settings, click File Sharing.

2 Click to the right of “Folder Setup”.

3 Select the folder that you want to share with media players and other DLNA-compatible devices.

4 Click Edit.

5 Under “LAN Protocol Support”, select the “DLNA” checkbox and click OK.

6 Click Services.

7 Move the DLNA switch to the position to enable DLNA.
8 Click to the right of “DLNA Server”.

9 Click Edit.

10 Select an interval for DLNA server database updates and click OK.

11 Click OK.

Playing Files
To play back content from a DLNA-compatible device:

1 Connect the DLNA-compatible device to the same network as the TeraStation and turn it on.

2 Select the TeraStation in the software of the DLNA-compatible device.

3 Select the content to be played back.

Note: For more information on playing files, see the DLNA-compatible devices’ manuals.

Connected DLNA-compatible Devices
Follow the procedure below to view the DLNA-compatible devices connected to your TeraStation.
1 From Settings, click Services.

2 Click to the right of “DLNA Server”.

3 Click DLNA Client Access Permissions.

4 A list of the MAC addresses, IP addresses, and device names of the DLNA-compatible devices connected to the same network as the TeraStation is displayed. If your device is not listed, click Refresh Database.

Streaming to DLNA-compatible Devices

When new movies, photos, and music files are added to the TeraStation's DLNA folder, the database must be updated before the new file can be streamed. By default, the database is updated at startup and again every 60 minutes. You can change this interval or update the database manually.
1. From Settings, click Services.

2. Click to the right of “DLNA Server”, then click Edit.

3. You may change the update interval, or select Refresh Database to update the database immediately.

Disabling Playback from Specific Devices
You may block specific DLNA devices from playing back media content.

1. From Settings, click Services.

2. Click to the right of “DLNA Server”.

3. Click DLNA Client Access Permissions.
4 Uncheck the devices you do not want to allow to play media and click OK.

Supported File Types

The TeraStation supports DLNA streaming of files with the extensions below.

<table>
<thead>
<tr>
<th>Types</th>
<th>File Extensions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video files</td>
<td>.avi, .divx, .asf, .mpg, .mpeg, .m1v, .vob, .mts, .m2t, .mpeg2, .vdr, .spts, .tp, .ts, .3gp, .mov, .m4v, .wmv, .dvr-ms, .xvid, .mp4, .m4v</td>
</tr>
<tr>
<td>Picture files</td>
<td>.jpg, .jpeg, .gif, .png, .tiff, .tif, .yuv, .bmp</td>
</tr>
<tr>
<td>Music files</td>
<td>.mp3, .mpa, .wma, .aac, .apl, .ac3, .pcm, .pcm, .wav, .m3u, .m4a, .mp4, .3gp, .m4b, .aif, .aiff, .flac, .ogg, .mp2, .mp1, .mp4</td>
</tr>
</tbody>
</table>

iTunes Server

If iTunes server is enabled, computers on your network with iTunes can play music files stored on the TeraStation and transfer them to iPod, iPhone, and iPad devices. iTunes server supports playback from up to five computers.

1 From Settings, click Services.

2 Click to the right of "iTunes Server".
3 Click **Edit**.

![iTunes Server Settings](image1)

4 Click **Browse**.

![iTunes Server Settings](image2)
5 Select the shared folder that you want to make available to iTunes, then click OK.

6 Click OK, then OK again.

7 Move the iTunes server switch to the position to enable iTunes server.
Chapter 9 Surveillance Server

The TeraStation supports streaming video from RTSP (Real Time Streaming Protocol) network cameras.

Getting Started

The following items are required:

- TeraStation with surveillance camera support
- Supported network camera
- Ethernet cable
- Ethernet hub
- Computer

  Supported operating systems: Windows 8.1 (64-bit or 32-bit)*, 8 (64-bit or 32-bit)*, 7 (64-bit or 32-bit), Vista (64-bit or 32-bit), XP SP3, Windows Server 2008 SP2 (64-bit or 32-bit), 2003 SP2, OS X 10.5.8 or later
  
  CPU: Intel dual-core 2.20 GHz or faster
  
  Drive: 10 GB or more of available space
  
  RAM: 2 GB or more

Computer requirements for Live Viewer are below:

  Supported operating systems: Windows 8.1 (64-bit or 32-bit)*, 8 (64-bit or 32-bit)*, 7 (64-bit or 32-bit), Vista (64-bit or 32-bit), XP SP3
  
  CPU: Quad-core 2.33 GHz or faster
  
  Drive: 10 GB or more of available space
  
  RAM: 2 GB or more

*Log in to Windows with a local admin account, not a Microsoft account. If you log in with a Microsoft account, you will not be able to access the surveillance server on the TeraStation.

Installing Client Tools

Download “Buffalo Surveillance Camera Client Tools Setup” from the Buffalo website and install the following client tools using the install wizard on your computer.

Camera Policies: Registers that a network camera is connected and ready to record.
**Live Viewer**: Lets you view video as it is being recorded. With some network cameras, pan, tilt, zoom, focus, and other remote operations may be unavailable.

**Data Service Policies**: Used to move, back up, and delete recorded video data.

**Vault Admin**: Used to perform license registration, self-diagnosis, check the remaining disk space, and other operations.

**Surveillance Video Manager**: Used to view recorded video data, perform searches, export, and other operations.

**Network Activity**: Displays the operating status of the TeraStation.

**Notes**:
- Install after logging into your computer using an account with administrator rights.
- Install another media player to play recorded videos if the version of “Buffalo Surveillance Camera Client Tools Setup” is 5.7.3.2 or later.
- Install VideoLAN VLC media player 1.11–1.13, or Apple QuickTime 7 or later if the version of “Buffalo Surveillance Camera Client Tools Setup” is older than 5.6.19.3. VLC media player 2.0.x may not work with some network cameras. Using VLC media player is recommended if your network camera records in MPEG-4 format.
- If VLC media player is installed, use the default installation location (C:\Program Files (x86)\VideoLAN\VLC in Windows 7 64-bit or the Application folder in macOS).
- If surveillance cameras or client tools installed under C:\Program Files (x86)\BUFFALO\SurveillanceServer\Bin are blocked due to the OS firewall, refer to the OS help for procedure about how to disable the firewall.
- Install client tools on one or more computers connected to the same network as the network camera(s) and the TeraStation. Surveillance camera settings are shared for all computers on the network.

**Connecting Devices to the Network**

Connect the following devices to the network.
- A TeraStation that supports surveillance cameras
- A compatible network camera
- A computer with the above client tools installed

**Notes**:
- Connect all devices on the same network subnet.
- Set the TeraStation's and network camera's time settings to the correct time. To select a different NTP server on the TeraStation, refer to “Name, Date, Time, and Language” section in chapter 10.
  - In certain cases, the DNS server address must be set in order to access the NTP server.
- Use the dedicated utility provided with the network camera or another program to confirm that the network camera is operating properly.

**Enabling Surveillance Cameras**

Enable surveillance cameras in Settings.

**Note**: First, complete the initial settings for the TeraStation and the network camera. For details on the procedure, see the manual supplied with the device.

1. From Settings, click **Applications**.

2. Click to the right of “Surveillance Cameras”.

3. Click **Edit**.
4 From "LAN Port", select the LAN port connected to the same network as the network camera and computer where the client tools are installed.

5 Click **Browse**.

6 Choose a folder for recorded video, then click **OK**.

   A folder that contains multibyte characters in its name cannot be used.

   **Note:** Use a folder with at least 100 GB of available space.

7 Click **OK**.

8 Click **OK**.

9 Move the surveillance camera switch to the **on** position to enable the surveillance camera.
Notes:

- If the target shared folder specified as the storage location for recorded video is deleted, the surveillance camera is automatically disabled.
- Do not directly edit recorded video data in the shared storage folder. If a file is directly edited, the surveillance camera may no longer operate properly.
- Do not duplicate or back up the recorded videos with the backup or replication functions in the TeraStation's Settings. A separate backup license must be purchased to back up this data to another TeraStation.
- The client tools can only be used with the LAN connected to the selected LAN port.
- Failover and surveillance cameras are not compatible. Therefore surveillance cameras cannot be used if failover is configured. Conversely, failover cannot be used if surveillance camera functionality is enabled.

Use with Two or More Network Cameras

In the default settings, only one network camera can be used. To use two or more network cameras, additional licenses (sold separately) must be purchased and registered. For more details to add licenses and registration, refer to the “Activating Additional Licenses” section.

Enabling the Free License

Your TeraStation comes with a license for one surveillance camera. Follow the procedure below to enable the included license.

Note: If port trunking is enabled, the free license cannot be activated. To activate the license, disable port trunking, then follow the procedure below.

1 Connect the TeraStation to the Internet.

2 Click Start > BUFFALO > BUFFALO Surveillance Server > Vault Admin.
   For Windows 8.1 and Windows 8, click Vault Admin in the Start menu.

3 Select the TeraStation where you want to add the license, right-click it, and click Properties.

Note: If your computer joins a Public network, the TeraStations may not be detected. In such case, let the computer joins a Home or Work network.
4 Open the License tab, then click Activate Free License.

To deactivate the license, click 🗑️.
Make sure that “SurveillanceCamera” and “HardDisk” were added to “Installed Licenses”.

The free license is now enabled.

**Registering Recording Policies**

Register the network camera that is used.

1. Click Start > BUFFALO > BUFFALO Surveillance Server > Camera Policies.
   For Windows 8.1 and Windows 8, click Camera Policies in the Start menu.

2. Click the icon.
Chapter 9 Surveillance Server

3 Click Next.

Welcome to the Add Camera Wizard

This wizard helps you add and schedule a new camera.
You may need to run this wizard with administrative rights.

To continue, click Next.

4 Click Find Cameras.

Camera Information

Find cameras on my network to populate the information below.

Find Cameras

Select the manufacturer and model.

- Select Manufacturer -  - Select Model -

What is the IP Address?

What credentials are needed to access this camera?

User Name:
Password:

Test Camera

< Back  Next >  Cancel
5 Select the detected network camera, then click OK.

Note: Network cameras that are already in use are indicated by an asterisk (*) and are grayed out.

6 Enter the username and password if they are configured, then click Next.

Note: Clicking Test Camera runs an operational check on the network camera.

7 Enter the description, then click Next.

Description

What is the name of this camera? (For example, 'Front Lobby')

Enter a brief description of this camera.
8 Select the recording schedule, then click Next.

Recording Schedule

When do you want to record video?

- Always
- At selected times

9 Select the TeraStation where the video will be recorded, then click Next.

Recording Computer

What computer will be used for recording video?

- Select Computer -
10 Check the registration information; if it is correct, click Next.

11 Click Next.

An additional network camera can be registered by selecting "Yes" when asked "Do you want to add an additional camera?".
12. Click *Finish*.

![Camera Information](image)

13. Click *Save*.

![Save Wizard Add](image)

Policy Name Camera Host

The recording will begin. You’ve now registered the recording policy of the network camera.

**Checking Recording**

To check that recording is working correctly, follow the procedure below. Wait at least 15 minutes after registering the recording policy before checking the recording.

1. Click *Start > BUFFALO > BUFFALO Surveillance Server > Surveillance Video Manager*.
   For Windows 8.1 and Windows 8, click *Surveillance Video Manager* in the Start menu.

2. Click *Search*.

![Search](image)

3. Recorded video clips are shown in the center of the screen. Click a video clip to start playback.
This completes checking recording.

### Viewing Saved Video

Follow the procedure below to view recorded data saved in the TeraStation.

1. Click Start > BUFFALO > BUFFALO Surveillance Server > Surveillance Video Manager.
   For Windows 8.1 and Windows 8, click Surveillance Video Manager in the Start menu.

2. Click Search.

3. Video clips are shown in the search results at the center of the screen. Click the clip to start playback.

### Advanced Usage

#### Export Recorded Data as an MOV Video File

To export recorded data saved to the TeraStation as an MOV format video file:

1. Click Start > BUFFALO > BUFFALO Surveillance Server > Surveillance Video Manager.
   For Windows 8.1 and Windows 8, click Surveillance Video Manager in the Start menu.
Select the search criteria on the left side of the search screen, then click **Search**.
The search results are displayed. Click a thumbnail to start the media viewer.
4 Select the section to export and click Export. This will register the video to the export queue.

![Export Queue Image]

5 Open the Export screen, register the export information from “Export Job Configuration”, and click “Start Export”. The video is exported in MOV format.

![Export Job Configuration and Export Status Images]

This completes exporting video in the MOV format.

**Viewing Video Real-time**

Follow this procedure to view the video as it is being recorded by the network camera.

**Note:** Live Viewer data cannot be viewed.

1 Click Start > BUFFALO > BUFFALO Surveillance Server > Live Viewer.

   For Windows 8.1 and Windows 8, click Live Viewer in the Start menu.
Registered network cameras are listed in the “Cameras” folder on the right side of the screen. To view a video that is currently being recorded, double-click the camera whose video you want to view or drag to a frame of the camera viewer on the left side of the screen.

This completes viewing current video.

Moving Recorded Video Data to Another TeraStation

Follow the procedure below to move (migrate) the recorded video data to another TeraStation.

Note: A separate surveillance server license pack must be purchased to do this.

1. Click Start > BUFFALO > BUFFALO Surveillance Server > Data Service Policies.
   For Windows 8.1 and Windows 8, click Data Service Policies in the Start menu.
2 Click and when the Create a Policy screen is opened, enter “MigrateTest” into the “Policy Name” field, select “Migrate”, and click OK.

3 Click the Source tab. Under “Vault”, select the TeraStation where the recorded video data is saved. Select “Any” to migrate recorded data on all network-connected TeraStations.

4 Click the Destination tab to select which TeraStation you want to move the data from “Vault” off of.

5 Set the migration date and time on the Scheduling tab. To execute migration every hour, select “Repeatedly at a defined interval” and “Every 1 hour”.

6 Click and register the policy.

This completes the settings for moving recorded video to another TeraStation.

**Backing Up Recorded Video to Another TeraStation**

Follow this procedure to back up recorded video data to another TeraStation.

**Note:** A separate surveillance camera license pack must be purchased to do this.

1 Click Start > BUFFALO > BUFFALO Surveillance Server > Data Service Policies.
   For Windows 8.1 and Windows 8, click Data Service Policies in the Start menu.
2 Click  and when the Create a Policy screen opens, enter “DuplicateTest” into the “Policy Name” field, select “Duplicate”, and click OK.

3 Click the Source tab and select the TeraStation where the recorded video data is saved under “Vault”.

   ![Source Tab]

   **Note:** If “any” is selected, recorded data for all TeraStations connected to the network will be backed up. Click the Destination tab, then select the TeraStation where you want to move the data from “Vault”.

4 Set the job execution date and time from the Scheduling tab. In this example, to execute the backup job every hour, select “Repeatedly at a defined interval” and “Every 1 hour”.

5 Click  and register the policy.

This completes the settings for backing up video to another TeraStation.

**Automatically Delete Old Data When Space Is Low**

Follow the procedure below to delete (purge) recorded video starting from the oldest when available space for recording video becomes low.

**Note:** By default, old video data will be deleted automatically when 80% of available space is used. Old data will be removed at the same rate as new video is added, so there will always be enough video to fill about 80% of the total available space. To disable this setting, remove the “Remove Old Video” policy from “Data Service Policies”.

1 Click Start > BUFFALO > BUFFALO Surveillance Server > Data Service Policies.

   For Windows 8.1 and Windows 8, click Data Service Policies in the Start menu.
2 Click and when the Create a Policy screen is opened, enter “PurgeTest” into the “Policy Name” field, select “Purge”, and click OK.

3 Click the Source tab and select the TeraStation on which recorded video is saved under “Vault”.

4 Open the Criteria tab; under “Miscellaneous Options”, set “Watermark: High” and “Watermark: Low” options. This determines the used space threshold.

   For example, if you set Watermark: High to “80” and Watermark: Low to “40”, old data will be deleted when the amount of used space exceeds 80% until it drops to 40%.

5 Set the job execution date and time from the Scheduling tab. In this example, we’ll configure a job to execute at 2:00 a.m. on weekdays.
   • Select “On selected days each week”.

   When should the job run?
   On selected days each week.
Chapter 9 Surveillance Server

- Select every day between Monday and Friday.

![Days selection](image)

- Select “2:00” and “AM”, then click OK.

![Time selection](image)

6 Click and register the policy.

This completes the registration of the policy. The job is executed at 2:00 a.m. Monday to Friday.

**Changing Where Recorded Video Is Saved**

Follow this procedure to change the TeraStation to which video is saved.

1. Click Start > BUFFALO > BUFFALO Surveillance Server > Camera Policies.
   
   For Windows 8.1 and Windows 8, click Camera Policies in the Start menu.

2. Click the icon on the toolbar and open the “Camera Configurations” screen.
3 Double-click the camera for which video will be saved. This opens “Modify Camera”.

4 Change the TeraStation you want to use as the “Recording Computer” and click OK.

5 Click and register the policy.

This completes changing the TeraStation where recorded video is saved.

**Email Notifications**

You may configure the TeraStation to send you an email notification when the available space for recording is low, or if recording fails due to a camera malfunction, network disconnection, or other cause.
Client Tools

Camera Policies

Camera Policies is utility software that registers the network cameras and starts video recording.

Click to start a wizard to register network cameras and schedule recording.

Click to open the camera configuration screen where network cameras are registered.

Click to start a new registration screen for an additional network camera. You can also register the camera and define the recording video policy.
Live Viewer

Live Viewer allows you to view video currently being recorded by a network camera.

Note: To view the current video, the network camera must be registered in Camera Policies.

- The layout of the camera view (numbers of rows and columns) and registered network cameras are displayed in the panel on the right side of the screen.
- The camera view (live video) is displayed on the left side panel. In the default setting, a 2x2 camera view is displayed. A layout view with up to 4x4 cameras can be displayed.
- Double-clicking the network camera name or dragging to the camera view frame enables viewing of the current video that is being recorded by the network camera.

The layout can be saved in View > Save Layout As.

Data Service Policies

Data Service Policies is utility software for creating data service policies. The policy types that can be created are shown below.

Note: To use migration and duplication, a separate backup license must be purchased.

<table>
<thead>
<tr>
<th>Policy Type</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Migration</td>
<td>Moves recorded video data to another TeraStation.</td>
</tr>
<tr>
<td>Duplication</td>
<td>Copies recorded video data to another TeraStation and synchronizes the data.</td>
</tr>
<tr>
<td>Purge</td>
<td>Deletes the recorded video data.</td>
</tr>
</tbody>
</table>
The right side of the screen includes tools for creating and updating data service policies. The left side of the screen shows an overview of all data service policies.

Notes:
- If ⚠️ is displayed for a policy in the left-side frame, the policy is disabled.
- Surveillance server functionality must be enabled beforehand for the TeraStation where migration or duplication files will be saved.

Vault Admin

Vault Admin is utility software for managing surveillance camera resources.

Operations are performed from the toolbar located in the top section of the screen.

The icons and their functions are shown below.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📚</td>
<td>Starts “Mini Vault Stats” for enabling the display of basic monitoring information.</td>
</tr>
<tr>
<td>🔒</td>
<td>Sets the security status.</td>
</tr>
<tr>
<td>🚫</td>
<td>Shuts down or restarts a portion (Vault) of the surveillance cameras.</td>
</tr>
<tr>
<td>⌜</td>
<td>Changes the properties.</td>
</tr>
<tr>
<td>📕</td>
<td>Performs a diagnosis of the surveillance camera.</td>
</tr>
<tr>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td><img src="loads_media.png" alt="Icon" /></td>
<td>Loads a media device.</td>
</tr>
<tr>
<td><img src="prepares_media.png" alt="Icon" /></td>
<td>Prepares a media device.</td>
</tr>
<tr>
<td><img src="unloads_media.png" alt="Icon" /></td>
<td>Unloads a media device.</td>
</tr>
<tr>
<td><img src="erases_media.png" alt="Icon" /></td>
<td>Erases a media device.</td>
</tr>
<tr>
<td><img src="refresh_screen.png" alt="Icon" /></td>
<td>Refreshes the current screen.</td>
</tr>
</tbody>
</table>

**Surveillance Video Manager**

Surveillance Video Manager is utility software for performing searches and exporting recorded video data.

**Search Window**

![Search Window](image.png)
Export Window

Network Activity

Network Activity is utility software that displays the TeraStations on which surveillance cameras are operating on the network in real time and in graphical form.

All clients and TeraStations located on the network are indicated by symbols and labels. These can be moved by dragging and dropping them. Clients are displayed only when a job is being executed and activities are indicated by a line linking the client and TeraStation.
Mini Vault Stats

Double-clicking the icon for a TeraStation on “Network Activity” starts “Mini Vault Stats.” “Mini Vault Stats” shows the network traffic in graphical form.

Activating Additional Licenses

Purchasing an additional license (sold separately) enables you to connect and use two or more cameras and use the migration and duplication functions. Use this procedure to activate an additional license.

When the TeraStation Is Connected to the Internet

1. Click Start > BUFFALO > BUFFALO Surveillance Server > Vault Admin.
   For Windows 8.1 and Windows 8, click Vault Admin in the Start menu.

2. Select the TeraStation to which you want to add the license, right-click it, and click Properties.
3 Open the License tab, then click +.

If your default free license activation is not installed, refer to the "Enabling the Free License" section to install it.

4 Enter the product key for the license pack (sold separately), then click OK.
5 Confirm that the new license was added to “Installed License”.

You have now activated the additional license.

**TeraStation Not Connected to the Internet**

1. If the TeraStation is being used in an environment where Internet access is not available, a separate computer with access to the Internet is required to activate the additional license.

2. Click Start > BUFFALO > BUFFALO Surveillance Server > Vault Admin. For Windows 8.1 and Windows 8, click Vault Admin in the Start menu.
3 Select the TeraStation to which you want to add the license, right-click it, and click Properties.

![Properties window]

4 Open the License tab, then make a note of the “Host Id”.

![License tab]

5 Open the website in web browser: [http://buffalo.jp/support_s/camera_licence/](http://buffalo.jp/support_s/camera_licence/).
6 From the license pack (sold separately), enter the product key and host ID code and click “Activate Software License”.

7 Downloading of the license file (*.lic) begins. Save the license file to a USB memory drive or another storage device.

8 Copy the license file to a computer connected to the same network as the TeraStation.

9 In the computer connected to the same network as the TeraStation, click Start > BUFFALO > BUFFALO Surveillance Server > Vault Admin.
   For Windows 8.1 and Windows 8, click Vault Admin in the Start menu.

10 Select the TeraStation where you want to add the license, right-click it, and click Properties.
11 Open the License tab, then click +.

12 Select “Import license file”, then click Browse.

13 Select the license file that was saved before, then click OK.
14 Check that the license pack was added to “Installed Licenses”.

This completes authentication of an additional license.
# Troubleshooting

<table>
<thead>
<tr>
<th>Issue</th>
<th>Possible Cause</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video recording does not start.</td>
<td>Surveillance camera setting not enabled.</td>
<td>Enable surveillance camera in Settings.</td>
</tr>
<tr>
<td></td>
<td>A LAN cable between the TeraStation and network camera is disconnected, or the power is turned off.</td>
<td>Check that the LAN cables are inserted correctly.</td>
</tr>
<tr>
<td></td>
<td>The video recording policy is not registered.</td>
<td>Register the video recording policy from Camera Policies.</td>
</tr>
<tr>
<td></td>
<td>The device is not connected to a network on the same LAN, or the device is not connected to the LAN port that was set in Settings.</td>
<td>Connect the device to the network of the LAN port that was set in Settings.</td>
</tr>
<tr>
<td></td>
<td>The disk is full.</td>
<td>Free available space on the disk by moving or deleting files.</td>
</tr>
<tr>
<td></td>
<td>The time for the TeraStation and network camera is not correct.</td>
<td>Set the time in Settings.</td>
</tr>
<tr>
<td></td>
<td>There are not enough camera licenses for the network cameras.</td>
<td>Purchase and register an additional license.</td>
</tr>
<tr>
<td>I cannot enable the surveillance camera.</td>
<td>Failover is running.</td>
<td>Disable failover.</td>
</tr>
<tr>
<td>Surveillance cameras no longer record video.</td>
<td>Surveillance camera functionality is not enabled.</td>
<td>Enable surveillance camera functionality in Settings.</td>
</tr>
<tr>
<td>I cannot view the network camera using Live Viewer.</td>
<td>The network camera is not registered in some camera policies.</td>
<td>Register the network camera from camera policies.</td>
</tr>
<tr>
<td></td>
<td>There is an error in the network camera settings.</td>
<td>Verify the settings in the camera policies.</td>
</tr>
<tr>
<td>There is no recorded data, or the recorded data cannot be found.</td>
<td>A camera was added in camera policies while Surveillance Video Manager was running.</td>
<td>If this is the case, this video may not be accessible. Restart Surveillance Video Manager to enable searching for recorded video from the new camera.</td>
</tr>
</tbody>
</table>

**Notes:**
- QuickTime is a trademark of Apple Inc., registered in the U.S. and other countries.
- VLC media player is a trademark of Video LAN org.
- See the Buffalo website for supported cameras.
- Refer to the “Buffalo Surveillance Server Administrator’s Guide” available from the Buffalo website for information about client tools.
- The TeraStation supports up to five network cameras but includes only a single camera license. To use more than one camera, additional licenses must be purchased and registered.
Chapter 10 Advanced Features

Antivirus Software

Trend Micro NAS Security can protect your network and data from software viruses, malware, and spyware. To use the Trend Micro NAS Security software, you will need to purchase an OP-TSVC license pack (sold separately). If your TeraStation is already running an activated antivirus software, no license registration is necessary.

Notes:

- To use the antivirus software effectively, the TeraStation should be connected to the Internet. The connection can be routed through a proxy server if the appropriate settings are configured in Administration > Proxy Settings from the left-side menu of the Trend Micro NAS Security settings page.
- Trend Micro is a trademark of Trend Micro Incorporated.

Collecting Personal Data

The antivirus software will collect information regarding device usage and virus detection and send feedback to Trend Micro incorporated. For more detailed information, follow the procedure below to display the “Privacy and Personal Data Collection Disclosure” document and read it carefully. If you continue using the antivirus software, it will be considered that you have agreed to the disclosure.

1. Enter the following link into the address bar of the browser: http://d.buffalo.jp/TS3000/.

2. Select the region where you bought the TeraStation and the model to go to your specific model’s d.buffalo website.

3. Click Privacy and Personal Data Collection Disclosure and download the PDF file.

Activating Virus Scanning

Follow the procedure below to activate virus scanning.

1. From Settings, click Applications.

2. Click to the right of “Antivirus”.

166
3 Click Edit.

4 Click Browse.

5 Select the desired quarantine folder and click OK.
6 Click OK again.

7 Move the antivirus switch to the position to enable antivirus.

Configuring Security Settings

Use the Trend Micro NAS Security settings page to configure security settings such as updating pattern files, configuring scan schedules, and activating or expanding the license. To open the settings page, follow the procedure below.

1 From Settings, click Applications.

2 Click to the right of “Antivirus”.

3 Click Options.
4. Enter your username and password, then click Log On.

You can log on using the TeraStation's admin account. The default username and password are “admin” and “password”.

5. The Trend Micro NAS Security settings page will open.

Notes:
- The Trend Micro NAS Security settings page is compatible with IE 6.0 SP2 or later (Windows) and Firefox 1.5 or later (Windows or Mac).
- To change the display language of the Trend Micro NAS Security settings page, change the system language to the desired settings by referring to the “Name, Date, Time, and Language” section below.

Licenses
If the antivirus software on your TeraStation is not activated or has expired, please purchase an OP-TSVC license pack (sold separately). If your TeraStation includes activated antivirus software, no license registration is required. The total period for antivirus software updates to be available may be extended up to 5 years. The example below shows an initial 1-year period for updates extended by an additional year.
1/1/2016 1/1/2017 1/1/2018 1/1/2021

Antivirus software updates activated

Extension (9/1/2016)

License period before extension

License period after extension

Up to 5 years (Cannot be extended beyond 5 years)

Note: It’s not possible to register a serial number that would extend the total license period beyond 5 years, such as a second 3-year license after 3 years.

1. From the left-side menu of the Trend Micro NAS Security settings page, click Administration > Product License.

2. Enter the serial number from the “Trend Micro NAS Security License Pack Guide”, included in your package. Click Activate.

Product License

The product has not been activated.

Product Activation

You must activate your product to enable scanning and security updates.

Serial number: ______ - ______ - ______ - ______ - ______
(CODE FORMAT: XXXX-XXXX-XXXX-XXXX-XXXX)

Activate  Cancel

The new license is now registered.
To check the status of the current license, open the Trend Micro NAS Security settings page and navigate to Administration > Product License on the left-side menu.

Connecting Through a Proxy Server

If you must pass through a proxy server to connect to the Internet in your network environment, follow this procedure to set the IP address of the proxy server and other settings.
From the left-side menu of the Trend Micro NAS Security settings page, click Administration > Proxy Settings.

Select the “Use a proxy server to access the Internet (License update)” checkbox. Enter the IP address and port of the proxy server, then click Save.

The antivirus software is now configured to use a proxy server.

**Updating Antivirus Pattern Files**

For best results, configure your antivirus software to update the antivirus pattern files automatically as described below.

From the left-side menu of the Trend Micro NAS Security settings page, choose Scheduled Updates.
2 Check “Enable Scheduled Update”.

**Scheduled Update**

- **Enable Scheduled Update**

**Update Frequency**

- **Start time:** 00 : 00 (hh:mm)
- **Repeat interval:** Hourly
- **Daily, update for 2 hours**

3 Select a time for updates to begin, an interval for updates, and an amount of time for updates to continue. Select the components to update. Click **Save**.

**Scheduled Update**

- **Enable Scheduled Update**

**Update Frequency**

- **Start time:** 00 : 00 (hh:mm)
- **Repeat interval:** Hourly
- **Daily, update for 2 hours**
- **Weekly, every Monday update for:** 4 hours

**Components to Update**

<table>
<thead>
<tr>
<th>Component</th>
<th>Current Version</th>
<th>Last Updated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virus Pattern</td>
<td>12.827.00</td>
<td>2016-11-01 09:00:00</td>
</tr>
<tr>
<td>Spyware/Grayware Pattern</td>
<td>1.773.00</td>
<td>2016-11-01 09:00:00</td>
</tr>
<tr>
<td>Scan Engine</td>
<td>9.900.1010</td>
<td>2016-11-01 09:00:00</td>
</tr>
</tbody>
</table>

The antivirus software is now configured to update automatically at the scheduled time. Updates will not be downloaded if the TeraStation is turned off, in standby mode, or disconnected from the Internet.

### Configuring Folders as Virus Scanning Targets

By default, all folders on the TeraStation (including attached USB drives) will be scanned. Follow the procedure below to block specific shared folders from being scanned.

1. From Settings, click **File Sharing**.

2. Click **Folder Setup** to the right of “Folder Setup”.

---

172
3 Click the shared folder that you want to exclude from the scan, then click Edit.

4 If the options' checkboxes are selected, it means the shared folder will be scanned by those scan options. To exclude from the scan, clear the options' checkboxes.

5 Click OK.

Configuring Virus Scanning

Three types of virus scans are available:

- **Real-time scan**
  The virus scan runs in the background, scanning every file that you read or write. This is the default type of scanning. Your TeraStation may run slower if real-time scanning is enabled.

- **Scheduled scan**
  A scheduled scan is executed at specific regular intervals, such as every Tuesday at 3 a.m.

- **Manual scan**
  A manual scan runs once when initiated. Initiate a manual scan as described below.

1 From the left-side menu of the Trend Micro NAS Security settings page, choose Scan Options > Manual Scan.

2 Click Scan now. This starts the virus scan.

If the scan finds a virus, the user can be notified in two ways:
• The I34 virus alert message is normally shown on the LCD panel. Once the virus is removed from the quarantine folder, the message is no longer displayed. If the antivirus software is configured to delete viruses from the quarantine folder automatically, then the I34 virus alert message will not be displayed.

• If email notification is enabled in Settings, then the antivirus software notifies the user by email if a virus is found. Enabling email notifications is recommended.

Depending on how many files are on your TeraStation, a virus scan may take several hours. Estimated scanning times are shown below.
10,000 files: ~ 30 minutes
100,000 files: ~ 5 hours
1,000,000 files: ~ 50 hours

Checking the Log

Follow the procedure below to check the virus scan log.

1. From the left-side menu of the Trend Micro NAS Security settings page, choose Logs.

2. Click the log item that you want to check.
3 Click Display Log.

**System Logs**

| 16 log(s) stored from 2017-03-29 17:07:03 to 2017-03-29 18:01:21 |
|---|---|---|---|---|---|---|
| Data range: | Today | | | | | |
| Start date: | 2017-03-29 | | | | | |
| End date: | 2017-03-29 | | | | | |
| Sort by: | Date/Time | Descending | | | | |
| Entries per page: | 25 entries | | | | | |

Note: Only the previous 1000 log entries will be retrieved for the specified log range.

This completes the procedure for checking the log.

**Opening the Online Help**

For more information on the antivirus software, refer to the online help. Follow the procedure below to access the online help.

1. From the right-top menu of the Trend Micro NAS Security settings page, choose Help > Contents and Index.

2. Online help will open.

Online help is now available.

**Email Notification**

Your TeraStation can send you email reports daily, or when settings are changed or an error occurs. You can configure the events that will trigger notifications from any of the following functions:
- Drive quota, drives (internal, external, or RAID array), fan, backup, replication, failover, antivirus, system alert, surveillance cameras

Refer to the contextual help in Settings for more detailed information such as when the notification email will be sent or the differences between the notification categories.

1. From Settings, click Management.

2. Move the email notification switch to the position to enable email notification.
3 Click to the right of “Email Notification”.

4 Click Edit.

5 Enter your email server settings, notification email’s default subject, and configure recipients and the time when email reports will be sent. Click OK to send a test email. If you select an authentication type other than “Disable” from the drop-down list, you can enter the sender email address and credentials of the email server.
To change the events of email reports, click **Advanced Report Settings**. On the displayed screen, select or clear the category’s checkboxes.

The notification emails will be categorized into the following importance levels.

<table>
<thead>
<tr>
<th>Levels</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily Report</td>
<td>Describes the status of the TeraStation in a daily report email.</td>
</tr>
<tr>
<td>Info</td>
<td>Sends a notification email if an event occurs. Info reports will contain just information such as capacity information, job starts/finishes, etc.</td>
</tr>
<tr>
<td>Notice</td>
<td>Sends a notification email if a non-critical error occurs. Notice reports will contain warnings such as something has failed, but the function or unit can continue operating as usual. It is recommended to do the corrective action for the notice as soon as possible.</td>
</tr>
<tr>
<td>Error</td>
<td>Sends a notification email if a critical error occurs. Error reports will describe critical failure which prevents a function or unit from operating. It is recommended to do the corrective action to for the error immediately.</td>
</tr>
</tbody>
</table>

**Sleep Mode**

To save energy, you can specify times to put the TeraStation into sleep (standby) mode, during which the drive and LEDs are turned off.

1. From Settings, click **Management**.

2. Click **Sleep Timer** to the right of “Sleep Timer”.

3. Click **Edit**.
Specify the timer interval, wake-up time, and time to go into sleep mode, then click **OK**.

Notes:

- Up to three timers can be set.
- The time to enter sleep mode can be set from 12:00 a.m. to 3:45 a.m. of the next day. The time to wake from sleep mode can be set from 12:00 a.m. to 11:45 p.m. If the time to enter sleep mode is after 12:00 a.m., the wake-up time setting may be from 4:00 a.m. to 11:45 p.m.
- The time to enter sleep mode should not be set at the same time as or before the start time.
- If a timer is scheduled during a drive check, drive format, backup process, and backup job, or within 5 minutes of the current time, the TeraStation will not change to standby mode when the configured time is reached.
- If scheduled times in the timer overlap, the operation is performed using the widest time interval.
- Examples of multiple timer settings are shown below.

**Example 1:**
If running at a current time of 10:00 a.m. Wednesday  
Timer 1: Daily 12:00–24:00  
Timer 2: Not used  
Timer 3: Not used  
No operation is performed at 12:00 p.m. and the unit goes into sleep mode at 12:00 a.m.

**Example 2:**
If running at a current time of 10:00 a.m. Wednesday  
Timer 1: Daily 9:00–18:00  
Timer 2: Wednesday 10:00–20:00  
Timer 3: Not used  
On days other than Wednesday, normal operation begins at 9:00 a.m. and the unit goes into sleep mode at 6:00 p.m. On Wednesday, the unit goes into sleep mode at 8:00 p.m.

**Example 3:**
If running at a current time of 10:00 a.m. Wednesday  
Timer 1: Daily 9:00–18:00  
Timer 2: Wednesday 10:00–1:00 a.m. of the next day
Timer 3: Not used
On days other than Wednesday, normal operation begins at 9:00 a.m. and the unit goes into sleep mode at 6:00 p.m. On Wednesday, normal operation begins at 10:00 a.m. and the unit goes into sleep mode at 1:00 a.m. of the next day.

Example 4:
If running at a current time of 10:00 a.m. Wednesday
Timer 1: Daily 9:00–18:00
Timer 2: Wednesday 7:30–22:00
Timer 3: Not used
On days other than Wednesday, normal operation begins at 9:00 a.m. and the unit goes into sleep mode at 6:00 p.m. On Wednesday, normal operation begins at 7:30 a.m. and the unit goes into sleep mode at 10:00 p.m.

• To wake the TeraStation from sleep mode manually, press the power button.

Wake-on-LAN
The TeraStation supports Wake-on-LAN, which allows it to be turned on remotely.

1 From Settings, click Network.

2 Click 

3 Click the LAN port that will receive Wake-on-LAN packets.

4 Enable “Wake-on-LAN”, then click OK.

Wake-on-LAN is now enabled. As long as the TeraStation is connected to a power source and the network, you can turn it on remotely.

Notes:
• After a power outage, wait 5 minutes after power is restored to send the Wake-on-LAN packet to the TeraStation.
• After receiving the Wake-on-LAN packet, the TeraStation may take approximately five minutes to be ready to use.
• To use Wake-on-LAN, you’ll need Wake-on-LAN software that sends magic packets. The TeraStation does not include Wake-on-LAN software.

• The TeraStation does not support using Wake-on-LAN and port trunking at the same time. You may use either feature, but not both at the same time.

• On the local network, Wake-on-LAN packets may be sent to port 2304 on either of the TeraStation’s LAN ports. If the TeraStation is connected to a Buffalo wireless router configured for remote access, then it may be turned on from outside the local network (from the WAN side). To use this feature, connect the router to only LAN port 1 on the TeraStation.

### UPS (Uninterruptible Power Supply)

If a UPS (sold separately) is attached, the TeraStation can be automatically shut down to protect data in the event of a power outage.

1. Plug the power cable of the UPS to a wall socket.

2. Connect the power cable of the TeraStation to the UPS.

3. Connect the UPS and TeraStation using a USB cable or serial cable.

4. Turn on the UPS, then the TeraStation.

5. From Settings, click *Management*.

6. Click **UPS Sync** to the right of “UPS Sync”.

7. Click *Edit*.
Configure the desired settings, then click OK.

Notes:

- If the TeraStation is connected directly to a UPS, select “Sync with UPS connected to this TeraStation”. If a different Buffalo NAS device is connected to the UPS, select “Sync with UPS connected to another LinkStation or TeraStation on the same network”. After making this selection, enter the IP address of the Buffalo NAS device that will be the sync source into “Other LinkStation or TeraStation’s IP Address”.
- When the TeraStation is restarted after an automatic shutdown such as from a power outage or power supply problem, verify that the power supply has been restored. If the TeraStation is turned on while it is still running on the UPS and without the power supply restored, the automatic shutdown will not be performed, even after the specified time elapses.
- If the power supply from the UPS to the TeraStation is stopped and restarted when UPS recovery is enabled, the TeraStation is automatically restarted.

**Port Trunking**

Two Ethernet cables can be used to establish two separate communication routes, providing LAN port redundancy and improving communication reliability. The use of two Ethernet cables enables access to the TeraStation even if one of the cables is disconnected.

The port trunking modes that can be set in the TeraStation are shown below.

<table>
<thead>
<tr>
<th>Trunking Mode</th>
<th>Characteristics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Round-robin</td>
<td>Network packets are transmitted in sequential order from the first available NIC slave through the last.</td>
</tr>
<tr>
<td>Active-backup</td>
<td>Only one NIC slave in the bond is active. A different slave becomes active if and only if the active slave fails.</td>
</tr>
<tr>
<td>XOR</td>
<td>Transmits network packets based on [(source MAC address XOR’d with destination MAC address) modulo NIC slave count]. This selects the same NIC slave for each destination MAC address.</td>
</tr>
<tr>
<td>Broadcast</td>
<td>Transmits network packets on all slave network interfaces.</td>
</tr>
<tr>
<td>Trunking Mode</td>
<td>Characteristics</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Dynamic link aggregation | Creates aggregation groups that share the network speed and duplex settings. Utilizes all slave network interfaces in the active aggregator group according to the 802.3ad specification.  
**Note:** To use this mode, a separate intelligent switch that supports IEEE 802.3ad is required. Configure LACP on the switch first. |
| TLB                   | The outgoing network packet traffic is distributed according to the current load (relative to the speed) on each network interface slave.            |
| ALB                   | The incoming and outgoing network packets traffic is distributed according to the current load on each network interface slave. The receive load balancing is achieved by ARP negotiation. |

*A separate intelligent switch that supports EtherChannel or other port trunking is required. Configure two LAN ports on the switch for port trunking first.  
**Note:** If the TeraStation is being used as an iSCSI drive, disable iSCSI before changing network settings such as port trunking. Navigate to Drives > iSCSI in Settings and move the iSCSI switch to the off position temporarily.

1. Use an Ethernet cable to connect the hub LAN port and TeraStation LAN port 1.  
   **Notes:**  
   - Do not connect the second Ethernet cable to the TeraStation yet.  
   - If using an intelligent switch, configure the LAN ports on the switch first, before connecting to the TeraStation.

2. From Settings, click Network.

3. Click 📦 to the right of “Port Trunking”.

4. Choose a port trunking link.
5 Select the LAN port that will be used, select the port trunking mode, and click Accept.

![Port Trunking](image)

6 Connect the hub's LAN port and TeraStation's LAN port using the second LAN cable. If you are using an intelligent switch, connect to the LAN port that was previously configured for port trunking.

7 Restart the TeraStation before use.

**Connecting a Printer**

You can connect a printer to the USB port on the TeraStation.

**Notes:**

- Only one USB printer can be connected to the TeraStation.
- Bidirectional communication is not supported i.e., remaining ink quantities and other printer status information are not displayed.
- If a multifunctional printer is connected, only the printer function can be used. Other functions such as scanning will not be available.
- The print server does not support macOS.
- Don't disable the SMB protocol while the print server is enabled. If you do, you will need to enable SMB again and reconfigure the print server from scratch.

1 From Settings, click Services.

![Services](image)

2 Move the print server switch to the position to enable the print server.

![Print Server](image)

3 Refer to the manual supplied with the printer and install the printer drivers.
4 Launch NAS Navigator2. Double-click your TeraStation's icon.

5 Double-click the icon of the connected printer (the shared name is displayed).

6 Click OK.

7 Select your printer, then click OK.

8 Register the printer.

---

**TeraSearch**

TeraSearch lets you locate files stored on the TeraStation. There are two search methods: you can either search by the text content contained in files, or search by specifying the filename, owner, date updated, and/or file size. TeraSearch can only search for Microsoft Office files, OpenDocument files, PDF files, HTML files, and text files. Other file types, such as music or movie files, are not compatible with TeraSearch. Refer to the chart below for all file types supported by TeraSearch.

<table>
<thead>
<tr>
<th>File Type</th>
<th>Filename Extensions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Office files</td>
<td>.doc, .docx, .docm, .xls, .xlsx, .xlsm, .ppt, .pptx, .pptm, .ppsx, .ppsm</td>
</tr>
<tr>
<td>OpenDocument files</td>
<td>.odt, .ods, .odp, .odg, .odc, .odf, .odi, .odm, .odb</td>
</tr>
<tr>
<td>PDF files</td>
<td>.pdf</td>
</tr>
<tr>
<td>HTML files</td>
<td>.html, .htm</td>
</tr>
<tr>
<td>Text files</td>
<td>.txt</td>
</tr>
</tbody>
</table>

Follow the procedure below to enable it.

1 From Settings, click *File Sharing*.

2 Click to the right of “Folder Setup”.

3 Click the shared folder to be indexed.

4 Click *Edit*.

5 Check “Include this folder in the search index”, then click OK.

6 Click OK.

7 Click Close.

8 Click *Applications*. 
9 Move the TeraSearch switch to the position to enable TeraSearch.

10 Click to the right of “TeraSearch”.

11 Click Refresh Index.

12 Click Edit.

13 Enter the port number that you want to use and the time that the index will be updated, then click OK.

14 Open the following URL in your browser.
http://(IP address of your TeraStation):3000/

15 Enter your TeraStation's username and password, then click Login.

16 Enter a keyword into the “Search Text” field. To search by other parameters such as filename or file size, check “Advanced Search”.

17 Click Search. The search results are displayed. Click the filename in the results to open the file.
The "offline files" feature that is included with many versions of Windows can be used with files on the TeraStation. You will be able to work on files stored on the TeraStation even when your PC is disconnected from the network. When you next connect to the network, the updated files are written and synchronized. Follow the procedure below to configure offline files.

1. From Settings, click File Sharing.

2. Click to the right of “Folder Setup”.

3. Click the shared folder for offline files.

4. Click Edit.

   - **Manual File Caching**: User selects files that are cached.
   - **Automatic File Caching**: Opened files can be cached locally for offline use. Previous versions of files that are not synchronized are automatically replaced by the latest versions.
   - **Automatic Program and File Caching**: Opened files can be cached locally for use offline. Previous versions of files and applications executed on the network that are not synchronized are automatically replaced by the latest version of the files and applications.

6. From Windows, navigate to Folder options (for users who are using Windows Vista or later, skip to step 9).

7. Check “Enable Offline Files”, then click OK.
   **Note**: Offline files cannot be enabled if “Use Fast User Switching” is enabled. To change the setting, open “User Accounts” in Control Panel and select “Change the way users log on or off”.

8. From File Explorer, right-click the icon of the shared folder on the TeraStation for which you have set the offline feature, then click Always available offline. If the offline file wizard opens, follow the procedure on the screen.
When the offline settings and sync settings are completed, the files and folders set appear as shown:

If the computer is disconnected from the network after synchronization is completed, the offline file function can be used.

Offline files can be accessed by the original Universal Naming Convention (UNC) where the data was saved.

**Note:** If you cannot access offline files, try the following procedure:

1. Reconnect the computer to the network.
2. From Control Panel, change the view to the icon view and click **Sync Center**. Click **Sync All** to synchronize all offline files.
3. Disconnect the computer from the network and verify that you can access offline files.

---

**DFS**

DFS (Distributed File System) is a set of client and server services that allows Windows users to organize many distributed SMB file shares into a distributed file system. Follow the procedure below to enable DFS on the TeraStation.

1. From Settings, click **File Sharing**.
2 Click to the right of “DFS”.

3 Click Edit.

4 Enable or disable “Set DFS Link to DFS Root”. If enabled, a DFS link target shared folder is created under the DFS root. If disabled, up to 8 DFS link target shared folders can be created under the DFS root.

5 Enter DFS Root Folder Name.

6 Click Add Link.

7 Enter the link name, hostname, and shared folder name, then click OK.
8 Click OK.

9 Move the DFS switch to the position to enable DFS.

Notes:
- Don’t disable the SMB protocol while DFS is enabled. If you do, you will need to enable SMB again and reconfigure DFS from scratch.
- TeraStations, LinkStations, and SMB-compatible Windows computers can be specified as DFS link targets (macOS and Linux are not supported).

Accessing from an NFS Client

Note: (US customers only) Buffalo’s customer support will help configure the NFS settings on your TeraStation, and will support VMware and Windows clients but will not provide support for configuring your Linux or other UNIX clients. There are various types of UNIX and the procedures for configuring NFS with them will vary considerably. For help configuring your NetWare, Linux, or other UNIX clients for NFS support, please consult each client’s own documentation and support.

1 From Settings, click File Sharing.

2 Click to the right of “Folder Setup”.

3 Choose the shared folder that will be accessible from the NFS client.

4 Click Edit.

5 Under “LAN Protocol Support”, select the “NFS” checkbox and click OK.

   Note the NFS path. It will be used later for accessing data from an NFS client.

6 Click Close.

7 Move the NFS switch to the position to enable NFS.

8 Click to the right of “NFS”.
Click the *Client Settings* tab.
10 Click Add Client.

![NFS Settings](image)

**Note:** To delete a client, select the checkboxes of the clients from the lists and click Delete Client.

11 Enter the hostname and IP address of the NFS client, then click OK. You should add all NFS clients to access the shared folder.

![NFS Client Settings](image)

**Notes:**
- To restrict NFS access to a specific network or client, navigate to File Sharing > NFS > Services and click Edit. Enter the address of the network. For example, if your local network subnet has a router at 192.168.1.1 and clients
with IP addresses in the range from 192.168.1.2 through 192.168.1.48 with subnet mask 255.255.255.0, then the “Public Network Address” would be 192.168.1.0 and the “Public Subnet Mask” would be 255.255.255.0. This would mean that only clients on this local network would be able to access the NFS share. If the default settings are used (0.0.0.0 for both the public network address and the public subnet mask), then access to the NFS share will not be restricted.

- To use shared folders set for NFS as drives on VMware ESX/ESXi or Citrix, change the operation mode from “User Mode” to “Kernel Mode” on the screen by navigating to Services > Edit.
- Async is the default for NFS rules. Sync is available only when the device is in kernel mode.
- To restrict access to a NFS share for specific clients, navigate to File Sharing > NFS > NFS Rules and click Add Rule. Choose the folder to restrict access to, and enter the clients that will have restricted access in the “Hosts” field. Clients may be entered by hostname, IP address, or IP address range. Wildcards are supported. Separate multiple entries with commas. You may assign read-only or read and write access to the listed clients. Rules will override settings made from the Services tab.

**NFS Mount Commands**

Enter the mount command to access the shared folder from the NFS client. The mount command depends on your operating system. The examples below assume that IP address of your TeraStation is 192.168.11.10, “/mnt/array1/share” is the desired NFS path, and “/mnt/nas” or drive letter “z” is the mount point.

**For Linux:**

```bash
mount -t nfs 192.168.11.10:/mnt/array1/share /mnt/nas
```

**For Windows Service for Unix 3.5:**

```bash
mount 192.168.11.10:/mnt/array1/share z:
```

**For Solaris 10:**

```bash
mount -F nfs 192.168.11.10:/mnt/array1/share /mnt/nas
```

**For macOS (NFS is working in kernel mode):**

```bash
mount -t nfs -o resvport 192.168.11.10:/mnt/array1/share /mnt/nas
```

**Encrypting Data Transmission**

### Encrypting Settings Data

All communication with Settings can use SSL encryption if you access the Settings page by changing “http://” to “https://” in the browser address bar or click Secure Connection from the login window. Once you are logged in using the HTTPS connection and wish to disable SSL encryption, click Normal Connection from the login window.

### Encrypting FTP Transfer Data

#### Using SSL/TLS Encryption

You can encrypt passwords and files using SSL/TLS for secure FTP communication. First, open a shared folder’s settings and click Edit; under “LAN Protocol Support”, select the “FTP” checkbox and click OK. Enable SSL security in the setup screen for your FTP client. The procedure depends on the FTP client software.

#### Using SSH Encryption

You can encrypt passwords using SSH for secure FTP communication. First, open a shared folder’s settings and click Edit; under “LAN Protocol Support”, select the “SFTP” checkbox and click OK. Also, you have to enable the SFTP service by moving the SFTP switch to the on position on “File Sharing”.

192
SSL Keys

SSL keys are used during setup screen operations and FTP communication. SSL (Secure Socket Layer) is a type of encryption system called public key encryption. Generally, SSL is managed by the two files below.

server.crt (SSL Certificates)

The TeraStation sends the file to a computer, and the computer uses it to perform encryption. The TeraStation receives the encrypted data and uses server.key (the private key) to decrypt the data.

In SSL, this key contains the server certificate, and depending on your computer environment, a check may be performed to determine the trustworthiness of the certificate. The server certificate included in the TeraStation's default settings was created by Buffalo, and in some cases the security certificate warning message may appear in your browser or another security software. Disregard this message and continue.

server.key (SSL Private Key)

This file is used as a pair with server.crt (server certificate). This is required for decrypting the data that was encrypted by the server certificate, and this is normally not revealed.

Note: The passphrase for the private key must be removed before importing to the TeraStation.

Updating SSL Key Files

To update a server certificate and a private key for SSL, follow this procedure.

1. From Settings, click Management.
2. Click SSL.
3. Register “server.key” for “Secret Key” and “server.crt” for “Server Certificate (.crt)”, then click Import.

Notes:
- Place the SSL key files (server.key, server.crt) directly below the C root drive. The SSL key files may be unable to be updated if it is placed in folders or paths that contain multibyte characters.
- If Settings cannot be displayed after updating, initialize the TeraStation settings.
- Updating the firmware initializes an SSL key.

Web Server

The TeraStation can be used as a web server. In addition to HTML files, images, and JavaScript, the TeraStation also allows installation of Perl script and PHP script files.

1. From Settings, click Services.
2. Move the web server switch to the position to enable the web server.
3 Click to the right of “Web Server”.

4 Click Edit.

**Note:** The settings of the PHP language interpreter can be changed from “Edit php.ini”.

5 Click Browse.
Choose a shared folder for the web server, then click OK.

Choose an external port, then click OK.

MySQL Server

The TeraStation can be used as a MySQL server. A MySQL database may be installed and linked to the web server.

1. From Settings, click Services.

2. Move the MySQL server switch to the position to enable the MySQL server.

3. Click to the right of “MySQL Server”.

4. Click Edit.
5 Click Browse.

![MySQL Server Settings](image)

6 Choose a shared folder for the MySQL server, then click OK.

![Browse Folders](image)

7 Choose an external port, then click OK.

**SNMP**

If SNMP is enabled, you can browse your TeraStation from SNMP-compatible network management software.

1 From Settings, click **Network**.
2 Click to the right of “SNMP”.

3 Click Edit.

4 Select whether to use SNMP version 2 or version 3.

5 Configure the desired settings, then click OK.

6 Move the SNMP switch to the position to enable SNMP.

7 SNMP has been configured for the TeraStation. For further use, configure your SNMP-compatible network management software using the Buffalo-specific MIB (management information base) file. The MIB file is available from the Buffalo website. Depending on which SNMP client software you use, the procedure for configuring the software will differ. For more detailed information on configuring the client software, refer to its help or included manual.
Saving and Applying Settings

The TeraStation’s settings can be saved to a USB drive and restored to another TeraStation of the same series. Use this feature to back up and copy settings to a new TeraStation.

Save Settings & Firmware

Write down the drive configuration (number of drives, RAID, LVM, etc.) of the TeraStation whose settings were saved. Make sure that any TeraStations that you apply these settings to have exactly the same drive configuration before you apply the settings. If the drive configuration is different, you may get unexpected results.

The following settings are not saved or restored:

<table>
<thead>
<tr>
<th>Category</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Sharing</td>
<td>All settings for USB drives and media cartridges</td>
</tr>
<tr>
<td>Drives</td>
<td>All settings in “Drives”</td>
</tr>
<tr>
<td></td>
<td>All settings in “RAID” &gt; “Options” &gt; “RAID Array Settings”</td>
</tr>
<tr>
<td></td>
<td>All settings in “LVM”</td>
</tr>
<tr>
<td></td>
<td>All settings in “iSCSI”</td>
</tr>
<tr>
<td></td>
<td>All settings for USB drives and media cartridges</td>
</tr>
<tr>
<td>Network</td>
<td>All settings except for service port restrictions, Wake-on-LAN, and Ethernet frame size settings in “IP Address”</td>
</tr>
<tr>
<td></td>
<td>All settings in “Port Trunking”</td>
</tr>
<tr>
<td>Backup</td>
<td>All settings in “Failover”</td>
</tr>
<tr>
<td>Management</td>
<td>The TeraStation’s hostname</td>
</tr>
<tr>
<td></td>
<td>All settings in “UPS Sync”</td>
</tr>
<tr>
<td></td>
<td>All settings in “SSL”</td>
</tr>
<tr>
<td></td>
<td>Display language in Settings</td>
</tr>
</tbody>
</table>

Saving Settings

1. Insert a 1 GB or larger USB drive (not included) into a USB 2.0 port on the TeraStation.
   **Note:** All data on the USB drive will be erased!

2. From Settings, click Management.
3 Click to the right of “Configuration Management”.

4 Select “Save current configuration to a USB drive”.

5 From “Target USB drive”, select the USB drive that is connected to the USB 2.0 port on the TeraStation, then click Execute.

6 The “Confirm Operation” screen will open. Enter the confirmation number, then click OK.

7 The TeraStation will save the settings. When saving settings is completed, click OK.

Dismount the USB drive before unplugging it. Refer to the “Dismounting Drives” section in chapter 4 for the procedure on dismounting drives.

Troubleshooting:

If the settings are not saved to the USB drive successfully, you may receive an error message such as “The specified operation cannot be executed.” Verify:

- The USB drive is connected to a USB 2.0 port, not a USB 3.0 port.
- The USB drive has a capacity of 1 GB or larger.
- The USB drive is not write-protected.

Applying Settings

The saved settings can be applied to a different TeraStation of the same series. If applying settings to another TeraStation, the unit’s current firmware version will be changed to the version used to save the settings.

1 Insert the USB drive with the saved settings to a USB 2.0 port on the TeraStation.

2 From Settings, click Management.

3 Click to the right of “Configuration Management”.

199
4 Select “Transfer settings from a USB drive”.

5 From “Target USB drive”, select the USB drive that is connected to the USB 2.0 port on the TeraStation, then click Execute.

6 The “Confirm Operation” screen will open. Enter the confirmation number, then click OK.

7 The TeraStation will apply the settings. When applying settings is completed, click OK.

Dismount the USB drive before unplugging it. Refer to the “Dismounting Drives” section in chapter 4 for the procedure on dismounting drives.

### Transferring Another TeraStation’s Settings

You can transfer saved settings from another series TeraStation to a TS3000 series TeraStation using the “NS-SHFT” software. The following settings can be transferred:

- Shared folders
- Access restrictions
- Users
- Groups

*NT domain access restrictions cannot be transferred.

**Note:** This feature is currently supported for the TS-HTGL/R5 series TeraStations and TS-X series TeraStations (as of June 2015). The latest compatibility information will be on the Buffalo website.

Follow the procedure below to transfer settings from another series TeraStation.

1. Create the config file (.nas_config) using NS-SHFT. The “NS-SHFT” software can be downloaded from the Buffalo website.
   
   For procedure on creating the config file, refer to the NS-SHFT user guide.

2. Before transferring access restrictions with Active Directory domain users or external users, make sure the migration target TeraStations are joined to the same domain controller. To have the unit join the domain network, read and follow the procedure on either the “Active Directory” section or “User Authentication with an External SMB Server” section in chapter 3.

   If you didn't configure access restrictions with Active Directory domain users and external users, skip to step 3.

3. From Settings, click Management.
4 Click to the right of “Configuration Management”.

5 Click Browse and select the config file (.nas_config) that was created with another TeraStation. If the config file was created with a password, enter it in the “Password” field.

6 Click Import.

7 The “Confirm Operation” screen will open. Enter the confirmation number, then click OK.

8 When transferring settings is completed, click OK.

Dismount the USB drive before unplugging it. Refer to the “Dismounting Drives” section in chapter 4 for the procedure on dismounting drives.

Notes:
- If the migration target TeraStation contains shared folders, users, and groups that share the same name as the transferred settings, the existing settings will be overwritten.
- If the migration target TeraStation has already added some shared folders, users, and groups, the transferred settings may exceed the maximum number of allowed shared folders, users, or groups. After migration finishes, open Settings and verify that all settings were properly transferred.

---

Restoring Factory Defaults

There are several ways to initialize the TeraStation and restore its factory default settings. One simple way to do this is to hold down the init button (refer to the TeraStation diagram in chapter 1) on the front panel for three seconds. Normally this will reset the admin username and password, network configuration, SSL, and security port settings to their factory default values. However, this button can be disabled in Settings. If the init button is disabled, refer to the methods below on how to initialize the TeraStation.

Initializing from Settings

To initialize the TeraStation to its factory defaults from Settings, follow this procedure.
1. From Settings, click Management.

2. Click to the right of “Restore/Erase”.

3. Click Initialize TeraStation.

4. The “Confirm Operation” screen will open. Enter the confirmation number, then click OK.

5. The TeraStation will restore its factory default settings. When restoring settings is completed, click OK.

Dismount the USB drive before unplugging it. Refer to the “Dismounting Drives” section in chapter 4 for the procedure on dismounting drives.

Creating a Recovery Drive

A recovery drive will restore the settings on your TeraStation to their factory defaults. You can initialize them without logging in to Settings. Follow the procedure below to create a recovery drive.

Notes:
- Normally, making and using a recovery drive will not affect data on the TeraStation. However, always back up your data regularly!
- This USB drive can be used to recover the system if your TeraStation doesn’t boot at all. In this case, if the data partition is damaged, then all your data will be deleted by the recovery process.

1. Insert a 1 GB or larger USB drive (not included) into a USB 2.0 port on the TeraStation.
   Note: All data on the USB drive will be erased!

2. From Settings, click Management.

3. Click to the right of “Configuration Management”.

Chapter 10 Advanced Features

202
4 Select “Create a USB drive for initializing settings”.

5 From “Target USB drive”, select the USB drive that is connected to the USB 2.0 port on the TeraStation, then click Execute.

6 The “Confirm Operation” screen will open. Enter the confirmation number, then click OK.

7 The TeraStation will create the recovery drive. This will take about a minute. When creating the USB recovery drive is completed, click OK.

Dismount the USB drive before unplugging it. Refer to the “Dismounting Drives” section in chapter 4 for the procedure on dismounting drives.

Initializing with the USB Drive

To initialize the settings on your TeraStation with a recovery drive, follow the procedure below. If using a recovery drive to initialize the TeraStation, you do not have to be logged in to Settings. For procedure on how to create a recovery drive, refer to the “Creating a Recovery Drive” in chapter 1.

Note: Initializing settings with the USB drive is available for the same TeraStation unit that created the recovery drive.

1 Turn off the TeraStation by pressing and holding the power button for 3 seconds until it beeps.

2 Insert the recovery USB drive into a USB 2.0 port on the TeraStation. Make sure that no other USB drives are currently connected to any USB ports on the TeraStation.

3 Set the boot mode switch to the “USB” position.

4 Press the power button to turn on the TeraStation.

5 When the I41 message appears on the LCD panel, press the function button.

6 It will take several minutes for initializing the settings. The TeraStation will shut down when it’s finished.

7 After shutdown, the I39 message is displayed.

8 Set the boot mode switch to the “HDD” position and disconnect the USB drive.

9 Press the power button to turn on the TeraStation.
Logs

Displaying TeraStation’s Logs

Follow the procedure to check the TeraStation’s logs.

1. From Settings, click Management.

2. Click ☰ to the right of “Logs”.

3. Select a log to view.

The file operation log stores file operations performed on the internal drives. File operations on USB drives are not logged.

Note: All logs are encoded in UTF-8 format. To show them correctly, change the software encoding to “UTF-8”.

Transferring Logs to the Syslog Server

1. From Settings, click Management.

2. Click ☰ to the right of “Logs”.

3. Click Edit.
4 Enable “Syslog Transfer”.

5 Enter the IP address of the syslog server where you want to transfer the logs to.

6 Select the type of log that you want to transfer from “Logs to Transfer”.

7 Click OK.

Note: FTP logs cannot be written to a syslog server.

Creating a Link to the Logs in the Shared Folder

1 From Settings, click Management.

2 Click to the right of “Logs”.

3 Click Edit.
Enable “Share Link to Logs”.

Click Browse and select the shared folder where the link will be created in “Target Shared Folder”. Click OK.

Under the selected shared folder, a folder named “system_log” will now contain the logs.

**Updating the Firmware**

If new firmware is available, a message is displayed when the TeraStation boots. You can update the firmware manually.

1. From Settings, click Management.

2. Click to the right of “Update”.

3. Click OK.

4. Click Install Update.

5. The “Confirm Operation” screen will open. Enter the confirmation number, then click OK.

You can also download the latest firmware from the [Buffalo website](https://buffalo.com).

**Name, Date, Time, and Language**

Configure the TeraStation’s hostname, date, time, and language as shown below.

**Note:** If the TeraStation is being used as an iSCSI drive, to change the settings, navigate to Drives > iSCSI in Settings and move the iSCSI switch to the off position temporarily before changing settings.
1. From Settings, click *Management*.

![Management button](image)

2. Click the button to the right of "Name/Time/Language".

![Name/Time/Language](image)

3. Click *Edit*.

4. Click the *Name* tab, then configure the TeraStation's name and description.

![Name/Time/Language settings](image)
Click the **Time** tab. Enable the NTP server and select the “Use Default NTP Server” checkbox. If you disable the NTP function, click **Use Local Date/Time** to use your computer’s time settings for the TeraStation.

By default, the TeraStation adjusts its clock automatically by using a default NTP server. This NTP server belongs to Internet Multi Feed Inc. For more information, visit [http://www.jst.mfeed.ad.jp](http://www.jst.mfeed.ad.jp).

To use a different NTP server, clear the “Use Default NTP Server” checkbox and enter a new NTP IP address or its hostname, then click **OK**. If an NTP server is specified by name instead of IP address, make sure that a DNS server is configured for the TeraStation.

**Note:** The internal clocks of the TeraStation and other devices on your network may run at slightly different speeds. Over a long period of time, your network devices may show somewhat different times, which can cause network problems. If clocks on your network vary by more than 5 minutes it may cause unexpected behavior. For best results, keep all clocks on the network set to the same time by adjusting them regularly, or use an NTP server to correct them all automatically.
6 Click the Language tab. Select the language to be used and click OK.

![Language tab screenshot]

**Note**: This tab changes the language used by the TeraStation for email notifications, antivirus software, DLNA, and other functions. To change the language displayed in Settings, go to Advanced Settings or Easy Admin and click Language from the menu bar. Choose your desired language from the drop-down list.

---

**Beep Alerts**

You can set the TeraStation to beep if certain errors occur.

1. From Settings, click Management.

2. Click to the right of “Notifications”.

3. Click Edit.

4. Click the Alert Sound Settings tab.
5 Select the triggers to make the alert beep, then click OK.

### LCD and LEDs

You may configure options for the LCD panel and adjust the brightness of the LCD panel and LEDs on the TeraStation.

1. From Settings, click *Management*.

2. Click to the right of “Notifications”.

3. Click *Edit*.

4. Click the *Front Panel Display Settings* tab.
5. Configure your settings, then click OK.

**Jumbo Frames**

If your other network devices support jumbo frames, you may be able to increase network performance.

1. From Settings, click *Network*.

2. Click ◀️ to the right of "IP Address".
3 Click the LAN port where the jumbo frames will be used.

4 Select the desired Ethernet frame size and click OK.
### Changing the IP Address

Normally, the TeraStation’s IP address is set automatically from a DHCP server on your network. If you prefer, you can set it manually. An easy way to do this is to change it on NAS Navigator2 running on a computer connected to the same router (subnet) as the TeraStation. The procedure to change the IP address in Settings is below.

**Note:** If the TeraStation is being used as an iSCSI drive, to change the settings, navigate to *Drives > iSCSI* in Settings and move the iSCSI switch to the *off* position temporarily before changing settings.

1. From Settings, click *Network*.

---

**Note:** Make sure the TeraStation’s Ethernet frame size is smaller than the hub or router’s. Larger frame sizes may not transfer the data to the TeraStation correctly.

---

**Connection**

<table>
<thead>
<tr>
<th>Jumbo Frame</th>
<th>Jumbo Frame Compatible Switch</th>
<th>Jumbo Frame Compatible PC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transfer data in jumbo frames.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Jumbo Frame</th>
<th>Jumbo Frame Compatible Switch</th>
<th>Jumbo Frame Compatible PC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transfer data not using jumbo frames.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Jumbo Frame</th>
<th>Jumbo Frame Compatible Switch</th>
<th>Jumbo Frame Compatible PC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transfer data not using jumbo frames.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Jumbo Frame</th>
<th>Jumbo Frame Compatible Switch</th>
<th>Jumbo Frame Compatible PC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any data cannot be transferred.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
2 Click the right of "IP Address".

3 Click the LAN port where the IP address will be changed.

4 Disable "DHCP" and enter the desired IP address and subnet mask.
5 Under “Network Settings”, enter the default gateway and DNS server addresses. If no changes are necessary, keep them as is.

6 Click OK.

Notes:
- The default gateway in the “Network Settings” field will only affect LAN port 1; the DNS server addresses will affect both LAN ports 1 and 2. If you change the DNS server address on either IP address settings page, it will affect the other LAN port as well.
- Do not set the IP address of the same segment for LAN port 1 and LAN port 2. This may cause unstable network communication.
- Use LAN port 1 to access different network subnets from the TeraStation. Access to a different network subnet is not possible from LAN port 2 since it doesn’t have a default gateway.
- The following IP addresses are reserved and should not be used. If you configure one of them by accident, initialize all settings with the init button on the TeraStation.
  - Local loopback address: 127.0.0.1, 255.255.255.0
  - Network address: 0.0.0.0, 255.255.255.0
  - Broadcast address: 255.255.255.255, 255.255.255.0
  - The IP address range from 224.0.0.0 to 255.255.255.255
NAS Navigator2 for Windows

NAS Navigator2 is a utility program that makes it easy to display Settings, change the Buffalo NAS device's IP address, or check its drive. If you installed the TeraStation with the TeraNavigator CD, NAS Navigator2 was installed automatically.

NAS Navigator2 will run in the system tray when the computer is on. Double-click the NAS Navigator2 icon (_TERMINAL) to start NAS Navigator2.

Click a Buffalo NAS device's icon to display total capacity, used capacity, workgroup name, IP address, subnet mask, default gateway, MAC address, and firmware version.

Double-click the icon to open a shared folder on the Buffalo NAS device.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Menu</strong></td>
<td></td>
</tr>
<tr>
<td>Map Share*</td>
<td>Assigns the Buffalo NAS device's shared folder as a network drive.</td>
</tr>
<tr>
<td>Disconnect Share*</td>
<td>Unmaps the network drive.</td>
</tr>
<tr>
<td>Map All Remote Shares to Drive Letters</td>
<td>Assigns all the Buffalo NAS devices' shared folders as network drives. This is available only when a shared folder has been created.</td>
</tr>
<tr>
<td>Create Desktop Shortcut*</td>
<td>Creates a desktop shortcut to the Buffalo NAS device's shared folders.</td>
</tr>
<tr>
<td>Launch NAS Navigator2 on Startup</td>
<td>Launches NAS Navigator2 in the system tray when Windows boots.</td>
</tr>
<tr>
<td>Display Errors</td>
<td>If an error occurs, an error message will appear from the NAS Navigator2 icon in the system tray.</td>
</tr>
<tr>
<td>Properties*</td>
<td>Opens the properties page that lets you configure the Buffalo NAS device's IP address or open Settings.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes NAS Navigator2.</td>
</tr>
<tr>
<td><strong>View</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Icons:</strong></td>
<td>Displays icons.</td>
</tr>
<tr>
<td><strong>Details:</strong></td>
<td>Displays the hostname, product name, workgroup, IP address, subnet mask, and default gateway.</td>
</tr>
<tr>
<td><strong>Sort by</strong></td>
<td>If you have multiple Buffalo NAS devices on the network, you may choose to display them in order of hostname, product name, workgroup, IP address, subnet mask, or default gateway.</td>
</tr>
<tr>
<td><strong>Browse</strong></td>
<td>Opens the Buffalo NAS device's shared folders.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Searches for the Buffalo NAS devices on the network again.</td>
</tr>
<tr>
<td>I'm here*</td>
<td>Causes your Buffalo NAS device to beep.</td>
</tr>
<tr>
<td>Right-click your device's icon to show these menus.</td>
<td>Opens the Buffalo NAS device's shared folders.</td>
</tr>
<tr>
<td>Settings</td>
<td>Opens Settings for the Buffalo NAS device.</td>
</tr>
<tr>
<td>Properties</td>
<td>Opens the properties page that lets you configure the Buffalo NAS device's IP address or open Settings.</td>
</tr>
<tr>
<td>Map Share</td>
<td>Assigns the Buffalo NAS device's shared folder as a network drive.</td>
</tr>
<tr>
<td>Disconnect Share</td>
<td>Unmaps the network drive.</td>
</tr>
<tr>
<td>Create Desktop Shortcut</td>
<td>Creates a desktop shortcut to the Buffalo NAS device's shared folders.</td>
</tr>
<tr>
<td>I'm here</td>
<td>Causes your Buffalo NAS device to beep.</td>
</tr>
</tbody>
</table>

*Click on the Buffalo NAS device’s icon to display these options.

When NAS Navigator2 is closed, right-click the NAS Navigator2 icon in the system tray for the following options.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse Shares</td>
<td>Opens the Buffalo NAS device's shared folders.</td>
</tr>
<tr>
<td>Settings</td>
<td>Opens Settings for the Buffalo NAS device.</td>
</tr>
<tr>
<td>Properties</td>
<td>Opens the properties page that lets you configure the Buffalo NAS device's IP address or open Settings.</td>
</tr>
<tr>
<td>Map Share</td>
<td>Assigns the Buffalo NAS device's shared folder as a network drive.</td>
</tr>
<tr>
<td>Disconnect Share</td>
<td>Unmaps the network drive.</td>
</tr>
<tr>
<td>Create Shortcut</td>
<td>Creates a desktop shortcut to the Buffalo NAS device's shared folders.</td>
</tr>
<tr>
<td>I'm here</td>
<td>Causes your Buffalo NAS device to beep.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Searches for the Buffalo NAS devices on the network again.</td>
</tr>
<tr>
<td>Open NAS Navigator2</td>
<td>Opens the NAS Navigator2 window.</td>
</tr>
<tr>
<td>Exit</td>
<td>Exits NAS Navigator2.</td>
</tr>
</tbody>
</table>

The following menus may be accessed from the Buffalo NAS device's properties page.

### Configuration

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>Select the &quot;Use DHCP&quot; checkbox to assign an IP address from the DHCP server automatically. If there is no DHCP server on the network, you cannot use this function. Select the &quot;Renew IP address&quot; checkbox to obtain an IP address from the DHCP server. You can manually enter a static IP address, subnet mask, and default gateway.</td>
</tr>
</tbody>
</table>
1 Double-click the NAS Navigator2 icon () to start NAS Navigator2.

2 Right-click your Buffalo NAS device's icon and select Map Share.

3 An icon for the mapped share will appear in Computer or My Computer. You can use this network drive just like any other drive.

Changing the IP Address

1 Double-click the NAS Navigator2 icon () to start NAS Navigator2.

2 Right-click your Buffalo NAS device's icon and select Properties > IP Address.

3 Clear the "Use DHCP" checkbox and enter the desired settings, then click OK. If the username and password prompt appears, enter the admin username and password.

NAS Navigator2 for macOS

NAS Navigator2 is a utility program that makes it easy to display Settings, change the Buffalo NAS device's IP address, or check its drive. If you installed the TeraStation with the TeraNavigator CD, NAS Navigator2 was installed automatically.

Click the NAS Navigator2 icon () in the Dock to start NAS Navigator2.

Click a Buffalo NAS device's icon to display total capacity, used capacity, workgroup name, IP address, subnet mask, default gateway, MAC address, and firmware version.

Double-click the icon to open a shared folder on the Buffalo NAS device.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Opens the Buffalo NAS device's shared folders.</td>
</tr>
</tbody>
</table>
The following menus may be accessed from the Buffalo NAS device's properties page.

### Configuration

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh</td>
<td>Searches for the Buffalo NAS devices on the network again.</td>
</tr>
<tr>
<td>I'm here</td>
<td>Causes your Buffalo NAS device to beep.</td>
</tr>
<tr>
<td>Settings</td>
<td>Opens Settings for the Buffalo NAS device.</td>
</tr>
<tr>
<td>Configure</td>
<td>Opens the properties page that lets you configure the Buffalo NAS device's IP address or open Settings.</td>
</tr>
<tr>
<td>Label Color</td>
<td>Selects the color of the name displayed below the icon.</td>
</tr>
<tr>
<td>View Options</td>
<td>Lets you choose icon size, position, and view mode.</td>
</tr>
<tr>
<td>Auto Power Mode</td>
<td>Auto power mode can turn supported Buffalo NAS devices on the network on and off automatically.</td>
</tr>
</tbody>
</table>

### To display these options, hold down the control key and click your device's icon.

- **Open Folder**: Opens the Buffalo NAS device's shared folders.
- **Settings**: Opens Settings for the Buffalo NAS device.
- **Configure**: Opens the properties page that lets you configure the Buffalo NAS device's IP address or open Settings.
- **I'm here**: Causes your Buffalo NAS device to beep.
- **Label Color**: Selects the color of the name displayed below the icon.

### IP Address

Select the “Use DHCP” checkbox to assign an IP address from the DHCP server automatically. If there is no DHCP server on the network, you cannot use this function. Select the “Renew IP address” checkbox to obtain an IP address from the DHCP server. You can manually enter a static IP address, subnet mask, and default gateway.
Mounting as a Network Drive

You can map a shared folder as a network drive using NAS Navigator2 on macOS.

1. Click the NAS Navigator2 icon (⏏️) in the Dock to start NAS Navigator2.
2. Double-click the Buffalo NAS device’s icon or click the icon while holding down the control key, then select Open Folder. Enter a username and password with the rights to access the shared folder.
3. Select the shared folder that you want to mount, then click OK.
4. The shared folder is now mounted as a network drive.

Changing the IP Address

1. Click the NAS Navigator2 icon (⏏️) in the Dock to start NAS Navigator2.
2. Click the Buffalo NAS device’s icon while holding down the control key, then select Configure > IP Address.
3. Clear the “Use DHCP” checkbox; enter the desired settings and the administrator password, then click Apply.

iSCSI Connection Tool

The iSCSI Connection Tool is a Windows utility that lets you use the TeraStation as an iSCSI drive. To launch it, click Start > All Programs > BUFFALO > iSCSI Connection Tool > iSCSI Connection Tool. For Windows 8.1 and Windows 8, click iSCSI Connection Tool.
## Home Screen

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Target</strong></td>
<td>If a TeraStation is selected, clicking Register iSCSI Device will register all the volumes in the TeraStation to the computer for enabling connection to individual volumes. If a volume is already registered, click Unregister iSCSI Device to unregister all volumes, disconnecting them from the TeraStation.</td>
</tr>
<tr>
<td><strong>Model</strong></td>
<td>Displays TeraStation's model name.</td>
</tr>
<tr>
<td><strong>Series</strong></td>
<td>Displays TeraStation's series name.</td>
</tr>
<tr>
<td><strong>IP Address</strong></td>
<td>Displays TeraStation's IP address.</td>
</tr>
<tr>
<td><strong>Subnet Mask</strong></td>
<td>Displays TeraStation's subnet mask.</td>
</tr>
<tr>
<td><strong>Firmware</strong></td>
<td>Displays TeraStation's firmware version.</td>
</tr>
<tr>
<td><strong>MAC Address</strong></td>
<td>TeraStation's MAC address.</td>
</tr>
<tr>
<td><strong>iSCSI Service</strong></td>
<td>Shows whether the iSCSI service of the TeraStation is running or stopped.</td>
</tr>
<tr>
<td><strong>Volume</strong></td>
<td>Select individual volumes from a registered TeraStation. Select a volume and click Connect, then the selected volume will be recognized as a local drive in My Computer on your computer. If a volume is connected, click Unregister to disconnect it.</td>
</tr>
<tr>
<td><strong>Current status</strong></td>
<td>Displays current status of the selected volume. Disconnected: Volume is disconnected. Connected: Volume is connected. Connected to another PC: Volume is connected to another computer. Displays the other computer's IP address.</td>
</tr>
<tr>
<td><strong>User authorization</strong></td>
<td>Disabled: No authentication. Enabled: User authentication is needed to connect to a volume.</td>
</tr>
<tr>
<td><strong>Connect on Start Up</strong></td>
<td>If selected, the computer will connect to the volume automatically at boot.</td>
</tr>
<tr>
<td><strong>Refresh</strong></td>
<td>Search for network devices on the LAN.</td>
</tr>
<tr>
<td><strong>Exit</strong></td>
<td>Exit iSCSI Connection Tool.</td>
</tr>
</tbody>
</table>

## Menu

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td>Refresh: Search for network devices on the LAN. Exit: Closes iSCSI Connection Tool.</td>
</tr>
<tr>
<td><strong>Setup</strong></td>
<td>Configuration: Opens Settings for the selected TeraStation. Change IP address: You can change the IP address of the selected TeraStation. Unregister iSCSI device: If you disconnect the TeraStation without unregistering it or changing its IP address, the registration information stays in your computer and searches will take longer. For better performance, unregister disconnected TeraStations with this command.</td>
</tr>
<tr>
<td><strong>Persistent Volume</strong></td>
<td>If checked, your computer will reconnect to the TeraStation whenever it's restarted.</td>
</tr>
<tr>
<td><strong>Set mutual CHAP secret</strong></td>
<td>Set the CHAP password on the computer side.</td>
</tr>
<tr>
<td><strong>Connect volumes</strong></td>
<td>Connect multiple volumes at a time.</td>
</tr>
<tr>
<td><strong>Disconnect volumes</strong></td>
<td>Displays the screen to disconnect multiple volumes at a time.</td>
</tr>
<tr>
<td><strong>Disk management</strong></td>
<td>Format drives.</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td>About: Displays version information.</td>
</tr>
</tbody>
</table>
NovaBACKUP

NovaBACKUP is a Windows utility that lets you back up the data on your computer.

Installing from CD

The installation methods are different depending on which version of TeraNavigator CD you have. If your TeraNavigator CD is version 1.11 or earlier, install NovaBACKUP from the included TeraNavigator CD.

1. Insert the TeraNavigator CD to your computer.
2. Launch TSNavi.exe from the TeraNavigator CD.
3. Click Options > Additional Software Installation.
4. Select “NovaBACKUP” and click Install. Follow the procedure to finish installing NovaBACKUP.

Installing from Website

If your TeraNavigator CD is version 1.20 or later, install the software from http://d.buffalo.jp/TS3000/. Select the region and model to go to the d.buffalo site of your specific product model.
To download the installer, you will need the serial number of your TeraStation. The serial number is printed on the label on the back or top of the unit. For the rackmount model, the serial number is located on the front as well. Refer to the “Diagrams” section in chapter 1 for information on where to find the serial number.
LCD Panel

The LCD panel can be cycled through different modes by pressing the display button on the front of the TeraStation. Also, the items displayed can be configured at Management > Notifications > Front Panel Display Settings in Settings.

## Modes

<table>
<thead>
<tr>
<th>LCD Message</th>
<th>Description</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>LINK SPEED No LINK</td>
<td>Not connected to a network.</td>
<td>Connect an Ethernet cable to the LAN port.</td>
</tr>
<tr>
<td>LINK SPEED 10 Mbps HALF</td>
<td>Connected at 10 Mbps half duplex.</td>
<td>-</td>
</tr>
<tr>
<td>LINK SPEED 10 Mbps FULL</td>
<td>Connected at 10 Mbps full duplex.</td>
<td>-</td>
</tr>
<tr>
<td>LINK SPEED 100 Mbps HALF</td>
<td>Connected at 100 Mbps half duplex.</td>
<td>-</td>
</tr>
<tr>
<td>LINK SPEED 100 Mbps FULL</td>
<td>Connected at 100 Mbps full duplex.</td>
<td>-</td>
</tr>
<tr>
<td>LINK SPEED 1000 Mbps</td>
<td>Connected at 1000 Mbps full duplex.</td>
<td>-</td>
</tr>
</tbody>
</table>

**Series Name/ Firmware Version**

| TS3400D Ver. 1.50                      | Displays the series name and the firmware version. **Note:** This is an example for TS3400D. Depending on the unit model you are using, the series name may be displayed differently. | - |

**Hostname/IP Address**

| TSxxxxx.xxx 192.168.11.150             | Displays the hostname and IP address. At the end of the IP address, F (fixed IP address) or D (IP address automatically acquired from a DHCP server) is displayed. **Note:** When an Ethernet cable is connected to LAN port 2, “NETWORK2” is displayed in the hostname section. | - |

**Calendar/Clock**

| DATE TIME 2012/1/1 11:11               | Displays the date and time set in the TeraStation. | - |

## Errors

If an error occurs, the error LED will glow red. You can also confirm the current status from the LCD panel.

**Note:** The “x” in the LCD message is the number of the drive or array involved in the process.

<table>
<thead>
<tr>
<th>LCD Message</th>
<th>Description</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOT FAIL</td>
<td>The drive not found.</td>
<td>Contact Buffalo technical support for assistance.</td>
</tr>
<tr>
<td>SYSTEM Error E04 Can't Load Krnl!</td>
<td>The firmware is corrupted.</td>
<td>Contact Buffalo technical support for assistance.</td>
</tr>
<tr>
<td>LCD Message</td>
<td>Description</td>
<td>Corrective Action</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>E10 UPS Running Off</td>
<td>The TeraStation is running on the UPS battery due to a power outage.</td>
<td>Shut down the TeraStation safely and wait until the power outage ends. If certain</td>
</tr>
<tr>
<td>Battery</td>
<td>If the setting to use the UPS connected to this TeraStation has been configured, the UPS cable may be disconnected.</td>
<td>settings are configured, the TeraStation may shut down automatically when the</td>
</tr>
<tr>
<td></td>
<td>If the setting to use the UPS connected to another TeraStation on the same network has been configured, the LAN cable of this TeraStation may be disconnected.</td>
<td>error is detected.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Verify that the UPS cable or LAN cable is connected properly.</td>
</tr>
<tr>
<td>E11 Fan Failure</td>
<td>An error occurred in the fan speed.</td>
<td>Check that no foreign objects or dust are clogging the fan. If any foreign objects or dust are found, use a pair of tweezers, air duster, or other tool to remove them. If the error is displayed again, contact Buffalo technical support for assistance.</td>
</tr>
<tr>
<td>E12 Cooling Failure</td>
<td>A rise in the system temperature may have exceeded the allowable safety value.</td>
<td>Do not place objects in the area around the TeraStation. Also, move the TeraStation to a cool location.</td>
</tr>
<tr>
<td>E14 Can't Mount</td>
<td>The RAID array cannot be mounted.</td>
<td>Run the RAID array disk check in Settings.</td>
</tr>
<tr>
<td>Arrayx</td>
<td></td>
<td></td>
</tr>
<tr>
<td>E16 Drivex Not Found</td>
<td>Unable to find the drive.</td>
<td>The drive may be disconnected or may have failed. After shutting down, reinstall the drive.</td>
</tr>
<tr>
<td>E22 Can't Mount</td>
<td>Unable to mount the drive.</td>
<td>Format the drive. After formatting, if the error still appears after rebooting, replace the drive. If the error is displayed again, contact Buffalo technical support for assistance.</td>
</tr>
<tr>
<td>Drivex</td>
<td></td>
<td></td>
</tr>
<tr>
<td>E27 Lost Failover</td>
<td>Unable to find the backup TeraStation.</td>
<td>In the main TeraStation's Settings, navigate to Backup &gt; Failover to reconfigure the backup TeraStation for failover.</td>
</tr>
<tr>
<td>Target</td>
<td></td>
<td></td>
</tr>
<tr>
<td>E30 Replace Drivex</td>
<td>An error occurred, so the drive was removed from the RAID array.</td>
<td>Replace the drive.</td>
</tr>
</tbody>
</table>

**Status**

After you change settings or format a drive, the current status is displayed on the LCD panel.

**Note:** The “x” in the LCD message is the number of the drive or array involved in the process.

<table>
<thead>
<tr>
<th>LCD Message</th>
<th>Description</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>I10 System Is</td>
<td>A rise in the system temperature may have exceeded the allowable safety value.</td>
<td>Move the TeraStation to a cool location. Do not place objects in the area around the TeraStation.</td>
</tr>
<tr>
<td>Overheating</td>
<td></td>
<td></td>
</tr>
<tr>
<td>I11 Bad Sectors on</td>
<td>The drive has too many bad sectors.</td>
<td>Replace the drive.</td>
</tr>
<tr>
<td>Drivex</td>
<td></td>
<td></td>
</tr>
<tr>
<td>I12 Degraded Mode</td>
<td>Operating in degraded mode.</td>
<td></td>
</tr>
<tr>
<td>I13 Formatting Arrayx</td>
<td>Formatting the RAID array.</td>
<td></td>
</tr>
<tr>
<td>LCD Message</td>
<td>Description</td>
<td>Corrective Action</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>I14 Checking Array...</td>
<td>Checking the RAID array.</td>
<td>-</td>
</tr>
<tr>
<td>I15 Scanning Array...</td>
<td>Examining the error status of the RAID array.</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Note: Transfer speeds are slower during the examination process.</td>
<td>-</td>
</tr>
<tr>
<td>I16 Creating Array...</td>
<td>Creating the RAID array.</td>
<td>-</td>
</tr>
<tr>
<td>I17 Resyncing Array...</td>
<td>Resynchronizing the RAID array.</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Note: Transfer speeds are slower during resynchronization.</td>
<td>-</td>
</tr>
<tr>
<td>I18 Rebuilding Array...</td>
<td>Rebuilding the RAID array.</td>
<td>-</td>
</tr>
<tr>
<td>I19 Filling Array...</td>
<td>Writing 0s to the RAID array and erasing all data.</td>
<td>-</td>
</tr>
<tr>
<td>with 0s</td>
<td></td>
<td>-</td>
</tr>
<tr>
<td>I20 Formatting Drivex...</td>
<td>Formatting the drive.</td>
<td>-</td>
</tr>
<tr>
<td>I21 Checking Drivex...</td>
<td>Checking the drive.</td>
<td>-</td>
</tr>
<tr>
<td>I22 Filling Drivex...</td>
<td>Writing 0s to the drive and erasing all data.</td>
<td>-</td>
</tr>
<tr>
<td>with 0s</td>
<td></td>
<td>-</td>
</tr>
<tr>
<td>I25 Updating Firmware...</td>
<td>Updating the TeraStation firmware.</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Note: Do not turn off the power during the updating process.</td>
<td>-</td>
</tr>
<tr>
<td>I26 Initializing Settings...</td>
<td>Initializing all settings.</td>
<td>-</td>
</tr>
<tr>
<td>I27 Checking USB Drivex...</td>
<td>Checking USB the drive.</td>
<td>-</td>
</tr>
<tr>
<td>I28 Formatting USB Drivex...</td>
<td>Formatting USB the drive.</td>
<td>-</td>
</tr>
<tr>
<td>I31 Push Func to Use New Drivex...</td>
<td>Displays when pressing the function button to rebuild the RAID after replacing the drive.</td>
<td>Press the function button to rebuild the RAID array.</td>
</tr>
<tr>
<td>I32 New Drivex Detected</td>
<td>Displays after replacing the drive when the RAID needs to be rebuilt in Settings or formatting is necessary.</td>
<td>From Settings, either rebuild the RAID array or format the drive.</td>
</tr>
<tr>
<td>I33 Replication Failure</td>
<td>An error occurred in replication, or synchronization between the main TeraStation and the backup TeraStation failed during failover configuration.</td>
<td>From Settings, navigate to Backup &gt; Replication and click Resync to execute resynchronization. If the error is displayed again, contact Buffalo technical support for assistance.</td>
</tr>
<tr>
<td>I34 Virus Quarantined</td>
<td>A virus scan found a virus.</td>
<td>Once the virus is removed from the quarantine folder, the message is no longer displayed. If the antivirus software is configured to delete viruses from the quarantine folder automatically, then the message will not be displayed.</td>
</tr>
<tr>
<td>I35 Bay 1 Has Media Cartridge</td>
<td>A drive set as a media cartridge has been installed in the drive slot.</td>
<td>Connect to the slot that was set as a media cartridge.</td>
</tr>
<tr>
<td>LCD Message</td>
<td>Description</td>
<td>Corrective Action</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>I36 Drivex Decryption Error</td>
<td>The media cartridge cannot be decrypted. The media cartridge may have been encrypted by a TeraStation other than this product.</td>
<td>Connect the drive to the TeraStation that performs encryption to decrypt the drive.</td>
</tr>
<tr>
<td>I37 Recovering System…</td>
<td>System recovery in progress.</td>
<td></td>
</tr>
<tr>
<td>I38 Recovery Finished</td>
<td>System recovery is complete.</td>
<td></td>
</tr>
<tr>
<td>I39 Change Boot Switch Back</td>
<td>System recovery from the USB recovery device is complete.</td>
<td>Change the boot mode switch on the rear to “HDD”.</td>
</tr>
<tr>
<td>I40 All Data Will Be Deleted</td>
<td>Beginning recovery. All data on the drive will be deleted.</td>
<td></td>
</tr>
<tr>
<td>I41 Push Func to Start Recovery</td>
<td>Press the function button on the front to start the recovery process.</td>
<td></td>
</tr>
<tr>
<td>I42 Preparing Recovery</td>
<td>Preparing to start the recovery process.</td>
<td></td>
</tr>
<tr>
<td>I43 Unsupported Hardware</td>
<td>The TeraStation was started from the USB recovery device, but the system cannot be recovered from this USB recovery device.</td>
<td></td>
</tr>
<tr>
<td>I44 Drive 1 Not Found</td>
<td>Recovery from the USB recovery device was initiated, but drive 1 was not detected.</td>
<td>Make sure that drive 1 is present and fully inserted in its slot.</td>
</tr>
<tr>
<td>I45 Recovery Failed</td>
<td>Recovery failed.</td>
<td></td>
</tr>
<tr>
<td>I46 Migrating RAID Array…</td>
<td>Data migration or conversion (RAID migration) is in progress.</td>
<td>Do not turn off the TeraStation's power.</td>
</tr>
<tr>
<td>I47 Don't Power Off System!</td>
<td></td>
<td></td>
</tr>
<tr>
<td>I48 Push Func to Start Failover</td>
<td>This TeraStation is ready to become the failover backup for the main TeraStation.</td>
<td>Hold down the function button on the front of the target TeraStation until it stops beeping to accept failover backup status.</td>
</tr>
<tr>
<td>I49 Lost Failover Main</td>
<td>The main TeraStation in the failover configuration cannot be found.</td>
<td>Make sure that the main TeraStation is on, working, and connected to the network.</td>
</tr>
<tr>
<td>I50 Failover in Maintenance Mode</td>
<td>Failover maintenance is in progress.</td>
<td>Do not turn off the TeraStation's power.</td>
</tr>
<tr>
<td>I51 Initializing Failover…</td>
<td>Initializing the failover configuration.</td>
<td>Do not turn off the TeraStation's power.</td>
</tr>
<tr>
<td>I52 New Firmware Available</td>
<td>A new firmware version has been released.</td>
<td>Update the firmware.</td>
</tr>
<tr>
<td>I54 Backup Jobxx Failed</td>
<td>The backup job failed.</td>
<td>Make sure that the backup job is configured correctly. Make sure that the NAS is on and not in standby mode. If the backup job still fails, check the status of NAS, network, and backup source and destinations.</td>
</tr>
<tr>
<td>LCD Message</td>
<td>Description</td>
<td>Corrective Action</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>I55 Recovery Not Authorized</td>
<td>Authentication during recovery of settings failed.</td>
<td>Settings can only be restored for the TeraStation whose settings were originally saved. To restore settings, insert the USB memory device, move the Boot Mode switch on the rear of the TeraStation to the USB position, and restart the TeraStation. Or, settings can be restored from Settings with the TeraStation powered on.</td>
</tr>
<tr>
<td>I56 Need License for Camera</td>
<td>There are not enough surveillance camera server licenses.</td>
<td>Purchase and register an additional license.</td>
</tr>
<tr>
<td>I57 No Free Space to Record</td>
<td>There is not enough space to record additional surveillance videos.</td>
<td>Delete or move some of the stored videos.</td>
</tr>
<tr>
<td>I58 Recording Failure</td>
<td>Video not recorded.</td>
<td>Check your settings. Also, use the utilities provided with your camera to check that the camera is operating correctly.</td>
</tr>
</tbody>
</table>

## Default Settings

<table>
<thead>
<tr>
<th>Administrator's Name</th>
<th>admin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password</td>
<td>password</td>
</tr>
</tbody>
</table>

### Shared Folders

- "share" for both Windows and Mac computers. The recycle bin is enabled on "share" by default.

### IP Address

- The TeraStation will get its IP address automatically from a DHCP server on the network. If no DHCP server is available, then an IP address will be assigned as follows:
  - IP Address: 169.254.xxx.xxx ("xxx" is assigned randomly when booting the TeraStation.)
  - Subnet Mask: 255.255.0.0

### Registered Groups

- "hdusers", "admin", and "guest"
- You cannot edit or delete these default groups.

### Microsoft Network Group Settings

- WORKGROUP

### Ethernet Frame Size

- 1500 bytes (not including 14 bytes of header and 4 bytes of FCS)

### SMB

- Enabled
- SMB2 Protocol | Enabled
- Recycle Bin Permissions | All users
- Exclude Mac OS temp files from recycle bin | Yes

### DFS

- Disabled

### AFP

- Enabled

### FTP

- Disabled

### SFTP

- Enabled

### WebAccess

- Disabled

### NFS

- Disabled

### RAID Scanning

- Disabled

### iSCSI

- Disabled

### DLNA Server

- Enabled

### iTunes Server

- Enabled

### Print Server

- Enabled
### Web Server
Disabled

### MySQL Server
Disabled

### WebAccess Remote
Disabled

### Amazon S3
Disabled

### BitTorrent
Disabled

### TeraSearch
Disabled

### Surveillance Cameras
Disabled

### Antivirus
Disabled

### SNMP
Disabled

### Time Machine
Disabled

### Direct Copy
Disabled

### NTP
Enabled

### Email Notification
Disabled

### RAID Mode
- **TS3200D:** RAID 1
- **TS3400D, TS3400R:** RAID 5

### Specifications

Check the [Buffalo website](https://www.buffalo.com) for information about the latest products and specifications.

**LAN Interface**

<table>
<thead>
<tr>
<th>Standards Compliance</th>
<th>IEEE 802.3ab (1000BASE-T), IEEE 802.3u (100BASE-TX), IEEE 802.3 (10BASE-T)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Transfer Rates</td>
<td>10/100/1000 Mbps (auto sensing)</td>
</tr>
<tr>
<td>Number of Ports</td>
<td>2</td>
</tr>
<tr>
<td>Connector Type</td>
<td>RJ-45 8-pin (auto MDI-X)</td>
</tr>
<tr>
<td>Supported Protocols</td>
<td>TCP/IP</td>
</tr>
<tr>
<td>Network File Services</td>
<td>SMB/CIFS, AFP, FTP/SFTP, NFS</td>
</tr>
<tr>
<td>Ethernet Frame Sizes</td>
<td>1500, 4084, 7404, and 9216 bytes (not including 14 bytes of header and 4 bytes of FCS)</td>
</tr>
</tbody>
</table>

**USB Interface**

<table>
<thead>
<tr>
<th>Standards Compliance</th>
<th>USB 3.0/2.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Transfer Rates</td>
<td>USB 3.0: max. 5 Gbps</td>
</tr>
<tr>
<td>Number of Ports</td>
<td>TS3200D: 2 × USB 2.0</td>
</tr>
<tr>
<td>Connector Type</td>
<td>Type A</td>
</tr>
</tbody>
</table>

**Other Interface**

| 1 × D-sub 9 pin (male) port |

**Internal Drives**

<table>
<thead>
<tr>
<th>Number of Drive Bays</th>
<th>TS3200D: 2</th>
<th>TS3400D: 4</th>
<th>TS3400R: 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive Interface</td>
<td>SATA 3 Gbps</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supported RAID Levels</td>
<td>TS3200D: 0, 1, JBOD (individual drives)</td>
<td>TS3400D, TS3400R: 5, 6, 10, 1, 0, JBOD (individual drives)</td>
<td></td>
</tr>
<tr>
<td>Replacement Drive</td>
<td>Buffalo OP-HDS series drive</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Note:* The replacement drive should be the same size or larger as the original drive. The drives listed above are available from the [Buffalo website](https://www.buffalo.com).
<table>
<thead>
<tr>
<th><strong>Other</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Power Supply</strong></td>
<td>AC 100–240 V, 50/60 Hz</td>
</tr>
</tbody>
</table>
| **Dimensions (D × W × H, excluding protruding parts)** | TS3200D: 230 × 170 × 170 mm; 9.1 × 6.7 × 6.7 in.  
TS3400D: 230 × 170 × 215 mm; 9.1 × 6.7 × 8.5 in.  
TS3400R: 430 × 45 × 430 mm; 16.9 × 1.7 × 16.9 in. |
| **Weight** | TS3200D: Approx. 4.5 kg; 9.9 lbs  
TS3400D: Approx. 8.0 kg; 17.7 lbs  
TS3400R: Approx. 9.0 kg; 19.8 lbs |
| **Power Consumption (Max.)** | TS3200D (for EU region model): 89 W  
TS3200D (for other region model): 47 W  
TS3400D: 86 W  
TS3400R: 140 W  
**Note:** To identify if your unit is EU region model or others, refer to the label on the unit that the series name is printed. If it says “1.5 A” for the PSU ampacity, your unit is EU region model. |
| **Operating Environment** | Temperature: 5–35°C; 41–95°F  
Humidity: 20–80% (non-condensing) |
| **Compatible Devices** | Windows PCs, tablets, and Mac computers with wired or wireless Ethernet connection.  
**Note:** The TeraStation requires an Ethernet connection with your computer for operation. It cannot be connected via USB. |
Windows RT 8.1, RT  
macOS 10.13, 10.12, 10.11, 10.10, 10.9, 10.8, 10.7, 10.6, 10.5, 10.4  
*64- and 32-bit versions
Chapter 13 Regulatory Compliance Information

For Customers in the United States

FCC Statement
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.
Only use the cables and accessories that are included in the package. Don't use other accessories or cables unless specifically instructed to in the documentation.

Proposition 65
WARNING:
This product and its components contain chemicals known to the State of California to cause cancer and birth defects, or reproductive harm. Wash hands after handling.

For Customers in Europe

CE
Dansk
Dette er et Klasse A-produkt. I et hjemmemiljø kan dette produkt skabe radiointerferens, hvormed det kan være nødvendigt for brugeren at tage passende forholdsregler.
Dette produkt kan forårsage interferens hvis det bruges i beboelsesområder. En sådan anvendelse skal undgås, medmindre brugeren tager specielle foranstaltninger for at reducere elektromagnetiske emissioner for at forhindre interferens med modtagelse af radio- og tv-udsendelser.
Der må kun bruges de kabler og det tilbehør der er inkluderet i pakken. Der må ikke bruges andet tilbehør eller kabler, medmindre det er udtrykkeligt beskrevet i dokumentationen.
Brug ikke USB-kabler, der er 3 meter eller længere for at tilslutte USB enheder til denne TeraStation serie.

Deutsch

English
This is a class A product. In a domestic environment, this product may cause radio interference, in which case the user may be required to take adequate measures. This product may cause interference if used in residential areas. Such use must be avoided unless the user takes special measures to reduce electromagnetic emissions to prevent interference to the reception of radio and television broadcasts. Only use the cables and accessories that are included in the package. Don't use other accessories or cables unless specifically instructed to in the documentation. Do not use USB cables that are 3 meters or longer to connect USB devices to this TeraStation series.

Español
Este es un producto de Clase A. En una situación domestica, este producto puede producir interferencias de radio, en ese caso el usuario deberá tomar las medidas adecuadas. Este producto puede causar interferencias al utilizarlo en áreas residenciales. Debe evitarse utilizarlo así, salvo si el usuario adopta medidas especiales para reducir las emisiones electromagnéticas e impedir que se produzcan interferencias con la recepción de emisiones de radio y televisión. Utilice únicamente los cables y accesorios incluidos en el paquete. No utilice otros accesorios ni cables a menos que así se indique en la documentación. Utilice cables de una longitud inferior a 3 metros para conectar los dispositivos USB a este tipo de TeraStation.

Français
Cet appareil est un produit de Classe A. Dans un environnement domestique, ce produit est susceptible de provoquer des interférences radio, auquel cas l’utilisateur peut être mis en demeure de prendre des mesures appropriées. Utilisé dans un environnement domestique, cet appareil génère des interférences. Ce type d’utilisation est donc à éviter si l’utilisateur n’a pas pris de mesures spécifiques visant à réduire les émissions électromagnétiques pour éviter les interférences avec la réception de programmes de radio et de télévision. Utilisez uniquement les câbles et accessoires inclus dans ce package. N’utilisez aucun autre accessoire ou câble sauf instruction spécifique de la documentation. Utilisez des câbles d’une longueur de moins 3 mètres pour connecter les périphériques USB à ce type de TeraStation.

Italiano
Questo è un prodotto di Classe A. In ambienti domestici il prodotto può causare radiointerferenza, nel qual caso potrebbe rendersi necessaria l’adozione di opportune misure. Questo prodotto può causare interferenze se usato in zone residenziali. Evitare l’uso in queste zone a meno che l’utente non intraprenda azioni specifiche per ridurre le emissioni elettromagnetiche e impedire le interferenze alla ricezione di trasmissioni radio-televisive.
Utilizzare esclusivamente i cavi e gli accessori inclusi nell'imballaggio. Non utilizzare altri accessori o cavi a meno che non sia specificamente indicato nella documentazione.
Non utilizzare cavi USB lunghi 3 metri o più per collegare dispositivi USB a questa TeraStation.

Nederlands
Dit is een Klasse A product. Dit product kan in een huishoudelijke omgeving radiostoring veroorzaken in welk geval de gebruiker adequate maatregelen dient te nemen.
Dit product kan storing veroorzaken wanneer gebruikt in woongebieden. Dergelijk gebruik dient te worden vermeden tenzij de gebruiker speciale maatregelen treft om de elektro-magnetische uitstraling te beperken zodat storing van de ontvangst van radio- en televisieuitzendingen wordt voorkomen.
Gebruik alleen de kabels en toebehoren die zich in de verpakking bevinden. Gebruik geen ander toebehoren of kabels tenzij dit uitdrukkelijk in de handleiding wordt aangegeven.
Gebruik geen USB-kabels die 3 meter of langer zijn om USB-apparaten met deze TeraStation series te verbinden.

Norsk
Dette er et produkt i klasse A. I et hjemmemiljø kan dette produktet forårsake radiointerferens, noe som gjør at brukeren i så fall må foreta passende tiltak.
Dette produktet kan forårsake interferens dersom det brukes i boligområder. Slik bruk må unngås med mindre brukeren tar spesielle tiltak for å redusere elektromagnetisk stråling for å unngå interferens med mottak av radio- og TV-sendinger.
Bruk kun kabler og tilbehør som er inkludert i pakken. Ikke bruk annet tilbehør eller kabler med mindre spesielt instruert til å gjøre det i dokumentasjonen.
Bruk ikke USB-kabler på tre meter eller mer for å koble USB-enheter til denne TeraStation-serien.

Português
Este é um produto de Classe A. Num ambiente doméstico, este produto pode provocar interferências de rádio, pelo que o utilizador poderá ter de tomar medidas adequadas.
Este produto poderá causar interferências se utilizado em áreas residenciais. A utilização deverá ser evitada, salvo se o utilizador tomar medidas especiais para reduzir as emissões electromagnéticas e assim prevenir interferências na recepção de rádio e televisão.
Utilizar apenas cabos e acessórios incluídos na embalagem. Não utilizar outros acessórios ou cabos, salvo se especificamente indicado na documentação.
Não usar cabos USB de 3 metros ou mais para ligar dispositivos USB a esta série TeraStation.

Suomi
Tämä on luokan A tuote. Tämä tuote voi aiheuttaa radiohäiriöitä kotikäytössä, jolloin käyttäjän on ehkä ryhdyttävä tarvittaviin toimenpiteisiin.
Tämä tuote saattaa aiheuttaa häiriintä, jos sitä käytetään asuinalueella. Sellaista käyttöä on vältettävä, ellei ryhdytä erityistoimenpiteisiin sähkömagneettisen sateilyn vähentämiseksi häiriöiden estämiseksi radio- ja televisiolähtöyksissä.
Käytä ainoastaan pakkauskseen mukana toimitettuja kaapeleita ja varusteita. Älä käytä muita varusteita tai kaapeleita ellei näin ole erityisesti ohjeistettu asiakirjoissa.
Älä käytä 3m tai pitempiä USB-kaapeleita USB-laitteiden liittämiseen näille TeraStation-sarjoille.

Svensk
Detta är en Klass A-produkt. I en hushållsmiljö kan denna produkt orsaka radiostörningar, och användaren kan i så fall begäras att vidta lämpliga åtgärder.
Chapter 13 Regulatory Compliance Information

Den här produkten kan oraka störningar om den används i bostadsområden. Sådan användning måste undvikas om inte användaren vidtar speciella åtgärder för att minska elektromagnetiska sändningar för att förhindra störningar i mottagningen av radio- och tv-sändningar.

Använd bara kablar och tillbehör som ingår i förpackningen. Använd inte andra tillbehör eller kablar om du inte får uttryckliga instruktioner om det i dokumentationen.

Använd inte USB-kablar som är 3 meter eller längre för att ansluta USB-enheter till den här TeraStation-serien.

Türk
Bu, A Sınıfı bir üründür. Evde kullanım sırasında bu ürün radyo girişimine yol açabilir ve bu durumda kullanıcının gerekli önlemleri alması gerekebilir.

Bu ürün yerleşim bölgelerinde kullanılrsa parazite neden olabilir. Kullanıcı radyo ve televizyon yayınlarında paraziti önlemek üzere elektromanyetik salınamaları azaltacak özel önlemler almadıkça bu şekilde kullanımdan kaçınılmalıdır.

Yalnızca pakette bulunan kablo ve aksesuarları kullanın. Belgelerde özellikle belirtilmedikçe başka aksesuar ve kablolar kullanmayın.

USB aygıtları bu TeraStation serisine bağlamak için 3 metre ve daha uzun USB kabloları kullanmayın.

CB
The socket-outlet shall be installed near the equipment and shall be easily accessible.

Norsk
Utstyr som er koplet til beskyttelsesjord via nettplugg og/eller via annet jordtilkoplet utstyr – og er tilkoplet et kabel-TV nett, kan forårsake brannfare.

For å unngå dette skal det ved tilkoping av utstyret til kabel-TV nettet installeres en galvanisk isolator mellom utstyret og kabel-TV nettet.

Svensk
Utrustning som är kopplad till skyddsjord via jordat vägguttag och/eller via annan utrustning och samtidigt är kopplad till kabel-TV nät kan i vissa fall medföra risk för brand. För att undvika detta skall vid anslutning av utrustningen till kabel-TV nät galvanisk isolator finnas mellan utrustningen och kabel-TV nätet.

For Customers in Russia

For Customers in Russia

TR-CU

<table>
<thead>
<tr>
<th>Country of Origin</th>
<th>Made in China or Made in Japan</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manufacturer</td>
<td>Buffalo Inc. Akamondori Bldg., 30-20, Ohsu 3-chome, Naka-ku, Nagoya 460-8315, Japan</td>
</tr>
</tbody>
</table>

For manufacturing date and country, refer to the product package.

Дату изготовления и страну-производителя см. на упаковке.

Өнімнің шығарылу мерзімі мен мемлекеті менеме кеңеті бойынша акпаараттықтамадан қараңыз.

Дату и крайну вырабу гл. на упакоўцы.

234
For Customers in China

CCC
插座应当装在设备的附近，而且应当便于触及到
产品标准号：GB4943.1-2011 GB9254-2008 (CLASS A) GB17625.1-2012

警告
此为A级产品，在生活环境中，该产品可能会造成无线电干扰。在这种情况下，可能需要用户对其干扰采取切实可行的措施。

For Customers in Taiwan

BSMI
警告使用者：
此为甲类资讯技术设备，於居住环境中使用时，可能会造成射频扰动，在此种情况下，使用者会被要求採取某些適當的對策。

For Customers in Korea

KC
이 기기는 업무용(A급) 전자파적합기기로서 판매자 또는 사용자는 이 점을 주의하시기 바라며，가정외의
지역에서 사용하는 것을 목적으로 합니다。